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CHƯƠNG 1 

 TỔNG QUAN TIN HỌC CHUYÊN NGÀNH QUẢN LÝ ĐẤT ĐAI 

1.1. Giới thiệu một số phần mềm chuyên ngành quản lý đất đai 

1.1.1. Hệ thống phần mềm Microstation và Mapping Office 

 Hiện nay, hệ thống phần mềm Mapping office và Microstation đang được sử 

dụng rộng rãi trong ngành địa chính ở nước ta và là công cụ không thể thiếu trong 

công tác thành lập Bản đồ địa chính, Bản đồ địa hình, Bản đồ hiện trạng và Bản đồ 

quy hoạch sử dụng đất các cấp. Phần này giới thiệu sơ lược về hệ thống phần mềm 

Microstation và Mapping office, từ đó giúp người đọc có cái nhìn tổng quan về các 

phần mềm này và có định hướng sử dụng phù hợp trong quá trình xây dựng bản đồ 

được giới thiệu ở các chương tiếp theo.  

 Tập đoàn Intergraph là một trong các hãng hàng đầu thế giới chuyên cung cấp 

các giải pháp cho Hệ thống tin địa lý - GIS và bản đồ, hãng có các giải pháp rất tốt 

trong lĩnh vực kết hợp, xử lý song song dữ liệu raster và vector trong cùng một môi 

trường đồ hoạ thống nhất. Tiêu biểu là việc phát triển và ứng dụng hệ thống phần mềm 

Mapping Office và MicroStation. Intergraph đã có mặt ở thị trường Việt Nam nhiều 

năm trước đây, đã cung cấp các trạm làm việc và giải pháp cho một số cơ quan như Bộ 

TN&MT, Cục Bản đồ Quân đội, Trung tâm đo đạc ảnh địa hình... Cuối năm 1996 

hàng loạt các trạm làm việc và phần mềm ứng dụng của Intergraph đã được lắp đặt đưa 

vào sử dụng tại các đơn vị thuộc Tổng cục Điạ chính (nay là Bộ TN&MT). Qua nhiều 

năm sử dụng, đến nay công nghệ của Intergraph đã và đang đóng góp vai trò quan 

trọng trong sự hoàn thiện cơ sở dữ liệu bản đồ số của nước ta. Trong tương lai gần, 

công nghệ của Intergraph cũng được xác định sẽ là công nghệ chủ đạo trong sự phát 

triển của ngành bản đồ và địa chính cả nước. 

1.1.1.1. Phần mềm Microstation  

 MicroStation là phần mềm trợ giúp thiết kế (Computer Aided Design - CAD) 

được phát triển bởi Bentley Systems cho tập đoàn Intergraph của Mỹ vào những năm 

1980. Tại thời điểm đó, sản phẩm phát triển đầu tiên có tên gọi là PseudoStation ra đời 

vào năm 1984. Qua nhiều năm phát triển, MicroStation đã cho ra đời nhiều phiên bản 

khác nhau với những tính năng ngày càng cải tiến. Vào năm 1987, MicroStation 2.0 ra 

đời và đó là phiên bản đầu tiên của MicroStation đọc và tạo file *.DGN. Phiên bản 

được sử dụng phổ biến nhất hiện nay là MicroStation SE được ra đời vào cuối 1997, 

đó là phiên bản đặc biệt của MicroStation (SE là viết tắt của Special Edition) và là 

phiên bản đầu tiên mà các nút công cụ được thể hiện bởi màu sắc khác nhau, ngoài ra 

MicroStation SE còn cung cấp một số công cụ làm việc qua Internet. Phiên bản mới 

nhất của MicroStation là V8i (V8.11) ra đời năm 2008, phiên bản này cho phép làm 

việc với định dạng file *.dwg mới nhất, đồng thời bao gồm cả Modul làm việc với dữ 

liệu GPS. 
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 Với MicroStation, người sử dụng được cung cấp các công cụ số hoá các đối 

tượng trên nền ảnh, sửa chữa, biên tập, xuất, nhập dữ liệu và trình bày bản đồ. Đồng 

thời, MicroStation cũng là môi trường đồ hoạ cao cấp làm nền cho các ứng dụng khác 

như: IrasB, Irasc, Geovec, MSFC, MRFclean, MRFflag, Famis chạy trên đó. 

 Hiện nay định dạng file *.dgn của MicroStation là định dạng file chuẩn theo 

quy định đối với Bản đồ hiện trạng sử dụng đất, Bản đồ quy hoạch sử dụng đất, Bản 

đồ địa hình, Bản đồ địa chính... dạng số ở nước ta.  

1.2.1.2. Hệ thống Mapping Office  

 Mapping office là một bộ phần mềm của tập đoàn Intergraph, bao gồm các 

phần mềm công cụ phục vụ cho việc xây dựng và duy trì toàn bộ các đối tượng địa lý 

thuộc một trong hai dạng dữ liệu, đồ hoạ và phi đồ hoạ sử dụng trong các hệ thông tin 

địa lý GIS và bản đồ, chạy trên hệ điều hành DOS/Windows.  

 Trong Mapping Office việc thu thập các đối tượng địa lý được tiến hành một 

cách đơn giản trên cơ sở các bản đồ đã được thành lập trước đây (trên giấy, diamat...), 

ảnh hàng không, ảnh vệ tinh, thông qua thiết bị quét và các phần mềm công cụ để tạo 

và chuyển đổi các tài liệu trên vào cơ sở dữ liệu số.  

 Mapping Office gồm bảy phần mềm ứng dụng được tích hợp trong một môi 

trường thống nhất MicroStation, phục vụ cho việc thu thập và duy trì dữ liệu.  

 Sau đây sẽ là các khái niệm và các ứng dụng cụ thể của từng phần mềm trong 

các công đoạn số hoá và biên tập bản đồ.  

 a. IrasB  

 IrasB là phần mềm hiển thị và biên tập dữ liệu raster dưới dạng các ảnh đen 

trắng (black and white image) và được chạy trên nền của MicroStation. Các công cụ 

trong IrasB được sử dụng để làm sạch các ảnh quét, nắn file ảnh raster từ toạ độ hàng 

cột của các pixel về toạ độ thực của bản đồ... Mặc dù dữ liệu của IrasB và 

MicroStation được thể hiện trên cùng màn hình nhưng nó hoàn toàn độc lập với nhau. 

Nghĩa là việc thay đổi dữ liệu phần này không ảnh hưởng đến dữ liệu phần kia.  

 b. IrasC  

 Trong Mapping Office, IrasC là phần mềm công cụ sử dụng cho mục đích nhập, 

hiển thị, phân tích, xử lý cải thiện chất lượng ảnh và in trên các ảnh có sắc độ thay đổi 

liên tục như ảnh hàng không, ảnh viễn thám. Các ảnh này được chuyển qua dạng số 

thông qua máy quét độ phân giải cao (ảnh trên giấy, phim), hoặc đọc trực tiếp nếu là 

ảnh số. Các ảnh này có thể hiển thị trong môi trường MicroStation, với các trức năng 

của một hệ CAD cao cấp, cho phép người sử dụng có thể vẽ, thao tác với dữ liệu đồ 

hoạ dạng vector trên Nền dữ liệu raster đã hiển thị. Khả năng hiển thị ảnh làm nền để 

tạo dữ liệu vector trên đó là một trong các chức năng rất mạnh của Mapping Office.  

 IrasC có thể chạy hoàn toàn độc lập hoặc chạy kết hợp với các modul phần 

mềm khác của Intergraph, khả năng này rất tốt khi người sử dụng số hoá ảnh theo các 
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đối tượng địa lý, các lớp thông tin không gian có gắn theo thông tin thuộc tính dể xây 

dựng dữ liệu cho hệ thống thông tin địa lý GIS. 

 Với khả năng hiển thị và xử lý ảnh cao cấp, đồng thời cho phép thao tác, xử lý 

song song trên cả hai loại dữ liệu raster và vector, IrasC hoàn toàn thoả mãn cho mục 

đích thành lập nhiều dạng bản đồ khác nhau dựa trên nền ảnh như bản đồ địa chính, 

bản đồ hiện trạng sử dụng đất..., và đặc biệt là các bản đồ đánh giá biến động của bất 

kỳ một đối tượng tự nhiên nào theo thời gian.  

 c. Geovec  

 Geovec là một phần mềm chạy trên nền của MicroStation cung cấp các công cụ số 

hoá bán tự động các đối tượng trên nền ảnh đen trắng (Dạng Binary) sang dạng vector với 

công nghệ dượt đường bán tự động cao cấp. Mỗi một đối tượng số hoá bằng Geovec phải 

được định nghĩa trước các thông số đồ hoạ về màu sắc, lớp thông tin, khi đó đối tượng 

này được gọi là một feature. Mỗi một feature có một tên gọi và mã số riêng.  

 Trong quá trình số hoá các đối tượng bản đồ, Geovec tự động nhận dạng các đối 

tượng ảnh dạng tuyến và cho phép ta chuyển thành một loạt các vertex nằm đúng tâm 

đường ảnh vì thế phần mềm này đặc biệt hiệu quả trong việc số hoá các đối tượng dạng 

đường, làm giảm đáng kể thời gian trong việc chuyển đổi dữ liệu cũ sang dạng số.  

 d. MSFC  

 MSFC (MicroStation Feature Collection) Modul cho phép người dùng khai báo 

và đặt các đặc tính đồ hoạ cho các lớp thông tin khác nhau của bản đồ phục vụ cho quá 

trình số hoá, đặc biệt là số hoá trong Geovec. Ngoài ra, MSFC còn cung cấp một loạt 

các công cụ số hoá bản đồ trên nền MicroStation. MSFC được sử dụng: 

 - Để tạo bảng phân lớp và định nghĩa các thuộc tính đồ hoạ cho đối tượng. 

 - Quản lý các đối tượng cho quá trình số hoá.  

 - Lọc điểm và làm trơn đường với các đối tượng đường riêng lẻ.  

 e. MRFclean  

 MRFclean được viết bằng MDL (MicroStation Development Language) và 

chạy trên nền của MicroStation. MRFclean dùng để:  

 - Xoá những đường, những điểm trùng nhau.  

 - Cắt đường: tách một đường thành hai đường tại điểm giao với đường khác.  

 - Tự động loại các đoạn thừa có độ dài nhỏ hơn Dangle-factor nhân với tolerence.  

 f. MRFflag  

 MRFflag được thiết kế tương hợp với MRFclean, dùng để tự động hiển thị lên 

màn hình lần lượt các vị trí có lỗi mà MRFclean đã đánh dấu trước đó và người sẽ sử 

dụng các công cụ của MicroStation để sửa.  
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 g. Iplot  

 Là bộ phần mềm chuyên dụng cho việc in ấn các tệp tin *.dgn của 

MicroStation. Bộ phần mềm này bao gồm 2 phần mềm chính là Iplot client và Iplot 

server. Iplot client nhận các yêu cầu in trực tiếp tại các trạm làm việc còn Iplot Server 

nhận các yêu cầu in qua mạng, do vậy để thực hiện việc in ấn trên máy tính ít nhất phải 

cài đặt Iplot Client. Iplot cho phép đặt các thông số in như lực nét, thứ tự in các đối 

tượng... thông qua tệp tin điều khiển Pen-table. 

1.1.2. Phần mềm Famis 

 Famis là phần mềm “Tích hợp đo vẽ bản đồ địa chính” (Field Work And 

Cadstral Mapping Intergraphted Software-Famis). Đây là phần mềm được Tổng cục 

địa chính toàn quốc ban hành năm 1998 và áp dụng cho tất cả các cơ sở địa chính 

trong toàn quốc nhằm đáp ứng nhu cầu sử dụng ngày càng cao đối với bản đồ địa 

chính đồng thời thống nhất công nghệ và chuẩn hóa dữ liệu để thống nhất quản lý việc 

lập bản đồ và hồ sơ địa chính. Famis là phần mềm chuyên biệt cho công tác thành lập 

bản đồ địa chính đầu tiên ở nước ta.   

 Hệ thống phần mềm chuẩn thống nhất trong ngành địa chính phục vụ lập bản 

đồ và hồ sơ địa chính bao gồm 2 phần mềm lớn : 

 “Phần mềm tích hợp cho đo vẽ và bản đồ địa chính (Field Work and Cadastral 

Mapping Intergrated Software – FAMIS )” có khả năng xử lý số liệu đo ngoại nghiệp, 

xây dựng, xử lý và quản lý bản đồ địa chính số. Phần mềm đảm nhiệm công đoạn từ 

sau khi đo vẽ ngoại nghiệp cho đến hoàn chỉnh một hệ thống bản đồ địa chính số. Cơ 

sở dữ liệu bản đồ địa chính kết hợp với cơ sở dữ liệu Hồ sơ Địa chính để thành một cơ 

sở dữ liệu vẽ Bản đồ và Hồ sơ địa chính thống nhất. 

 “Hệ quản trị cơ sở dữ liệu Hồ sơ Địa chính Cadastral Document Database 

Management System CADDB” là phần mềm thành lập và quản lý các thông tin vẽ hồ 

sơ địa chính. Hệ thống cung cấp các thông tin cần thiết để thành lập Bộ Hồ sơ Địa 

chính. Hỗ trợ công tác tra cứu, thanh tra, quản lý sử dụng đất. Cấp giấy chứng nhận sử 

dụng đất, thống kê tình hình sử dụng đất .v.v 

1.1.3. Phần mềm MapSubject 

 MapSubject là phần mềm chuyên thành lập bản đồ hiện trạng, bản đồ quy 

hoạch sử dụng đất và các loại bản đồ chuyên đề khác chạy trên nền MicroStation bám 

sát theo theo các hướng dẫn của ngành Tài nguyên Môi trường như: 

 + Thông tư 28/2014/TT-BTNMT Quy định về thống kê, kiểm kê đất đai và lập 

bản đồ hiện trạng sử dụng đất. 

 + Thông tư 29/2014/TT-BTNMT Quy định chi tiết việc thành lập, điều chỉnh 

quy hoạch, kế hoạch sử dụng đất. 

 Phần mềm MapSubject được sử dụng song hành với các phần mềm thông dụng 

trong lĩnh vực thành lập bản đồ địa chính như Famis, TMV.Map. Sản phẩm thể hiện 
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tính mở rất cao để phù hợp với những loại bản đồ khác nhau, đáp ứng kịp thời các yêu 

cầu mang tính địa phương của từng đơn vị sử dụng.  

 Phần mềm có nhiều chức năng như: Tự động tìm, sửa lỗi, tạo vùng; Đánh số 

khoanh, gán thông tin, chỉnh sửa thông tin; Vẽ nhãn thông tin kiểm tra; Đổi màu nét 

thửa theo loại đất; Nuốt ranh thửa bán tự động (chọn thửa); Nuốt ranh thửa tự động 

(cùng loại đất); Tạo khung bản đồ hiện trạng, quy hoạch; Tạo biểu đồ cơ cấu diện tích; 

Khung trình duyệt bản đồ của các cơ quan chức năng; Đặt thứ tự các lớp khi xem; Cố 

định thứ tự các lớp khi xem; Tô màu và pattern tự động bản đồ hiện trạng, quy hoạch; 

Vẽ nhãn bản đồ hiện trạng, quy hoạch; Vẽ nhãn bản đồ kết quả điều tra kiểm kê; Hỗ 

trợ kí hiệu các loại đất theo quy định; Chọn phân lớp thông tin; Vẽ các đối tượng 

điểm; Chọn kiểu chữ; Phân thành nhiều file theo các lớp định nghĩa… 

 Phần mềm cũng rất đa dạng các bảng biểu tổng hợp như: Tổng hợp nhãn theo 

khoanh đất; Tổng hợp diện tích theo khoanh đất; Biểu chi tiết thông tin các thửa đất; 

Biểu tổng hợp diện tích trích dọc; Biểu tổng hợp diện tích trích ngang; Báo cáo thông 

tin tổng hợp toàn đơn vị hành chính… 

1.1.4. Phần mềm ViLIS 

 Phần mềm ViLIS (Viet nam Land Informationm System) được xây dựng dựa 

trên nền tảng các thủ tục về kê khai đăng ký, lập hồ sơ địa chính (HSĐC) và cấp giấy 

chứng nhận quyền sử dụng đất (GCNQSDĐ) theo thông tư 1990/TT-TCĐC ngày 30 

tháng 11 năm 2001 của Tổng cụ Địa chính “Hướng dẫn đăng ký đất đai, lập HSĐCvà 

cấp GCNQSDĐ”. 

 Phần mềm gồm 2 hệ thống chính: 

 - Hệ thống kê khai đăng ký và lập HSĐC 

 - Hệ thống đăng ký và quản lý biến động đất đai 

 Các hệ thống được xây dựng với chức năng giải quyết hầu hết các vấn đề trong 

công tác quản lý đất đai hiện nay từ dữ liệu bản đồ đến HSĐC tạo sự thống nhất từ trên 

xuống dưới ở các cấp quản lý. 

 Ngoài ra tùy theo yêu cầu của từng địa phương, các chức năng và giao diện của 

hệ thống sẽ được sửa chữa và cập nhật cho phù hợp với các hoạt động quản lý và sử 

dụng đất đai tại địa phương. 

 VILIS là một phần mềm hệ thống thông tin đất đai đa mục tiêu, cung cấp đầy 

đủ những công cụ, chức năng để thực hiện các công tác nghiệp vụ chuyên môn của 

công tác quản lý đất đai. Phần mêm VILIS bao gồm nhiều phần, mỗi phần bao gồm 

các chức năng hỗ trợ một nội dung của công tác quản lý nhà nước về đất đai.  

 Các chức năng cơ bản của phần mềm VILIS như: Đăng ký, quản lý biến động 

đất đai; quản lý quy hoạch; quản lý giá, thuế đất; đăng ký thống kê; quản lý theo quy 

trình; hệ thống tham chiếu không gian; quản lý truy nhập... Theo đó, sau giai đoạn đo 

đạc, thành lập bản đồ các loại với độ chính xác cao bằng những công nghệ mới, VILIS 
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sẽ giúp xây dựng một cơ sở dữ liệu có lưu trữ một cách thống nhất toàn bộ khối lượng 

sản phẩm bản đồ đảm bảo khả năng tích hợp, tra cứu, cập nhật một cách nhanh chóng, 

chính xác và đảm bảo tính an toàn, bảo mật dữ liệu; hiện đại hóa và đẩy nhanh quá 

trình đăng ký cấp GCNQSDĐ,  cập nhật kịp thời các biến động đất đai đang xảy ra... 

Ngoài ra, VILIS còn giúp tăng cường năng lực quản lý nhà nước, cung cấp những 

thông tin đất đai nhanh chóng và hiệu quả, giảm chi phí và thời gian trong quá trình 

khai thác sử dụng các tài liệu trong hệ thống HSĐC, làm tiền đề để nâng cao hiệu quả 

và quản lý quá trình xử lý hồ sơ xin đăng ký cấp giấy CNQSDĐ... 

1.1.5. Phần mềm ArcGIS 

 Phần mềm ArcGIS (ESRI Inc.) là hệ thống GIS hàng đầu hiện nay, cung cấp 

một giải pháp toàn diện từ thu thập, nhập số liệu, chỉnh lý, phân tích và phân phối 

thông tin trên mạng Internet tới các cấp độ khác nhau như CSDL địa lý cá nhân hay 

CSDL của các doanh nghiệp. Về mặt công nghệ, hiện nay các chuyên gia GIS coi công 

nghệ ESRI là một giải pháp mang tính chất mở, tổng thể và hoàn chỉnh, có khả năng 

khai thác hết các chức năng của GIS trên các ứng dụng khác nhau như: desktop 

(ArcGIS Desktop), máy chủ (ArcGIS Server), các ứng dụng Web (ArcIMS, ArcGIS 

Online), hoặc hệ thống thiết bị di động (ArcPAD)... và có khả năng tương tích cao đối 

với nhiều loại sản phẩm của nhiều hãng khác nhau. 

 ArcGIS Desktop (với phiên bản mới nhất là ArcGIS 10) bao gồm những công 

cụ rất mạnh để quản lý, cập nhật, phân tích thông tin và xuất bản tạo nên một hệ thống 

thông tin địa lý (GIS) hoàn chỉnh, cho phép: 

 - Tạo và chỉnh sửa dữ liệu tích hợp (dữ liệu không gian tích hợp với dữ liệu 

thuộc tính) cho phép sử dụng nhiều loại định dạng dữ liệu khác nhau thậm chí cả 

những dữ liệu lấy từ Internet;  

 - Truy vấn dữ liệu không gian và dữ liệu thuộc tính từ nhiều nguồn và bằng 

nhiều cách khác nhau; 

 - Hiển thị, truy vấn và phân tích dữ liệu không gian kết hợp với dữ liệu thuộc tính; 

 - Thành lập bản đồ chuyên đề và các bản in có chất lượng trình bày chuyên nghiệp. 

 ArcGIS Destop là một bộ phần mềm ứng dụng gồm: ArcMap, ArcCatalog, 

ArcToolbox, ModelBuilder, ArcScene và ArcGlobe. Khi sử dụng các ứng dụng này 

đồng thời, người sử dụng có thể thực hiện được các bài toán ứng dụng GIS bất kỳ, từ 

đơn giản đến phức tạp, bao gồm cả thành lập bản đồ, phân tích địa lý, chỉnh sửa và 

biên tập dữ liệu, quản lý dữ liệu, hiển thị và xử lý dữ liệu. Phần mềm ArcGIS Desktop 

được cung cấp cho người dùng ở 1 trong 3 cấp bậc với mức độ chuyên sâu khác nhau 

là ArcView, ArcEditor, ArcInfo. 

1.1.6. Chương trình thống kê kiểm kê online 

 Chương trình thống kê, kiểm kê đất đai là một phần mềm ứng dụng Web được 

xây dựng để quản lý, cập nhật số liệu thống kê, kiểm kê đất đai của các cấp, từ cấp xã 

đến cấp Trung Ương. Chương trình được cài đặt tại Tổng cục Quản lý đất đai, người 
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sử dụng truy cập vào phần mềm qua đường truyền Internet để thực hiện. Cơ sở dữ liệu 

thống kê, kiểm kê là thống nhất và tập trung trên toàn quốc. Tại các máy trạm không 

cần cài đặt phần mềm, chạy trực tiếp trên ứng dụng webbase.  

 Đường dẫn để truy cập phần mềm: http://tk.gdla.gov.vn 

1.2. Ứng dụng tin học chuyên ngành trong công tác quản lý đất đai 

1.2.1. Xây dựng bản đồ địa chính  

Bản đồ địa chính là bản đồ được đo vẽ trực tiếp hoặc biên tập, biên vẽ từ bản đồ 

địa chính cơ sở theo từng đơn vị hành chính xã, phường, thị trấn (gọi chung là cấp xã). 

Bản đồ địa chính được đo vẽ bổ sung để đo vẽ trọn vẹn các thửa đất, xác định các loại 

đất theo chỉ tiêu thống kê của từng chủ sử dụng đất trong mỗi mảnh bản đồ và được 

hoàn chỉnh phù hợp với số liệu trong hồ sơ địa chính. 

Bản đồ địa chính là loại bản đồ tỷ lệ lớn và tỷ lệ trung bình, được thành lập theo 

đơn vị hành chính xã, phường, thị trấn. Để quản lý được đất đai, chúng ta phải có được 

bản đồ địa chính, hồ sơ địa chính, giấy chứng nhận quyền sử dụng đất. Toàn bộ các tư 

liệu này phải phản ánh thửa đất với đầy đủ 4 yếu tố: 

- Yếu tố tự nhiên của thửa đất như vị trí, hình dạng, kích thước, chất lượng đất… 

- Yếu tố xã hội của thửa đất như chủ sử dụng đất, chế độ sử dụng đất, quá trình 

biến động đất đai… 

- Yếu tố kinh tế thửa đất như giá đất, thuế đất, lợi nhuận do kinh tế mang lại, 

giá trị các công trình trên đất… 

- Yếu tố pháp lý thửa đất như các văn bản giấy tờ xác định quyền sử dụng, 

xác nhận quy hoạch… 

Một số yếu tố trên được ghi nhận trong hồ sơ địa chính, một số yếu tố khác 

được thể hiện trên bản đồ địa chính. Bản đồ địa chính là công cụ để quản lý đất đai, 

trên đó ghi nhận các yếu tố tự nhiên của thửa đất và quan hệ với các yếu tố địa lý khác 

trong khu vực. Ngoài ra nhằm mục đích liên hệ với hồ sơ địa chính người ta còn thể 

hiện tên chủ sử dụng đất, loại đất và một số yếu tố quy họach sử dụng đất. 

Hiện nay công tác thành lập bản đồ địa chính là nhu cầu cấp bách không chỉ 

riêng của ngành địa chính mà của cả các cấp chính quyền cũng như toàn xã hội, bởi 

bản đồ địa chính là sản phẩm đo đạc bản đồ có tính pháp lý cao, nó là tài liệu quan 

trọng trong quá trình cấp giấy chứng nhận quyền sử dụng đất, lập quy hoạch, kế hoạch 

sử dụng đất và các nội dung khác trong quản lý Nhà nước về đất đai. Việc xây dựng cơ 

sở dữ liệu địa chính phải tuân theo các nguyên tắc cụ thể như sau: 

 - Việc xây dựng, cập nhật, quản lý và khai thác sử dụng dữ liệu địa chính phải 

đảm bảo tính chính xác, khoa học, khách quan, kịp thời và thực hiện theo quy định 

hiện hành về lập hồ sơ địa chính, cấp giấy chứng nhận QSD đất, quyền sở hữu nhà ở 

và tài sản khác gắn liền với đất. 

 

http://tk.gdla.gov.vn/
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 - Cơ sở dữ liệu địa chính phải được xây dựng theo đơn vị hành chính xã, 

phường, thị trấn (gọi chung là cấp xã) và được tổ chức, quản lý ở quận, huyện, thị xã, 

thành phố trực thuộc tỉnh (gọi chung là cấp huyện) và ở tỉnh, thành phố trực thuộc 

trung ương (gọi chung là cấp tỉnh). Cơ sở dữ liệu địa chính ở Trung ương được tổng 

hợp từ tất cả các đơn vị hành chính cấp tỉnh trên phạm vi cả nước. Mức độ tổng hợp do 

Tổng cục Quản lý đất đai quy định cụ thể sao cho phù hợp với yêu cầu quản lý của 

từng giai đoạn. 

 Hiện nay, công nghệ thành lập bản đồ địa chính ở nước ta phổ biến gồm hai 

phương pháp sau:  

 - Công nghệ đo vẽ mặt đất: Được áp dụng trong ở những vùng dân cư đô thị 

hoặc nông thôn để thành lập bản đồ địa chính tỷ lệ 1/500 hoặc 1/1000. Hiện nay công 

nghệ này được áp dụng dựa trên các tiến bộ khoa học kỹ thuật kết hợp giữa công nghệ 

tự động hoá thành lập bản đồ số toàn đạc điện tử và các phần mềm tin học ứng dụng 

như MicroStation, Famis, AutoCAD...  

 - Công nghệ thành lập bản đồ địa chính từ ảnh hàng không hoặc ảnh viễn 

thám: Phương pháp này sử dụng tư liệu ảnh máy bay hoặc các ảnh viễn thám có độ 

phân giải siêu cao (dữ liệu ảnh thu được có độ phân giải mặt đất nhỏ hơn 1m) kết hợp 

các phần mềm chuyên dụng để thành lập bản đồ. Đây là phương pháp làm giảm đáng 

kể thời gian lập bản đồ và đặc biệt hiệu quả đối với những vùng rộng lớn và những 

vùng đi lại khó.  

1.2.2. Xây dựng bản đồ hiện trạng sử dụng đất, quy hoạch sử dụng đất 

 Bản đồ hiện trạng sử dụng đất là bản đồ thể hiện sự phân bố các loại đất theo 

quy định về chỉ tiêu kiểm kê theo mục đích sử dụng đất tại thời điểm kiểm kê đất đai 

và được lập theo đơn vị hành chính các cấp, vùng địa lý tự nhiên - kinh tế và cả nước. 

Bản đồ hiện trạng sử dụng đất thường được xây dựng cho từng cấp hành chính 

xã, huyện, tỉnh và cả nước. Đầu tiên phải xây dựng bản đồ hiện trạng sử dụng đất cấp 

xã sau đó sẽ dùng bản đồ các xã để tổng hợp thành bản đồ cấp huyện, tỉnh. 

Để đáp ứng kịp thời nhu cầu thành lập bản đồ hiện trạng sử dụng đất nhằm 

phục vụ cho công tác quản lý Nhà nước về đất đai cũng như nhu cầu sử dụng bản đồ 

hiện trạng sử dụng đất của các ngành, các lĩnh vực, đồng thời để thống nhất quản lý về 

mặt kỹ thuật thành lập bản đồ hiện trạng sử dụng đất trong phạm vi cả nước, ngày 

31/12/2004, Bộ trưởng Bộ TN&MT đã ra quyết định số 22/2007/QĐ-BTNMT “Quy 

định về thành lập bản đồ hiện trạng sử dụng đất”, quyết định số 23/2007/QĐ-BTNMT 

về ban hành “Ký hiệu bản đồ hiện trạng sử dụng đất và bản đồ quy hoạch sử dụng đất”, 

thông tư số 13/2011/TT-BTNMT về việc ban hành “Quy định về Ký hiệu bản đồ hiện 

trạng sử dụng đất phục vụ quy hoạch sử dụng đất và bản đồ quy hoạch sử dụng đất” và 

thông tư số 28/2014/TT-BTNMT về việc ban hành “Quy định về thống kê, kiểm kê và 

lập bản đồ hiện trạng sử dụng đất” áp dụng thống nhất trong cả nước. Việc ra đời của 

các tài liệu nói trên giúp cho những người làm công tác lập bản đồ có một công cụ 

chuẩn để thống nhất nguồn dữ liệu bản đồ hiện trạng sử dụng đất dạng số trên cả nước. 
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1.2.3. Xây dựng các loại bản đồ chuyên đề 

 Hiện nay có rất nhiều loại bản đồ chuyên đề với nhiều mục đích sử dụng khác 

nhau. Do đó việc xây dựng các loại bản đồ chuyên đề này còn tùy thuộc vào mục đích 

sử dụng của người làm bản đồ. Trong phần này chủ yếu giới thiệu một số các loại bản 

đồ chuyên đề thường gặp trong ngành quản lý đất đai. 

 a. Bản đồ địa hình 

 Bản đồ địa hình loại bản đồ địa lý chung, vì nội dung của nó chứa đựng các 

thông tin về yếu tố tự nhiên như địa hình, chất đất, thuỷ văn, lớp phủ thực vật…và các 

yếu tố về kinh tế - văn hoá - xã hội như dân cư, hệ thống đường xá, cầu cống, các cơ 

sở sản xuất - dịch vụ, các công trình công cộng, địa giới hành chính. 

 Bản đồ địa hình cho ta khả năng nhận thức bề mặt địa lý một cách tổng quát, 

dựa vào bản đồ địa hình cụ thể nhanh chúng xác định đuợc toạ độ và độ cao của bất kỳ 

một điểm nào trên mặt đất khoảng cách và phương hướng giữa hai điểm… Trên bản 

đồ cũng thể hiện các mặt định tính, định lượng, hình dạng và trạng thái của các yếu tố 

địa lý, ghi chú địa danh của chúng.  

 Bản đồ địa hình là tài liệu không thể thiếu được trong bất kỳ một công tác 

nghiên cứu về lãnh thổ cũng như trong công tác thiết kế, quy hoạch và phân vùng sản 

xuất. Mỗi loại tỷ lệ khác nhau các bản đồ địa hình đều có những mục đích sử dụng 

khác nhau. 

 Công nghệ sản xuất bản đồ địa hình ở Việt Nam chủ yếu có nhiều hướng: 

 - Thành lập bản đồ địa hình bằng phương pháp biên vẽ chuyển tiếp từ ản đồ địa 

hình tỷ lệ lớn hơn vừa mới đo vẽ kế cận về tỷ lệ nhỏ hơn. 

 - Thành lập bản đồ địa hình bằng phương pháp đo vẽ trực tiếp ngoài thực địa. 

 - Thành lập bản đồ địa hình bằng phương pháp đo vẽ trực tiếp sử dụng ảnh vệ tinh. 

 b. Bản đồ đất (Bản đồ thỗ nhưỡng) 

 Bản đồ đất thuộc nhóm bản đồ chuyên đề, chúng thể hiện những kết quả điều 

tra, nghiên cứu sâu về phân loại đất, các đặc tính, tính chất đất có quan hệ với các mục 

đích đánh giá về khả năng sử dụng, quy hoạch sử dụng, bảo vệ, cải tạo đất và xây 

dựng các biện pháp sử dụng đất bền vững… 

 Việc xây dựng bản đồ đất ở nước ta được bắt đầu tiến hành ngay sau khi các hệ 

thống phân loại đất hình thành và từng bước hoàn thiện. Tuy nhiên đến năm 1984, bản 

quy phạm tiêu chuẩn ngành đầu tiên mới được ra đời và áp dụng từ đó đến nay. Trong 

quy phạm xây dựng bản đồ đất nêu rõ những yêu cầu cần đạt được trong xây dựng bản 

đồ đất như sau: 

 - Tài liệu điều tra đất được dùng để đánh giá đất đai và quy hoạch sử dụng đất, 

kiểm kê, đánh giá tài nguyên đất đai của từng vùng cụ thể cho các mục đích sử dụng 

đất của sản xuất nông nghiệp. Do đó nội dung, tài liệu bản đồ phải phản ánh rõ vị trí, 

sự phân bố, số lượng và chất lượng các loại đất (các đơn vị phân loại đất) ở từng vùng 
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điều tra, để bố trí sử dụng đất hợp lý và áp dụng các biện pháp bảo vệ, cải tạo đất thích 

hợp và bền vững. 

 - Mức độ yêu cầu và các tỷ lệ bản đồ khác nhau tùy thuộc vào các mục đích sử 

dụng. Trong đó những tỷ lệ sau đây thường hay được sử dụng ở nước ta: 

 + Bản đồ đất khái quát toàn quốc ở tỷ lệ 1/1.000.000 hoặc nhỏ hơn. 

 + Bản đồ đất được xây dựng cho các tỉnh hay các vùng sinh thái ở tỷ lệ 

1/100.000 – 1/50.000 

 + Bản đồ đất xây dựng cho các huyện, thị hay các vùng chuyên canh (các cơ sở 

sản xuất lớn, sản xuất cây trồng, chăn nuôi, nghề rừng…) ở tỷ lệ 1/50.000 – 1/25.000 

 + Bản đồ đất xây dựng cho các vùng sản xuất cấp huyện, xã có diện tích từ 

5000 đến 20.000 ha thường có tỷ lệ 1/10.000 

 + Bản đồ đất tỷ lệ 1/5000 xây dựng cho các vùng diện tích cấp xã hay cơ sở sản 

xuất nghiên cứu có diện tích dưới 500 ha 

 - Tỷ lệ bản đồ nền địa hình hay bản đồ giải thửa được sử dụng để xây dựng bản 

đồ đất phải có tỷ lệ lớn hơn tỷ lệ bản đồ đất cần xây dựng. 

 c. Bản đồ đơn vị đất đai 

 Bản đồ đơn vị đất đai là một loại bản đồ chuyên đề được xây dựng trên cơ sở 

chồng xếp các loại bản đồ đơn tính về các điều kiện tự nhiên có ảnh hưởng đến chất 

lượng đất đai. Các khoanh/vạt đất được thể hiện trên bản đồ đơn vị đất đai sau khi 

chồng xếp gọi là “Đơn vị bản đồ đất đai – LMU (Land Mapping Unit)” 

 Trước đây bản đồ đơn vị đất đai chủ yếu được xây dựng bằng phương pháp thủ 

công (chồng ghép trên bàn kính và khoanh bằng tay). Cùng với sự phát triển của công 

nghệ thông tin và hệ thống thông tin địa lý GIS, cho phép người sử dụng có thể chồng 

xếp (overlay) các bản đồ đơn tính một cách dễ dàng, nhanh chóng với độ chính xác 

cao. Các loại bản đồ đơn tính phục vụ xây dựng bản đồ đơn vị đất thường dung trong 

GIS là: 

 - Bản đồ đất (bản đồ thổ nhưỡng) 

 - Bản đồ địa hình hoặc độ dốc 

 - Bản đồ khí hậu; tài nguyên nước; chế độ nước 

 - Bản đồ thảm thực vật; hiện trạng sử dụng đất… 

 Số lượng và nội dung bản đồ đơn tính phục thuộc vào việc xác định các chỉ tiêu 

xây dựng bản đồ đơn vị đất đai. Các chỉ tiêu xây dựng bản đồ đơn vị đất đai được xác 

định dựa vào các can cứ sau: 

 - Đặc điểm tự nhiên của vùng nghiên cứu 

 - Mục tiêu nghiên cứu của dự án đánh giá đất đai 

 - Yêu cầu sử dụng đất của các loại hình sử dụng đất được chọn 

 - Quy mô diện tích và tỉ lệ bản đồ cần xây dựng 

 - Nguồn tài liệu sẵn có và khả năng bổ sung 
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 d. Bản đồ giá đất 

 Trong xu hướng thực hiện pháp luật về đất đai phải phù hợp với nền kinh tế thị 

trường, đất đai phải được quản lý chặt chẽ, sử dụng hiệu quả, công khai, minh bạch… 

đòi hỏi chúng ta phải ưu tiên đầu tư xây dựng và hoàn thiện hệ thống thông tin đất đai, 

cơ sở dữ liệu đất đai và hệ thống hồ sơ địa chính theo hướng hiện đại, theo mô hình tập 

trung, thống nhất trên phạm vi cả nước, phục vụ đa mục tiêu, chuyển dần các hoạt 

động đăng ký, giao dịch trong lĩnh vực đất đai sang giao dịch điện tử. Đồng thời nhằm 

nâng cao năng lực quản lý nhà nước ngành quản lý đất, theo định hướng chúng ta phải 

sẽ hoàn thiện nguyên tắc, phương pháp định giá đất theo vùng giá trị và triển khai xây 

dựng bản đồ giá đất, giá đất vùng giáp ranh, cơ sở dữ liệu giá đất toàn quốc phục vụ 

quản lý nhà nước và phát triển thị trường quyền sử dụng đất trong thị trường bất động 

sản. Theo đó, từng thửa đất sẽ được người dân khai giá, sau đó cơ quan chức năng 

thẩm định, cập nhật theo giá thị trường. Dựa trên các cơ sở dữ liệu đã có tiến hành bắt 

đầu đề xuất xây dựng bản đồ giá đất phục vụ công tác quản lý đất đai trên cả nước. 

Bản đồ giá đất này làm cơ sở cho việc chuyển nhượng, đền bù, tính thuế... 
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CHƯƠNG 2 

PHẦN MỀM MICROSTATION 

2.1. Tổ chức dữ liệu trong MicroStation  

2.1.1. Các file trong Microstation  

 File dữ liệu của MicroStation gọi là design file (*.dgn). Mỗi file bản vẽ đều 

được định vị trong một hệ thống toạ độ nhất định với các tham số về lưới toạ độ, đơn 

vị đo, phạm vi làm việc, số chiều của không gian làm việc... Để cho nhanh chóng khi 

tạo file, các tham số này thường được xác định sẵn trong một số file chuẩn gọi là seed 

file và khi tạo file mới người sử dụng chỉ việc chọn Seed file phù hợp để sao chép các 

tham số này từ seed file sang file cần tạo.  

 Seed file thực chất là một design file trắng (không chứa dữ liệu) nhưng nó chứa 

đầy đủ các thông số quy định chế độ làm việc với MicroStation. Đặc biệt với các file 

bản đồ, để đảm bảo tính thống nhất về cơ sở toán học giữa các file dữ liệu, phải tạo các 

file chứa các tham số về hệ toạ độ, phép chiếu, đơn vị đo.... Sau đó các file bản đồ có 

cùng cơ sở toán học sẽ được tạo dựa trên nền seed file này. Mỗi một cơ sở toán học 

của bản đồ sẽ có một seed file riêng.  

 MicroStation chỉ cho phép người sử dụng mở và làm việc với một design file 

tại một thời điểm. File này gọi là File hoạt động (Active design file).  

 Chúng ta có thể mở đồng thời nhiều design file trên nhiều cửa sổ Microstation 

khác nhau nhưng không thể mở cùng lúc 2 design file trên cùng một cửa sổ 

Microstation. Nếu mở một design file khi đã có một Design file khác đang mở sẵn, 

MicroStation sẽ tự động đóng file đầu tiên lại. Tuy nhiên chúng ta có thể xem (tham 

khảo) nội dung của các design file khác bằng các tác động đến các file dưới dạng các 

file tham khảo (Reference File).  

 Theo quy định của bộ TNMT, các đơn vị hành chính thuộc tỉnh nào thì phải sử dụng 

seed file của tỉnh đó. Mặc định ví tí của seed file là C:/win32app/ustation/wsmod/default/seed, 

tuy nhiên seed file cũng có thể lưu trữ tại bất kỳ vị trí nào trong máy tính tùy vào người sử 

dụng. 

2.1.2. Giao diện của Microstation 

 MicroStation cho phép giao diện với người dùng thông qua cửa sổ lệnh Command 

Window, các cửa sổ quan sát, các menu, các hộp hội thoại và các thanh công cụ.  

2.1.2.1. Cửa sổ lệnh Command Window 

 Trên cửa sổ lệnh hiển thị một số thông tin trong quá trình thành lập bản đồ 

như: trạng thái của yếu tố được chọn, các thuộc tính các đối tượng, tên của lệnh đang 

được thực hiện, thao tác tiếp theo cần thực hiện, các thông báo lỗi, kết quả đo đạc và là 

nơi để nhập lệnh từ bàn phím. 
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Hình 2.1. Cửa sổ lệnh Comand Window 

Mỗi một công việc nào đó trong MicroStation thường có thể thực hiện bằng 

nhiều phương pháp: từ biểu tượng của công cụ, từ menu, từ cửa sổ lệnh... tuỳ thuộc sự 

lựa chọn của người sử dụng. Nhưng dù sử dụng phương pháp nào thì thông tin về lệnh 

vừa thực hiện cũng được thể hiện trên cửa sổ lệnh Command Window. Sử dụng các 

lệnh trong MicroStation nói chung thường gồm hai bước. Bước thứ nhất nhằm xác 

định yếu tố cần thao tác, bước thứ hai để khẳng định (hoặc huỷ bỏ) lệnh cần thực hiện. 

Việc quan sát cửa sổ lệnh thường xuyên trong quá trình thực hiện các lệnh sẽ giúp ta 

thao tác nhanh chóng và không mắc phải sai sót. 

 Một số lệnh hay dùng với Command Windows: 

 “xy=<tọa độ x>,<tọa độ y>”: Tạo 1 điểm có toạ độ x,y 

 “MDL L <ứng dụng>”: Gọi một ứng dụng chạy trên nền MicroStation. Ví dụ: IrasB 

 “ Back”: Backup dữ liệu, lưu dữ liệu tại thời điểm đó dưới dạng file có đuôi 

*.bak, muốn phục hồi dữ liệu tại thời điểm backup chỉ cần đổi đuôi file thành dgn 

  “dx=<delta x>,<delta y>: Dịch chuyển đối tượng một khoảng theo giá trị 

delta theo trục tọa độ  

 “Com”: Nén file dữ liệu, có tác dụng làm giảm dung lượng của file  

 “ Fence change lock”: Khoá một vùng trên bản đồ sử dụng fence  

 “Fence change unlock”: Mở khoá một vùng trên bản đồ sử dụng fence 

 - Menu chính của MicroStation được đặt trên cửa sổ lệnh. Từ menu chính có 

thể mở ra nhiều menu dọc trong đó chứa rất nhiều chức năng của MicroStation. Ngoài 

ra còn có nhiều menu được đặt ở các cửa sổ hội thoại xuất hiện khi ta thực hiện một 

chức năng nào đó của MicroStation.  

2.1.2.2. Cửa sổ quan sát Window 

Là nơi chứa nội dung bản vẽ để ta quan sát và thực hiện các thao tác đồ hoạ cần 

thiết. Có thể mở cùng một lúc tối đa 8 cửa sổ. Có thể di chuyển vị trí hoặc thay đổi 

kích thước của các cửa sổ Windows như đối với các cửa sổ Window thông thường. Để 

đóng hoặc mở các cửa sổ, ta làm như sau:  

 + Chọn Windows/open-close/dialog, đánh dấu vào của sổ cần mở, đóng  

 + Chọn Windows/open-close, chọn cửa sổ cần mở 

2.1.2.3. Các thanh công cụ 

 Các thanh công cụ của MicroStation được mở từ menu Tools 

Để dễ dàng và thuận tiện trong thao tác, Microstation cung cấp cho chúng ta rất 

nhiều các công cụ tương đương như các lệnh. Các công cụ này có thể hiển thị trên màn 
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hình bằng các biểu tượng hoặc được nhóm lại với nhau theo các chức năng có liên 

quan với nhau.  

 a. Thanh công cụ chính (Main) 

 Các thanh công cụ chính thường dùng nhất được Microstation tập hợp lại và để 

trên một thanh công cụ gọi là Main Tool Box và được rút gọn lại thành nhóm ở dưới 

dạng biểu tượng. Ta có thể dùng chuột để kéo hết tất cả các công cụ trong một nhóm 

ra thành một Tool Box hoàn chỉnh.  

Khi ta sử dụng công cụ nào thì công cụ đó sẽ được hiển thị màu thẫm, đi kèm 

theo đó là hộp Tool Setting để chúng ta đặt các thông số cho các đối tượng đồ họa.  

 

Hình 2.2. Thanh công cụ chính 

 b. Thanh công cụ Primary 

 

Hình 2.3. Thanh công cụ Primary  

 Thanh công cụ Primary dùng để lựa chọn thông tin thuộc tính của các đối tượng 

trên bản vẽ gồm có: màu sắc, level chứa đối tượng, kiểu đường, lực nét. Ngoài ra trong 

thanh công cụ Primary còn cung cấp chức năng Analyze Element để xem thông tin 

thuộc tính của các đối tượng, đồng thời có thể thay đổi các thuộc tính của đối tượng đó.  

2.1.2.4. Thanh cuốn Scroll bar  

Thanh cuốn Scroll bars dùng để thay đổi tầm nhìn các đối tượng (vị trí, kích 

thước các đối tượng vẫn không thay đổi). Từ menu chọn Windows/Scroll bar. 

       

Hình 2.4. Thanh cuốn Scroll bar 

2.1.2.5. Bảng các thuộc tính hiển thị  

 Từ menu dọc chọn Settings/View Atributes (CTRL+ B) xuất hiện bảng thuộc 

tính hiển thị trên màn hình cho phép người sử dụng đặt các thuộc tính hiển thị cho từng 
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cửa sổ. Muốn chọn thuộc tính nào thì đánh dấu chọn ở ô tương ứng, sau đó ấn Apply để 

xác nhận. 

 - Fill: Cho phép hiển thị chế độ tô màu đối với những vùng kín được tô màu. Nếu 

chế độ Fill không được chọn thì tất cả các vùng được tô màu (kể cả những vùng được 

fill màu từ trước) sẽ không được hiển thị màu đã fill trên màn hình cũng như khi in ra. 

  - Line Styles: Cho phép sử dụng kiểu đường do người sử dụng tự thiết kế Nếu 

chế độ Line Styles không được chọn thì MicroStation chỉ cho phép hiển thị 8 kiểu 

đường cơ bản từ 0 đến 7.  

 - Line Weights: Cho phép hiển thị các yếu tố với lực nét thực tế mà người sử 

dụng đã chọn. Nếu không chọn chế độ này, lực nét ngầm định bằng 0. 

  - Patterns: Cho phép hiển thị chế độ trải patterns của các đối tượng.  

 

Hình 2.5. Hộp thoại hiển thị thông tin thuộc tính 

2.1.3. Khái niệm và làm việc với các lớp dữ liệu 

 Dữ liệu trong file DGN được tách riêng thành từng lớp dữ liệu. Mỗi một lớp dữ 

liệu được gọi là một level. Một file DGN nhiều nhất có 63 level. Các level này được 

quản lý theo mã số từ 1 đến 63 hoặc theo tên của level do người sử dụng đặt.  

 Các level dữ liệu có thể hiển thị (bật) hoặc không hiển thị (tắt) trên màn hình. 

Khi tất cả các level chứa dữ liệu được bật màn hình sẽ hiển thị đầy đủ nội dung của 

bản vẽ. Ta cũng có thể tắt tất cả các level trừ level đang hoạt động gọi là Active level. 

Active level là level các đối tượng sẽ được vẽ trên đó. Việc lưu giữ các đối tượng đồ 

họa trong các lớp cần phải theo quy phạm của bộ TNMT. 

2.1.2.1. Chọn lớp dữ liệu hoạt động 

 Trong quá trình làm việc với Microstation, luôn luôn có một lớp dữ liệu ở trạng 

thái hoạt động (Active level). Khi chuyển trạng thái hoạt động từ level này sang level 

khác thì các đối tượng được vẽ sau khi chuyển Active level thì sẽ nằm trên level đó, 

còn các đối tượng thuộc được vẽ trước đó thì vẫn thuộc level cũ.  

 *Cách 1: Từ cửa sổ lệnh của Microstation đánh lệnh lv=<Mã số hoặc tên 

level>, sau đó chọn phím Enter trên bàn phím.  
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 *Cách 2: Từ thanh Menu chọn Tools/Primary xuất hiện thanh Primary Tools 

bấm vào Active level, kéo chuột đến level cần chọn. 

 

Hình 2.6. Chọn Active level 

2.1.2.2. Ẩn, hiện lớp dữ liệu  

Các level có thể ẩn, hiện được, tuỳ theo yêu cầu của người sử dụng. Các level 

ẩn thì những dữ liệu trên level đó không hiển thị trên giao diện làm việc và không bị 

tác động bởi các lệnh biên tập trong Microstation (trừ lệnh Edit/Select All).  

 *Cách 1: Trên cửa sổ lệnh đánh lệnh on=< Mã số hoặc tên level>, sau đó chọn 

phím Enter trên bàn phím. Để tắt, thay “on” bằng “off”. Để sử dụng cho nhiều level 

chúng ta viết cách nhau một dấu “,”.  

 *Cách 2: Sử dụng tổ hợp phím nóng Ctrl + E, xuất hiện bảng View Levels. 

Kích chuột hoặc rê chuột đến các ô để đổi màu cho các ô và kích đúp để xác lập lớp 

hoạt động. Ô nào bôi đen là bật, trắng là tắt và đen tròn là hoạt động. Chọn Apply để 

thực hiện. 

 

Hình 2.7. Bảng điều khiển level 

2.1.4. Đối tượng đồ hoạ (Element)  

 Mỗi một đối tượng đồ hoạ xây dựng lên Design file được gọi là một element. 

Element có thể là một điểm, đường, vùng hoặc một chữ chú thích. Mỗi một element 

được định nghĩa bởi các thuộc tính đồ hoạ sau:  
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 - Vị trí: Tọa độ X,Y với file 2D (Toạ độ X,Y, Z với 3D)  

 - Tên lớp (level): có tất cả 63 lớp, đánh số từ 1 - 63 

 - Màu sắc (color): Bảng màu có 255 màu, đánh số từ 0- 254 

 - Kiểu nét (line style): có 8 loại nét cơ bản, đánh số từ 0-7 

 - Lực nét (weight): có 16 loại lực nét cơ bản, đánh số từ 0-15  

 - Màu tô (Fill color): Cho các đối tượng đóng vùng tô màu: từ 0-254 

 * Các kiểu đối tượng (element type) sử dụng cho các bản đồ số.  

 - Kiểu đối tượng dạng điểm:  

 + Là 1 Point = Line (đoạn thẳng) có độ dài bằng 0.  

 + Là 1 cell (một kí hiệu nhỏ) được vẽ trong MicroStation. Mỗi một cell được 

định nghĩa bởi một tên riêng và được lưu trữ trong một thư viện cell (Cell library).  

 - Kiểu đối tượng dạng đường:  

 + Line: đoạn thẳng nối giữa hai điểm.  

 + LineString: đường gồm một chuỗi các đoạn thẳng nối liền với nhau. (số đoạn 

thẳng nhỏ hơn 100). 

 - Kiểu đối tượng dạng vùng:  

 +Shape: Vùng được nối bởi chưa đến 100 đoạn thẳng. 

 + Complex Shape:  Vùng được nối bởi hơn 100 đoạn thẳng  hoặc là một vùng 

được tạo từ những line hoặc linestring rời nhau.  

 - Kiểu Element thể hiện các đối tượng dạng chữ viết:  

 + Text: đối tượng đồ hoạ dạng chữ viết.  

 + Text Node: nhiều đối tượng text được nhóm lại thành một Element. 

2.2. Sử dụng Microstation để biên tập bản đồ số 

2.2.1. Thao tác chuột (mouse) trong Microstation  

2.2.1.1. Các phím thao tác chuột 

Trong quá trình sử dụng Microstation, chúng ta thường phải sử dụng chuột 

trong 3 trạng thái sau: Data (Phím trái), Reset (Phím phải), Tentative (Đồng thời phím 

trái và phải). Trong đó:  

 - Data: Chọn các đối tượng hoặc các điểm trên màn hình; chấp nhận một thao 

tác nào đó. 

 - Reset: Kết thúc hoặc bỏ dở một lệnh vẽ; hoặc nếu đang vừa vẽ vừa sử dụng nút 

điều khiển màn hình thì kết thúc việc điều khiển màn hình và trở lại thao tác đang vẽ. 

 - Tentative: Xác định thử 1 điểm, nếu gần đối tượng thì điểm thử bắt vào vị trí 

theo các chế độ được quy định tại chức năng Snap. 
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2.2.1.2. Cách bắt điểm chính xác (Snap)  

Để tăng độ chính xác cho quá trình số hoá trong những trường hợp muốn đặt 

điểm Data vào đúng vị trí cần chọn, phím Tentative sẽ được dùng để đưa con trỏ vào 

đúng vị trí trước. Thao tác đó được gọi là bắt điểm (Snap to Element). Các chế độ 

chọn lựa cho thao tác bắt điểm gồm:  

- Nearest: con trỏ sẽ bắt vào vị trí gần nhất trên element.  

- Keypoint: con trỏ sẽ bắt vào điểm nút gần nhất element.  

- Midpoint: con trỏ sẽ bắt vào điểm giữa của element.  

- Center: con trỏ sẽ bắt vào tâm điểm của đối tượng.  

 - Origin: con trỏ sẽ bắt vào điểm gốc của cell. 

 - Intersection: con trỏ bắt vào điểm cắt nhau giữa hai đường giao nhau.  

 Chế độ bắt điểm chính xác ngầm định của Microstation là Keypoint và 

Midpoint. 

Để lựa chọn sử dụng các chức năng bắt điểm chính xác, có thể sử dụng 2 cách: 

 - Cách 1: Setting/Snap, rồi chọn các chế độ như trên  

 - Cách 2: Chọn các biểu tượng trong thanh công cụ Snap Mode 

 
Hình 2.8. Chế độ bắt điểm chính xác 

2.2.2. Tạo các đối tượng trong Microstation 

 Theo cách phân loại dữ liệu không gian, các kí hiệu trên bản đồ bao gồm 4 loại: 

 - Kí hiệu dạng điểm.  

 - Kí hiệu dạng đường.  

 - Kí hiệu dạng pattern (các kí hiệu được trải đều trên diện tích một vùng nào đó).  

 - Kí hiệu dạng chữ chú thích.  

 Các kí hiệu dạng điểm và pattern được thiết kế thành các cell. Các cell này được 

sử dụng một cách thường xuyên, lặp đi lặp lại nhiều lần trong quá trình số hoá cũng như 

biên tập bản đồ. Mỗi cell được định nghĩa bởi một thư viện chữa cell và tên cell.  

 Ví dụ: Các cell kí hiệu dùng cho bản đồ địa hình 1:50.000 được lưu chữ trong 

thư viện cell Dh-50.cell.  

 Trong thư viện này kí hiệu nhà độc lập phi tỷ lệ có tên là C.NHA.  

 Các kí dạng đường được thiết kế dưới dạng là các kiểu đường custom. Các kiểu 

đường dùng để biểu thị các đối tượng dạng đường của bản đồ được chứa trong thư 

viện kiểu đường (Line style Library) hay còn gọi là file resource bắt buộc phải được 

lưu trong thư mục C:\win32app\Ustation\wsmod\default\symbol\*.rsc 
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2.2.2.1. Tạo ký hiệu dạng điểm và pattern 

 Các ký hiệu dạng điểm và pattern được tạo thành các cell và chứa trong các thư 

mục cell riêng cho từng loại và từng tỷ lệ bản đồ khác nhau. Kích thước các cell khi 

thiết kế tính theo đơn vị đo chính MU (master unit) và sẽ bằng kích thước các ký hiệu 

khi in ra giấy nhân với mẫu số của tỷ lệ bản đồ.Trong quá trình thiết kế ký hiệu người 

sử dụng phải biết sử dụng một cách kết hợp và hài hoà các công cụ, các chức năng 

giúp vẽ chính xác đối tượng của MicroStation. 

 Cell type: Có hai kiểu cell chính Graphic và point. Các thuộc tính đồ hoạ của một 

cell dạng graphic được đặt khi vẽ ký hiệu, trong khi các giá trị thuộc tính của một cell 

dạng point sẽ được đặt tại thời điểm vẽ cell. Trước khi thiết kế một cell người sử dụng 

phải tạo hoặc mở thư viện sẽ chứa cell đó, → vẽ ký hiệu → tạo ký hiệu đó thành cell.  

2.2.2.2. Tạo ký hiệu dạng đường  

 Các ký hiệu dạng đường được thiết kế dưới dạng là các kiểu đường custom. Các 

kiểu đường dùng để biểu thị các đối tượng dạng đường của bản đồ được chứa trong 

thư viện kiểu đường (line style library) hay còn gọi là file resource. Vd: DH-50.rsc.  

 Để sử dụng được các kiểu đường này, các file resource bắt buộc phải được lưu 

trong thư mục: C:\win32app\ustation\wsmod\defaut\symbol\*.rsc.  

 Trong file resource mỗi một ký hiệu dạng đường được định nghĩa bao gồm tên 

ký hiệu, tên này được gắn một kiểu định nghĩa đường. Có 3 kiểu định nghĩa đường:  

 - Kiểu Stroke pattern: đường được định nghĩa dưới dạng là một nét đứt và một 

nét liền có chiều dài được xác định một cách chính xác (đơn vị tính theo đơn vị 

chính_MU), lực nét của các nét liền cũng được xác định một cách chính xác, màu sắc 

của đường sẽ được định nghĩa tuỳ theo người sử dụng sau này.  

 - Kiểu point symbol: Một chuỗi các ký hiệu nhỏ gọi là các point symbol (được 

tạo giống như tạo cell) đặt dọc theo chiều dài của đối tượng, khoảng cách giữa các ký 

hiệu được xác định chính xác (theo đơn vị đo chính) dựa trên chiều dài của các nét liền 

của một đường dạng Stroke pattern.  

 - Kiểu compound: Kiểu đường này được tạo nên từ sự kết hợp bất kỳ các kiểu 

đường nào với nhau. Kiểu này thường được sử dụng khi tạo các ký hiệu dạng đường 

vừa thể hiện các nét và các ký hiệu nhỏ trải dọc theo đường.  

 Tùy vào hình dáng và cách thể hiện ký hiệu dạng đường mà các ký hiệu được 

tạo dựa trên một trong 3 kiểu đường trên. 

2.2.2.3. Tạo các đối tượng dạng vùng 

 a. Tạo vùng trực tiếp từ thanh công cụ 

 Khi muốn tạo hình trực tiếp từ thanh công cụ, chúng ta có thể sử dụng các công 

cụ thuộc nhóm Place: 

 - Place Block để tạo vùng vuông góc. 

 - Place Shape để tạo hình khối có dạng bất kỳ. 
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 Khi tạo vùng cần phải lưu ý điền đầy đủ các thông số như sau: 

 - Tính chất của vùng: Là vùng đặc hay rỗng. 

 - Màu của vùng cách tô màu cho vùng (Fill type): Gồm có các lựa chọn là 

không tô (none), tô màu đồng nhất giữa đường biên của vùng và trong vùng (Opaque), 

tô màu không đồng nhất giữa đường biên và trong vùng (Outlined). 

 - Chọn màu sắc cho đường biên và vùng tô màu. 

 - Để đảm bảo các vùng được khép kín, khi sử dụng công cụ Place Shape cần 

phải sử dụng chế độ bắt điểm chính xác khi khép kín vùng. 

 

Hình 2.9. Tô màu chế độ outline 

 b. Tạo vùng bằng cách chuyển các đường thẳng thành vùng  

Để tạo được vùng theo phương pháp này, cần phải đảm bảo các yêu cầu sau: 

Đường bao các đối tượng phải khép kín, không tồn tại các điểm tự do, tại các điểm 

giao nhau phải có các điểm nút.  

 Chọn công cụ Create complex shape. Bấm chuột trái vào cạnh đầu tiên, sau đó 

bấm vào cạnh tiếp theo. Trường hợp lựa chọn method là Automatic thì con trỏ sẽ tự 

động chuyển sang cạnh tiếp theo. Nếu đến khu vực ngã ba hay ngã tư thì nếu con trỏ 

chỉ đúng, bấm chuột trái, nếu con trỏ chỉ sai, bấm chuột phải và chọn cạnh cho nó tiếp 

tục chạy. 

 

Hình 2.10. Chuyển đường thành vùng 

2.2.2.4. Tạo các đối tượng dạng Text  

 Để tạo các đối tượng dạng Text, cần sử dụng công cụ Place text trong thanh 

công cụ chính của Microstation.  
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 Khi tạo các đối tượng dạng text cần phải lưu ý một số vấn đề sau:  

 - Text Node Lock: Khóa việc đặt các ký tự lên bản đồ.  

 - Method: Cách thức đặt ký tự.  

 - Font: Font chữ (Để sử dụng được chữ Việt nên dùng TCVN3). 

 - Justification: Tâm của các ký tự.  

 - Active Angle: Góc đặt ký hiệu. 

 

Hình 2.11. Tạo đối tượng dạng text 

2.2.3. Biên tập các đối tượng đồ họa  

2.2.3.1. Biên tập các dữ liệu thuộc tính cho các đối tượng đồ họa  

 Các đối tượng đồ hoạ được đặc trưng bởi các thuộc tính cơ bản như: màu sắc, 

chiều dài, độ đậm (lực nét), dạng đường… Nếu chúng ta muốn chỉnh sửa các thuộc 

tính đó, trước hết cần phải để đối tượng đó trong môi trường đang hoạt động (có nghĩa 

là đối tượng đó là đối tượng đang được chọn).  Sau đó, chúng ta sử dụng công cụ 

Primary để thay đổi các thuộc tính 

 

Hình 2.12. Thay đổi thông tin thuộc tính của đối tượng biên tập 

2.2.3.2. Biên tập dữ liệu không gian  

 a. Biên tập các đối tượng dạng điểm  

* Sửa cell đặt không đúng vị trí:  

- Chọn công cụ Move element, bấm phím data để chọn đối tượng  

 - Bấm phím data đến vị trí mới của đối tượng. 

 

Hình 2.13. Công cụ di chuyển đối tượng 

*Sửa cell bị sai về kích thước:  
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- Chọn công cụ Scale element.  

- Đặt tỷ lệ cân đối cho đối tượng trong hộp scale.  

- Bấm phím data chọn đối tượng cần thay đổi.  

 - Bấm phím data để đổi kích thước đối tượng. 

 

Hình 2.14. Công cụ thay đổi kích thước đối tượng 

*Sửa cell sai về hình dạng:  

- Vẽ lại cell mới đùng hình dạng và kích thước.  

 - Tạo cell với tên cell giống như tên cũ.  

- Sử dụng chức năng Replace cell.  

 - Bấm phím data vào cell cần đổi 

 b. Biên tập các đối tượng dạng đường  

Microstation cung cấp cho chúng ta một loạt các công cụ để chỉnh sửa các đối 

tượng dạng đường như: bắt thừa, bắt thiếu điểm, làm trơn đường…  

Cụ thể:  

 - Kéo dài hai đường đến cắt nhau theo hướng định sẵn hoặc là loại bỏ các đoạn 

đường thừa bằng công cụ Extend Elements to Intersection . 

 

Hình 2.15. Xóa bỏ các đoạn thẳng có điểm cuối tự do 

- Kéo dài đoạn thẳng thứ nhất đến đoạn thẳng thứa hai theo hướng của đoạn 

thẳng thứ nhất hay nối các điểm bị bắt thiếu bằng công cụ Extend Element to 

Intersection . 
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Hình 2.16. Nối đoạn thẳng 

- Kéo dài đoạn thẳng theo hướng của đoạn thẳng cuối cùng của đoạn thẳng đó 

bằng công cụ Extend Element . 

 

Hình 2.17. Kéo dài đoạn thẳng 

- Cắt một đường hoặc một chuỗi các đường tại giao điểm của chúng với đối 

tượng khác bằng công cụ . 

 

Hình 2.18. Cắt đường thẳng tại điểm giao nhau giữa chúng và đường thẳng khác 

- Dịch chuyển đỉnh của các đoạn gấp khúc bằng công cụ . 

 

Hình 2.19. Dịch chuyển đỉnh của đoạn thẳng gấp khúc 

- Thêm điểm cho đoạn thẳng bằng công cụ . 
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Hình 2.20. Thêm điểm 

 c. Biên tập các đối tượng dạng vùng 

*Tạo các vùng mới từ các vùng có sẵn: 

 Thực chất của quá trình này là sử dụng công cụ Create region với các Method 

khác nhau để tạo ra các vùng mới, từ các vùng đã có sẵn bằng việc nhấn chuột trái vào 

các vùng đã chọn. 

 Hình ảnh minh họa: 

 - Chọn chức năng Union. 

 

Hình 2.21. Tạo vùng hợp nhau 

- Chọn chức năng Intersection. 

 

Hình 2.22. Tạo vùng giao nhau 

- Chọn chức năng Difference. 

 

Hình 2.23. Tạo vùng bù nhau 
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*Tạo các vùng thủng: 

 Chọn công cụ Group Holes, nhấn chuột trái vào vùng bao ngoài, sau đó bấm 

chuột trái vào các vùng nằm trong vùng bao ngoài đó.  

 Thực chất là để xây dựng các thửa đất mà trong đó có các công trình, hoặc thửa 

đất của người khác. 

*Trải nền cho các vùng: 

Để trải nền cho các đối tượng dạng vùng, nhất thiết các vùng này phải được vẽ 

ở chế độ Soil (dạng đặc). Chúng ta có thể trải nền bằng các nét gạch, hoặc bằng các ký 

hiệu, tùy theo yêu cầu. 

 - Để trải nền bằng các nét gạch, chúng ta có các sự lựa chọn như: Trải bằng nét 

gạch đơn, trải bằng hai nét gạch. 

- Trải nền bằng các cell. 

- Trải nền theo dạng tuyến. 

 Khi trải nền, cần phải lưu ý một số thông số sau: 

 - Scale: Tỷ lệ ký hiệu. 

 - Spacing: Khoảng cách giữa các đường thẳng hoặc các cell.  

- Angel: Góc nghiêng giữa các đường thẳng hoặc các cell. 

 - Method: Cách thức trải nền (Cho đối tượng, cho vùng giao nhau…). 

- Cell: Tên cell dùng để trải nền (Khi trải nền bằng các cell). 

 

Hình 2.24. Trải nền bằng các đường đơn 

 

Hình 2.25. Trải nền bằng các đường đôi 
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Hình 2.26. Trải nền bằng các ký hiệu 

2.2.3.3. Biên tập đối tượng dạng text  

Trong quá trình biên tập bản đồ sẽ có các lỗi thường gặp đối với dữ liệu dạng 

chữ viết (text) thường là: Sai các thuộc tính đồ hoạ (level, color, linestyle, weight), 

không đúng vị trí, không đúng kiểu chữ và kích thước quy định, sai nội dung của text. 

*Sửa lỗi sai về kiểu chữ và kích thước: Sử dụng công cụ Change Text attribute 

để đặt lại các thuộc tính cho dữ liệu dạng chữ trong hộp thoại Change Text attribute. 

 

Hình 2.27. Biên tập thuộc tính cho các đối tượng dạng text 

*Sửa các lỗi sai về nội dung: Sử dụng công cụ Edit text để nhập nội dung cần 

thay đổi cho các đối tượng dạng chữ cần chỉnh sửa nổi dung. 

 

Hình 2.28. Biên tập nội dung của text 
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BÀI THỰC HÀNH 1 

SỬ DỤNG CÁC CÔNG CỤ CỦA PHẦN MỀM MICROSTATION  

1. Căn bản về Microstation 

1.1. Khởi động phần mềm MicroStation:  

- Nháy đúp (Double click) vào biểu tượng của MicroStation trên màn hình.  

1.2. Làm việc với design file 

a. Tạo một file mới  

Từ cửa sổ MicroStation Manager:  

+ Chọn File/New, xuất hiện hộp thoại Create Design File:  

+ Chọn Seed File: Bấm chuột vào Select, xuất hiện hộp thoại Select Seed File, 

Chọn Seed file là file: C:WIN32APP\ustation\wsmod\default\seed\vn2d.dgn, hoặc 

C:\Famis\system\seed_bd.dgn, chọn OK. 

+ Gõ tên File mới cần tạo, chọn OK, (Nếu File đã có, chọn File cần mở, chọn OK). 

- ChọnWorkspace: Default. 

- Chọn Style: Comand window. 

 

- Chọn Ok. Xuất hiện màn hình của MicroStation.  

b. Mở một file đã có 

Thực hành mở file to06.dgn trong thư mục D:\CSDL Tin hoc chuyen 

nganh\Phuong Kim Long như sau: 

 - Cách 1: Từ thanh Menu chọn File/Open xuất hiện hộp thoại sau đó chọn thư 

mục chứa file và tên file cần mở, bấm OK.  
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- Cách 2: Khởi động Microstation. Xuất hiện hộp thoại Microstation Manager. 

Chọn thư mục chứa file và tên file từ hộp thoại Microstation Manager. 

 

 - Cách 3: Mở file dưới dạng file tham khảo (Reference File) 

 + Từ thanh Menu chọn File/Reference lúc này sẽ xuất hiện hộp thoại Reference 

Files, tiếp tục chọn Tools/Attach  

 - Chọn thư mục và tên file cần mở, bấm OK.  

 

 Để đóng file tham khảo trong hộp thoại trên, chọn file tham khảo cần đóng, 

chọn Tools/Detach.  

 c. Trộn các file với nhau  
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Thực hành trộn file to06.dgn và to07.dgn trong thư mục D:\CSDL Tin hoc 

chuyen nganh\Phuong Kim Long theo 1 trong 2 cách sau như sau: 

 Cách 1 : Trộn file bằng chức năng Merge 

 - Mở hộp thoại MicroStation Manager (Hộp thoại này sẽ xuất hiện khi khởi động 

MicroStation, trong trường hợp khi đang làm việc với MicroStation, chọn File/Close sẽ 

xuất hiện hộp thoại này), chọn File/Merge. Xuất hiện hộp thoại Merge file. 

 - Trong hộp thoại File  to Merge, bấm Select để chọn các file cần trộn là to06.dgn 

(file cho dữ liệu).  

 - Trong hộp thoại Merge Into chọn file chứa kết quả trộn là to07.dgn (file nhận 

dữ liệu). 

 - Chọn Merge để kết thúc công việc. 

 

 - Mở file to07.dgn lên để xem kết quả sau khi trộn file  

 Cách 2: Trộn file bằng chức năng Merge Into Master 

 - Mở file cần trộn là to07.dgn (file nhận dữ liệu) 

 - Từ thanh Menu chọn File/ Reference lúc này sẽ xuất hiện hộp thoại Reference 

Files, tiếp tục chọn Tools/Attach 

 - Chọn thư mục và tên file cần trộn là to06.dgn (file cho dữ liệu), bấm OK 

 - Chọn Tools\Merge Into Master 
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1.3. Làm việc với thanh cuốn Scroll bar  

Mở file to06.dgn hoặc to07.dgn trongthư mục: D:\CSDL Tin hoc chuyen 

nganh\Phuong Kim Long để thực hành các thao tác dưới đây: 

Các lệnh trong thanh cuốn này gồm: 

 
 1: Update View: Vẽ lại nội dung của cửa sổ màn hình.  

 2: Zoom In: Phóng to tầm nhìn bản vẽ, nhập hệ số phóng Zoom Ratio.  

 3: Zoom Out: Thu nhỏ tầm nhìn bản vẽ, nhập hệ số thu Zoom Ratio.  

 4: Windows Area: Phóng to tầm nhìn bản vẽ theo cửa sổ. 

  5: Fit View: Thu toàn bộ nội dung của bản vẽ vào trong màn hình với kích 

thước lớn nhất (Nhìn bản vẽ một cách bao quát).  

 6: Rotate View: Quay tầm nhìn bản vẽ (chọn phương pháp quay-Method) .  

 7: Pan View: Dịch chuyển tầm nhìn bản vẽ theo một hướng nhất định.  

 8: View Previous: Trở về tầm nhìn trước đó.  

 9: View Next: Trở về tầm nhìn trước khi thực hiện lệnh View Previous  

1.4. Làm việc với bảng thuộc tính hiển thị (View Attributes) 

Mở file to06.dgn hoặc to07.dgn trong thư mục: D:\CSDL Tin hoc chuyen 

nganh\Phuong Kim Long để thực hành các thao tác dưới đây: 

Từ menu của MicroStation chọn Settings/ViewAttributes (hoặc ấn Ctrl + B). 

Xuất hiện bảng thuộc tính hiển thị trên màn hình. 

 Tiến hành bật/ tắt các thuộc tính trên bảng ViewAttributes, sau đó ấn apply và 

quan sát sự thay đổi trên màn hình. 

 

1.5. Làm việc với bảng điều khiển lớp (View Levels)  

Mở file to06.dgn hoặc to07.dgn trong thư mục: D:\CSDL Tin hoc chuyen 

nganh\Phuong Kim Long để thực hành các thao tác dưới đây: 

Để thay đổi level hoạt động hay thay đổi chế độ bật tắt các level có thể sử dụng 

bảng điều khiển View levels. Từ menu chọn Settings/level/display (Hoặc ấn đồng thời 

2 phím Ctrl+E). 
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Mỗi số viết trên các ô (từ 1- 63) tương ứng với một level. Nếu ô có màu đen thì 

level đó được chọn hiển thị (Chế độ ON). Nếu ô có màu xám nhạt thì level tương ứng 

bị tắt hiển thị (Chế độ OFF: level 27, 28, 29). Ô nào có một hình tròn bao quanh số thì 

đó là level hoạt động (level 10). Để đổi chế độ hiển thị của level từ on sang off (hay 

ngược lại) thì chỉ cần ấn phím data trên level tương ứng.  

Tại mỗi thời điểm phải có ít nhất một Level được bật. Sau khi chọn xong chế độ 

hiển thị cho các level, ấn Apply để áp dụng cho View đó hoặc ấn All để áp dụng cho 

tất cả các cửa sổ windows.  

Hãy chọn lớp hoạt động, bật tắt các lớp bất kỳ, ấn Apply và quan sát sự thay đổi 

trên màn hình  

1.6. Thực hành các lệnh vẽ cơ bản trong thanh công cụ chính Main.  

 a. Nhóm lệnh vẽ đối tượng dạng tuyến (Linear Elements):  

 

 1: Place Smartline: Vẽ đường thẳng dạng tuyến (đường, sharp, arc) 

 2: Place Line : Vẽ đường thẳng đơn.  

 + Tích chọn Length, nhập giá trị độ dài để vẽ đường theo độ dài xác định. 

 + Tích chọn Angel, nhập giá trị góc để vẽ đường thẳng theo góc xác định. 

 3: Place Multi Line: Vẽ đường Multi Line.  

 4: Place Tream Line String: Vẽ đường cong dạng chuỗi (theo nét bút như: dòng 

chảy, suối). 

 5: Place Point or Tream Curve: Vẽ đường có điểm uốn. 

 6: Construct Angle Bisector: Vẽ đường thẳng chia đôi một góc. Khi dùng lệnh 

này phải bắt điểm chính xác lần lượt vào các điểm sau:  

 + End point of angel leg: Điểm cuối trên một cạnh đường thẳng tạo góc cần chia. 

 + Angel vertex: Đỉnh góc . 

 + Endpoint of angel leg: Điểm cuối trên cạnh đường thẳng còn lại. 

 7: Construct Minimum Distance Line: Vẽ đoạn thẳng ngắn nhất nối hai đối tượng.  

 8: Construct Line at Active Angle: Vẽ đường thẳng với một góc nghiêng nhất định. 
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 b. Nhóm công cụ Polygons (Vẽ vùng) 

 

 1: Place Block: Vẽ hình chữ nhật. 

 2: Place Shape: Vẽ đa giác tự do. 

 3: Place Orthogonal Shape: Vẽ đa giác có các góc đều vuông. 

 4: Place Regula Polygon: Vẽ đa giác đều. 

 Khi thực hiện các lệnh vẽ vùng cần chú ý các thông số sau:  
 

 

 + Area: Chọn chế độ tạo vùng. 

  - Solid: Vùng đặc. 

  - Hole: Vùng rỗng. 

 + Fill Type: Chọn kiểu tô màu. 

  - None: Không tô màu. 

  - Opaque: Tô màu không có viền. 

  - Outlined: Tô màu có màu viền (màu viền là màu trên thanh Primary). 

 + Fill Color: Chọn màu tô (từ 0 – 254, màu 255 là màu nền của cửa sổ).  

 Chú ý: Nếu màu tô không hiển thị lên màn hình, ấn đồng thời 2 phím Ctrl + B, 

xuất hiện hộp thoại View Attributes, chọn Fill, Apply. 

c. Nhóm lệnh vẽ vòng tròn, elip (Ellipses).  

 

- Chọn phương pháp: Method.  

- Chọn kiểu tô màu: Fill type.  

- Chọn màu tô: Fill color. 

Lưu ý: Để vẽ các hình theo thông số cho trước ta làm như sau: 

+ Đối với vẽ vòng tròn: Tích chọn vẽ theo đường kính (Diameter) hoặc bán kính 

(Radius) và nhập thông số đường kính hoặc bán kính tương ứng. 

+ Đối với vẽ elip: Tích chọn vẽ theo bán trục lớn (Primary), bán trục nhỏ 

(Secondary) và góc quay bán trục lớn (Rotation). 
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d. Nhóm công cụ Text (Nhập văn bản) 

Lưu ý: Để gõ tiếng việt có dấu trong Microsation, bật Unikey và chọn bảng mã 

TCVN3. 

 

 1: Place text: Lệnh vẽ chữ. Chọn Font chữ, chế độ canh lề (Justification), góc 

quay chữ (Active angle), phương pháp viết chữ (Method). Nhập dòng chữ vào hộp 

thoại Text Editor. 

 2: Place node: Vẽ chữ (có mũi tên chỉ để chú thích cho một đối tượng).  

 3: Edit Text: Sửa chữa, thay đổi dòng chữ. Nháy kép chuột vào dòng chữ cần 

sửa chữa => xuất hiện trong hộp thoại Text Editor. Tiến hành sửa chữ. Sau đó Apply.  

 4: Display Text Attributes: Xem thuộc tính dòng chữ.  

 5: Match Text Attributes: Sao chép thuộc tính dòng chữ.  

 6: Change Text Attributes: Thay đổi thuộc tính dòng chữ. Thuộc tính dòng chữ 

gồm Font chữ, Height: độ cao chữ, Weight: độ rộng chữ... 

 7: Plate text node: Đánh số các điểm ghi chú.  

 8: Copy and Increment Text: Sao chép và tăng dòng chữ dạng số. Nhập hệ số 

tăng (Tag Increment), chọn chữ khởi đầu. 

e. Nhóm lệnh vẽ điểm (Points)  

 

 1: Place Active Point: Tạo điểm. 

 Lưu ý: Để tạo một điểm có tọa độ XY, nhập dòng lệnh “XY=<Tọa độ X>,<Tọa 

độ Y> vào cửa sổ lệnh Comand Window. 

 2: Construct Points Between Data Points: Tạo một số nhất định các điểm liên 

tiếp với khoảng cách đều nhau. 

 3: Project Points Onto Element : Đặt điểm trên một đối tượng được chọn 

 4: Construct Point at Intersection: Đặt một điểm tại chỗ giao nhau của 2 đối tượng 

 5: Construct Point Along Element: Đặt một số nhất định các điểm trên đối 

tượng giữa hai lần bấm chuột. 

 6: Construct Point @ Distance Along Element: Tạo một điểm nằm trên đối 

tượng và cách điểm bấm chuột một khoảng cách cho trước. 

 f. Nhóm lệnh vẽ cung (Arcs)  

 

 1: Place Arc: Vẽ cung tròn.  

 2: Place Half Ellipse: Vẽ một cung của hình Elip.  
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 3: Place Quarter Ellipse: Dạng một nửa của Place Half Ellipse.  

 4: Modify Arc Radius: Thay đổi cung tròn (2 đầu mút của cung cố định).  

 5: Modify Arc Angle: Thay đổi độ lớn của cung (Kéo dài hoặc thu ngắn cung).  

 6: Modify Arc Axis: Thay đổi cung theo một trục nhất định. 

 g. Nhóm công cụ đo (Measure) 

 

 1: Measure Distance: Đo khoảng cách giữa hai điểm. 

 2: Measure Radius: Đo bán kính. 

 3: Measure Angle: Đo góc. 

 4: Mesure Length: Đo chiều dài. 

 5: Measure Area: Đo diện tích. 

 Các kết quả đo sẽ đươc hiển thị trên cửa sổ lệnh Command Window.  

1.7. Các lệnh lựa chọn đối tượng 

 Sử dụng các lệnh lựa chọn đối tượng trong menu Edit 

 
 - Select all: Lựa chọn tất cả các đối tượng trên bản đồ. 

 - Select none: Bỏ lựa chọn các đối tượng trên bản đồ. 

 - Select by attributes: Lựa chọn theo thông tin thuộc tính của các đối tượng trên 

bản đồ. 
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1.8. Lệnh xóa đối tượng:  

2. Các công cụ biên tập bản đồ của Microstation 

2.1. Nhóm chức năng Fence 

 Fence là một hình khép kín do người sử dụng tự xác định để làm việc với các 

yếu tố hiện thị trên bản vẽ. Mối quan hệ giữa các yếu tố trên bản vẽ và Fence phụ 

thuộc vào hai yếu tố:  

 - Tương quan vị trí giữa yếu tố và Fence.  

 - Chế độ làm việc của Fence.  

 

1: Place Fence: Tạo Fence.  

2: Modify Fence: Sửa chữa Fence.  

3: Manipulate Fence Contents: Sao chép, dịch chuyển, quay các đối tượng sử 

dụng Fence.  

4: Delete Fence Contents: Xóa các đối tượng sử dụng Fence.  

5: Drop Fence Contents: Phá vỡ liên kết (Drop) giữa các đối tượng khi làm việc 

với Fence. 

Các chế độ làm việc của Fence (Fence Mode) bao gồm:  

- Inside: Tác dụng đối với các đối tượng nằm hoàn toàn trong Fence.  

- Overlap: Tác dụng đối với những đối tượng nằm trong Fence và những đối 

tượng cắt Fence, tiếp xúc trong với Fence.  

- Clip: Tác dụng đối với những đối tượng nằm hoàn toàn trong Fence và phần 

nằm trong Fence của những đối tượng cắt Fence.  

- Void: Tác dụng đối với những đối tượng nằm hoàn toàn ngoài Fence.  

- Void-Overlap: Tác dụng đối với những đối tượng nằm hoàn toàn ngoài Fence 

và những đối tượng cắt Fence, tiếp xúc ngoài với Fence.   

- Void-Clip: Tác dụng đối với những đối tượng nằm hoàn toàn ngoài Fence và 

phần nằm ngoài Fence của những đối tượng cắt Fence.  

Các kiểu Fence (Fence Type) bao gồm:  

+ Block: Vẽ fence hình chữ nhật.   

+ Shape: Vẽ fence có hình dạng đa giác bất kỳ. 

2.2. Nhóm công cụ Modify Element sử dụng để sữa chữa các đối tượng đồ hoạ. 

`  
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 1: Modify Element: Thay đổi 2 đầu mút đối tượng.  

 2: Delete Part Of Element: Xóa một phần đối tượng.  

 3: Extend Line: Kéo dài/thu ngắn đối tượng (hướng không đổi).  

 4: Extend 2 Element to Intersection: Kéo dài/thu ngắn 2 đối tượng đến giao 

điểm của hai đối tượng đó.  

 5: Extend Element to Intersection: Kéo dài đối tượng đến giao với một đối 

tượng khác. 

 6: Trim Element: Xóa phần đoạn thẳng thừa.  

2.3. Nhóm công cụ Dựng hình (Manipulate) 

 

 1: Copy Element: Sao chép đối tượng  

 2: Move Element: Dịch chuyển đối tượng.  

 Đánh dấu / không vào ô Make Copy để chuyển đổi giữa 2 lệnh Copy và Move.  

 3: Move Paralell: Sao chép/dịch chuyển đối tượng với một khoảng cách cho 

trước. Nhập giá trị khoảng cách vào ô Distance.  

 4: Scale Element: Thay đổi tỷ lệ đối tượng. Nhập tỷ lệ thu, phóng đối tượng vào 

ô X scale và Y scale.  

 5: Rotate: Quay đối tượng. Chọn phương pháp quay – Method. 

 6: Mirror: Lấy đối xứng với đối tượng.  

 7: Construct Array: Tạo mảng.  

 +Array Type: Kiểu mảng:  Rectangular: Mảng hình chữ nhật 

      Polar: Mảng hình tròn.  

 + Rows: Số hàng của mảng.  

 + Columns: Số cột của mảng.  

 + Rows Spacing: Khoảng cách giữa các hàng.  

 + Column Spacing: Khoảng cách giữa các cột. 

2.4. Nhóm lệnh thay đổi thuộc tính của đối tượng.  

 

Change Element Attributes: Thay đổi thuộc tính đối tượng.  

+ Level: Thay đổi lớp.  

+ Color: Thay đổi màu sắc đối tượng.  

+ Style: Thay đổi kiểu đường nét.  

+ Weight: Thay đổi lực nét đối tượng. 
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Change Element to Active Fill Type: Thay đổi thuộc tính của các đối 

tượng dạng vùng.  

+ Fill Type: Kiểu tô màu.  

+ Fill Color: Màu tô. 

2.5. Nhóm lệnh tạo liên kết/phá vỡ liên kiết các đối tượng  

 

1: Drop Element: Phá vỡ liên kết các đối tượng.  

2: Create Complex Change: Tạo liên kết giữa các đối tượng.  

3: Create Complex Shape: Tạo vùng từ những đối tượng riêng lẻ, trong đó:  

 - Manual: Tạo vùng bằng cách chọn lần lượt các đối tượng của vùng. Nếu các 

đối tượng không khép kín, chương trình tự động khép kín vùng. 

 - Automatic: Bấm chuột vào 1 đường bao của vùng, chương trình tự động dò tìm 

đường bao của vùng. Nếu chọn sai đường bao, ấn phím phải chuột, chương trình sẽ dò 

tìm theo hướng khác.  

4: Create Region: Lệnh tô màu cho đối tượng khép kín.  

Xuất hiện của sổ Create Region, cần thực hiện các bước sau:  

- Chọn phương pháp tạo vùng (Method).  

+ Intersection: Lấy vùng là giao của 2 vùng.  

+ Union: Cộng vùng.  

+ Diffrence: Trừ vùng.  

+ Flood: Tạo vùng. Chọn phương pháp tạo vùng là Flood. 

- Chọn kiểu tô màu (Fill Type)  

+ None: Không tô màu.  

+ Opaque: Tô màu không có đường viền. 

+ Outlined: Tô màu có màu viền vùng (màu viền quanh vùng là màu trên thanh 

công cụ Primary Tools).  

- Chọn màu tô: Fill Color.  

- Đánh dấu vào Keep Original để giữ các vùng xung quanh.  

Sau đó, bấm chuột vào 1 điểm ở trong thửa đất, con chuột sẽ tự động dò tìm 

đường bao của thửa đất, ấn tiếp phím Data kết thúc tô màu. 
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BÀI THỰC HÀNH 1 

SỬ DỤNG MICROSTATION ĐỂ BIÊN TẬP BẢN ĐỒ SỐ 

Nội dung 1: Căn bản về Microstation 

Bài tập 1.1. 

Dùng công cụ Place Line để tạo một hình chữ nhật ABCD có kích thước và 

thuộc tính như hình sau: 

 

 

 

 

 

Bài tập 1.2. 

Dùng công cụ Contruct Angle Bisector để vẽ đường phân giác cho các góc 

BAC và ABD ở câu 1. 

Bài tập 1.3. 

Dùng chức năng Place block tạo các hình đa giác các thuộc tính như sau: 

 a. Hình chữ nhật - Level: 5     - Line style: 0  - Weight: 1 

     - Line color: 1  -  Fill type: None. 

 b. Đa giác tự do  - Level: 6     - Line style: 1  - Weight: 3 

     - Fill type: Opaque  - Fill Color: 22  

 c. Lục giác đều  - Level: 7     - Line style: 3  - Weight: 3 

   - Line color: 4  - Fill type: Outline  - Fill Color: 22 

Bài tập 1.4. 

Dùng chức năng Place Circle để vẽ một hình tròn có các thuộc tính như sau: 

 - Level: 8   - Đường kính: 60m   - Line style: 0 

 - Line weight: 1  - Fill type: Opaque   - Fill color: 30 

Bài tập 1.5. 

 a. Dùng công cụ Place text để tạo ra đoạn văn bản có nội dung và thuộc tính 

như sau: 

 - Nội dung: Khoa Tài nguyên đất & Môi trường Nông nghiệp 

 - Level: 9  - Color text: 4  - Font: VnTime   

 - Height: 5.00 - Width: 5.00   - Justification: Center Center 

b. Dùng chức năng Edit text để sửa chữa đoạn văn bản câu 1 thành nội dung: 

“Khoa Tài nguyên đất và Môi trường Nông nghiệp, trường Đại học Nông Lâm Huế”. 

Bài tập 1.6. 

Mở file to06.dgn trong thư mục D:\CSDL Tin hoc chuyen nganh\Phuong Kim 

Long và thực hiện các lệnh lựa chọn sau đây: 

40m 

100m 

Line weight = 3, Color = Blue 
C 

A 

D 

B 
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 a. Lựa chọn tất cả các đối tượng của tờ bản đồ 

 b. Bỏ lựa chọn các đối tượng ở câu a 

 c. Lựa chọn các đối tượng dạng chữ của tờ bản đồ 

 d. Lựa chọn các đối tượng dạng chữ trên level 13 của tờ bản đồ 

 e. Lựa chọn các đối tượng dạng chữ có nội dung “TP” 

Bài tập 1.7. 

Thực hiện lệnh xóa các đối tượng tương ứng ở Câu 6 

 

Nội dung 2: Các công cụ biên tập bản đồ của Microsation 

Bài tập 2.1:  

a. Dùng chức năng Place circle để vẽ một hình tròn có các thuộc tính như sau: 

 - Level: 20 - Line style: 0 - Line weight: 1 - Đường kính: 60m 

 - Fill type: None   - Fill color: 4 

 b. Dùng chức năng Copy Element copy đối tượng ở Câu a. 

 c. Dùng chức năng Change element attributes để thay đổi thuộc tính cho đối 

tượng ở Câu b như sau: 

 - Level: 22 - Line style: 3 - Line weight: 4 - Đường kính: 60m 

 - Fill type: Outline   - Line color: 4 - Fill color: 22 

 d. Dùng chức năng Scale element để thay đổi kích thước cho đối tượng ở Câu c 

lên 2 lần. 

Bài tập 2.2:  

a. Dùng công cụ vẽ đường đơn Place line và công cụ Create Complex Shape để 

tạo thành một hình chữ nhật có kích thước và các thuộc tính như hình sau: 

       150m 

 

   50m  

 

 

 b. Dùng công cụ copy, copy đối tượng ở câu 1. Sau đó vẽ một đường tròn 

đường kính = 60m cắt đối tượng đó. Dùng công cụ Create Region để tô màu theo 

phương pháp Diffrence giữa đường tròn và hình chữ nhật với Fill type là Opaque và 

Fill color là 5. (Lưu ý: Tạo vùng, tô màu vẫn giữ nguyên vùng xung quanh) 

 c. Dùng công cụ copy, copy đối tượng ở câu 1. Sau đó vẽ một đường tròn 

đường kính = 60m cắt đối tượng đó. Dùng công cụ Create Region để tô màu theo 

phương pháp Intersection với Fill type là Outline và Fill color là 22. Lưu ý: Tạo vùng, 

tô màu vẫn giữ nguyên vùng xung quanh) 
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Bài tập 2.3:  

a. Dùng công cụ vẽ đường đơn Place line và công cụ Create Complex Shape để 

tạo thành một hình chữ nhật có kích thước và các thuộc tính như hình sau: 

1000m 

 

   300m       No fill color 

 

 

 b. Dùng công cụ Copy Element để copy đối tượng ở câu 1. Dùng công cụ Hatch 

Area để trải nền đơn với Spacing = 50m; Angel =450 

 c. Dùng công cụ Copy Element để copy đối tượng ở câu 1. Dùng công cụ 

Crosshatch Area để trải nền đa với Spacing lần lượt là 50m và 10m; Angel lần lượt là 

450 và 1350 

 d./ Dùng công cụ Copy Element để copy đối tượng ở câu 1. Dùng công cụ 

Pattern Area để trải nền theo cell “RDM” trong thư viện cell “ht1_5” với Spacing lần 

lượt là 10m và 10m. 
 

Nội dung 3: Tạo mới kiểu kí hiệu (Cell) và kiểu Đường (LineStyle) 

Bài tập 3.1:  

Tạo thư viện chứa các kiểu kí hiệu có kích thước như hình sau trên bản đồ quy 

hoạch tỷ lệ 1:10.000. Đặt tên thư viện là Cell_<tenSV> 

 

 

HƯỚNG DẪN THỰC HÀNH 

1. Tạo file mới 

Từ cửa sổ MicroStation Manager:  

+ Chọn File/New, xuất hiện hộp thoại Create Design File:  

+ Chọn Seed File: Bấm chuột vào Select, xuất hiện hộp thoại Select Seed File, 

Chọn Seed file là file: C:WIN32APP\ustation\wsmod\default\seed\vn2d.dgn, hoặc 

C:\Famis\system\vn2d.dgn, chọn OK. 
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+ Gõ tên File mới cần tạo, chọn OK, (Ví dụ: Tao_Cell). 

- Chọn Workspace: Default. 

- Chọn Style: Comand window. 

 

- Chọn Ok. Xuất hiện giao diện làm việc của MicroStation.  

2. Tạo mới thư viện cell 

- Menu Element/Cells. Xuất hiện hộp thoại Cell Library 

- Chọn File/New. Xuất hiện tiếp hộp thoại Create Cell Library 

- Đặt tên cho thư viện: Cell_<TênSV> 

 

3. Dùng các công cụ vẽ các kí hiệu cell 

Sử dụng các công cụ của Microstation ở Bài thực hành 1 để tạo các kí hiệu theo 

đúng quy định. 

Quy tắc vẽ: Kích thước Cell trên Microstation = Kích thước cell in trên giấy x 

Mẫu số tỷ lệ bản đồ 

Ví dụ: Tạo kí hiệu Trụ sở UBND cấp xã trên bản đồ 1/10000  

Kích thước trên Microstation = 3 mm (Kích thước trên giấy in) x 10000 (Mẫu số 

tỷ lệ bản đồ) = 30000 mm = 30 m 
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4. Đưa cell vào thư viện kiểu cell 

- Dùng công cụ Place Fence bao quanh kí hiệu 

+ Fence type: Block;  + Fence Mode: Inside 

- Dùng công cụ Define Cell Origin: Bấm chuột trái (data) vào chính giữa kí hiệu 

(cell) cần tạo để xác nhận kí hiệu. 

- Bấm Create trong hộp thoại thư viện Cell. 

- Đặt tên (Name) và Mô tả (Description) cho cell cần tạo  

Ví dụ: + Name: UBX;  + Description: UBND cấp xã 

Bài tập 3.2:  

Tạo 1 thư viện các kiểu đường có kích thước như hình sau trên bản đồ tỷ lệ 

1:5000. Đặt tên thư viện là KieuDuong_<TenSV> 

 

HƯỚNG DẪN THỰC HÀNH 

(Tạo kiểu đường địa giới hành chính cấp xã xác định) 

1. Tạo mới thư viện kiểu đường 

 - Trên giao diện thanh công cụ Primary, chọn thuộc tính kiểu đường > Edit 
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 - Xuất hiện hộp thoại Line Sstyle Editor. 

 - Chọn File/New. Xuất hiện hộp thoại Create Line Style Library 

 - Nhập tên thư viện kiểu dường: Linestyle_<Tên SV> 

 

2. Tạo kiểu đường Stroke địa giới hành chính cấp xã  

- Menu Edit > Create> Stroke Pattern 

- Nhập mô tả kiểu đường stroke vào dòng “new stroke component” =  “địa giới 

hành chính cấp xã” 

- Chọn Add 2 lần (= tương ứng với số đoạn nét liền – nét đứt đã xác định của 

đường địa giới hành chính cấp xã) 

Lưu ý: Tùy vào kiêu đường để xác định số cặp nét liền: Thông số nét liền – nét 

đứt là 3-2-3-2….. thì chỉ cần add vào Microstation 1 cặp nét liền nét đứt (= 2 đoạn) 

- Biên tập cho từng đoạn nét liền và nét đứt bằng cách bấm chuột vào từng đoạn 

một (Dash: nét liền; Gap: nét đứt):  
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+ Bấm chuột chọn đoạn thứ nhất (nét liền)> Chọn stoke type là Dash > Chỉnh độ 

dài nét liền ở ô Length = 15 m (3x5000=15000 mm) > Chỉnh thông số Width thành 

FULL > Nhập thông số ở Start và End = 1 (0,2x5000= 1000 mm) 

+ Bấm chuột chọn thứ hai (nét đứt) > Chọn Stroke Type: Gap > Chỉnh độ dài 

Length = 10 m (2x5000=10000 mm) 

 

- File > Save để lưu đường stroke vừa tạo 

3. Tạo kiểu đường Point cấp xã xác định 

- Menu Edit > Create > Point 

- Nhập mô tả kiểu đường Point vào dòng “new point component” =  “Point địa 

giới cấp xã xác định” 

- Bấm chuột vào Base stroke pattern > Chọn kiểu đường: “Stroke địa giới hành 

chính cấp xã” 
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- Vẽ kí hiệu Point “Chấm tròn cấp xã” với kích thước: Đường kính = 1 m 

(0,2x5000=1000 mm) bằng công cụ Place Circle, trong đó:  

+ Fill type: Opaque;  + Tích chọn Diameter > Nhập thông số = 1 

 

- Dùng công cụ Place Fence (nhóm công cụ Fence) bao fence quanh kí hiệu vừa 

vẽ (Fence sát kí hiệu và cân đối) 

- Dùng công cụ Define Cell Origin (nhóm công cụ Cell) để xác định kí hiệu vừa 

vẽ (Bấm chuột vào vị trí trung tâm kí hiệu) 

- Bấm chọn Create trong hộp thoại tạo kiểu đường > Hộp thoại Create Point 

Symbol 

- Đặt tên cho kí hiệu = “Chấm tròn cấp xã”. Bấm OK. 

 

- Xác định vị trí đưa kí hiệu vào: Bấm chuột chọn đoạn nét đứt > Chọn Select để 

chọn kí hiệu: “Chấm tròn cấp xã” 
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- File > Save để lưu lại đường Point 

4. Tạo đường Compound (kết hợp) cấp xã xác định 

- Menu Edit > Create > Compound 

- Nhập mô tả kiểu đường Compound vào dòng “new compound component” =  

“Địa giới hành chính cấp xã xác định” 

- Đặt tên cho đường Compound: Edit > Create > Name.  

- Thay nội dung chữ “Unname” = “RGXXĐ_TênSV” 

- Chọn Insert > Chọn từng đường thành phần gồm: “Stroke địa giới hành chính 

cấp xã” và “Point địa giới hành chính cấp xã xác định” 

- File > Save để lưu lại 

6. Tạo đường Point cấp xã chưa xác định 

- Edit > Create > Point 

- Gõ mô tả kiểu đường Point vào dòng “new point component” =  “Point địa giới 

cấp xã chưa xác định” 

- Bấm vào Base stroke pattern để chọn đường stroke làm nền cho đường point là 

“Stroke địa giới cấp xã” 

- Xác định vị trí đưa kí hiệu“Chấm tròn cấp xã” vào nét đứt 

- Vẽ kí hiệu “Gạch chéo cấp xã” bằng công cụ Place Line theo kích thước 

+ Chọn Length = 9 (1,8x5)  

+ Chọn Angle = 450  

- Dùng công cụ Place Fence (nhóm công cụ Fence) bao fence quanh kí hiệu vừa 

vẽ (Fence sát kí hiệu và cân đối) 
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- Dùng công cụ Define Cell Origin (nhóm công cụ Cell) để xác định kí hiệu vừa 

vẽ (Bấm chuột vào vị trí trung tâm kí hiệu) 

- Bấm chọn Create trong hộp thoại tạo kiểu đường > Hộp thoại Create Point 

Symbol 

- Đặt tên cho kí hiệu = “Gạch chéo cấp xã” 

- Xác định vị trí đưa kí hiệu vào (nét liền hay nét đứt?) > Bấm chuột chọn đoạn 

nét liền > Chọn Select để chọn kí hiệu: “Gạch chéo cấp xã” 

- File > Save để lưu lại 

7. Tạo đường Compound cấp xã chưa xác định 

- Edit > Create > Compound 

- Gõ mô tả kiểu đường Compound vào dòng “new compound component” =  

“Địa giới cấp xã chưa xác định” 

- Đặt tên cho đường Compound: Edit > Create > Name  

- Thay nội dung chữ “Unname” = “DGXCXD_TenSV” 

- Chọn Insert > Chọn từng đường thành phần gồm: “Stroke cấp xã” và “Point xã 

chưa xác định” 

 

- File > Save để lưu lại. 

- Để thể hiện các kiểu đường vừa tạo xong lên bản đồ. Chọn công cụ Custom 

trong thanh Primary Tools → xuất hiện hộp hội thoại Line style → Kích đúp chuột để 

chọn tên kiểu đường cần vẽ sau đó dùng các công cụ vẽ đường của Microstation để thể 

hiện kiểu đường đã chọn lên bản vẽ. 
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CHƯƠNG 3 

SỐ HÓA VÀ KHAI THÁC THÔNG TIN BẢN ĐỒ ĐỊA CHÍNH 

3.1. Số hóa bản đồ 

3.1.1. Khái niệm số hóa 

Thông thường, các dữ liệu dạng chữ, hình ảnh, âm thanh… sử dụng trên máy tính 

và được máy tính nhận biết đúng định dạng, được gọi chung là dữ liệu số. Quá trình 

chuyển các dạng dữ liệu truyền thống như các bản viết tay, bản in trên giấy, hình 

ảnh… sang chuẩn dữ liệu trên máy tính và được máy tính nhận biết được gọi là số hoá 

dữ liệu. 

Như vậy, Số hóa là quá trình chuyển các thông tin từ bản đồ, bản vẽ hoặc văn 

bản (số liệu ghi các tọa độ) về dạng số có thể lưu trữ, quản lý trên một tệp trong 

máy tính 

3.1.2. Ưu điểm và Hạn chế 

a. Ưu điểm 

- Giúp việc lưu trữ, truy xuất, chia sẻ, tìm kiếm thông tin một cách dễ dàng 

- Linh hoạt trong việc chuyển đổi sang các loại dữ liệu số khác nhau 

- Giảm chi phí tối đa cho việc quản lý, không gian lưu trữ 

- Có khả năng chỉnh sửa và tái sử dụng dữ liệu 

b. Hạn chế 

- Cần đầu tư ban đầu về công nghệ, cơ sở hạ tầng CNTT, máy móc hiện đại. 

- Dữ liệu dễ bị sao chép và sửa đổi trái pháp luật. 

-Việc triển khai sử dụng gặp nhiều khó khăn do phải thực hiện tập huấn đồng bộ 

và có hệ thống. Ngoài ra việc bảo mật dữ liệu cũng là một thách thức lớn 

3.1.3. Quy trình  xây dựng bản đồ số từ bản đồ giấy 

a. Quét bản đồ và tạo ra các tập tin ảnh 

Quá trình quét bản đồ được thực hiện nhờ vào thiết bị quét chuyên dụng 

Quét bản đồ là quá trình chuyển các bản đồ được lưu trữ trên giấy, phim, diamat, 

thành các tập tin dữ liệu dưới dạng ảnh (raster file), sau đó tùy thuộc vào phần mềm xử 

lý ảnh và phần mềm quản lý bản đồ hiện có mà chuyển các raster file sang các định 

dạng khác như: *.TIFF, *.RLE, *.EPS, *.BMP. Sau đó sẽ tạo thành dữ liệu dạng 

Raster và lưu trữ trong máy tính. 

b. Nắn bản đồ 

Nắn bản đồ là bước quan trọng nhất của quá trình thành lập bản đồ số vì nó ảnh 

hưởng đến độ chính xác khi số hóa bản đồ từ bản đồ giấy. Quá trình nắn ảnh là quá 

trình đưa tọa độ theo hàng cột của các Pixel về đúng với tọa độ thực tế.  

Tọa độ một điểm được xác định trên ảnh và thực tế có sự sai lệch nhau, tùy thuộc 

vào tỷ lệ bản đồ và mục đích thành lập bản đồ mà sai số cho phép sẽ khác nhau. Các 
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điểm định vị trên vừa định nghĩa vùng làm việc cho quá trình số hóa, vừa là cơ sở cho 

quá trình tiếp biên giữa các mảnh bản đồ. 

c. Vector hóa 

Là quá trình biến đổi dữ liệu raster thành dữ liệu vector tức là quá trình vẽ lại bản 

đồ thành điểm, đường, vùng được thực hiện trên máy tính thông qua thao tác với các 

phần mềm đồ họa hoặc bàn số hóa nhằm tạo một bản vẽ dạng số của bản đồ. Hiện nay 

có rất nhiều phần mềm số hóa bao gồm Autocad, Mapinfo, Arcinfo, Microstation… 

Sau khi số hóa, tùy thuộc vào phần mềm số hóa mà dữ liệu vector sẽ được tổ chức 

trong các định dạng files khác nhau như với Mapinfo sẽ được lưu trữ vào files*.TAB, 

với Microstation sẽ được lưu trữ vào files*.DGN. Autocad là file DWG 

d. Chỉnh sửa dữ liệu 

Sau quá trình số hóa, dữ liệu được nhận chưa phải đã hoàn thiện và sử dụng 

được, các dữ liệu này được gọi là dữ liệu thô, cần phải qua một quá trình chỉnh sửa 

hợp lệ. Quá trình này bao gồm các công đọan: lọc bỏ điểm dư thừa (filter), làm trơn 

đường (smooth), loại bỏ các đối tượng trùng nhau, sửa các điểm cuối tự do và tạo các 

điểm giao. 

e. Kiểm tra và bổ sung đối tượng 

Sau khi chỉnh sửa dữ liệu xong chúng ta sẽ cần có bước kiểm tra và bổ sung đối 

tượng một lần nữa cho đầy đủ các thông tin sau khi số hóa. Quá trình kiểm tra này 

cũng là một yếu tố quan trong ảnh hưởng đến chất lượng cũng như độ chính xác của 

bản đồ số.  

Kiểm tra độ chính xác của dữ liệu là kiểm tra mức độ sai số giữa dữ liệu raster và 

dữ liệu vector (là độ lệch giữa các đường vector và tâm đường raster), thông thường 

sai số này phải < 0,1 mm tính theo tỷ lệ bản đồ. Kiểm tra tính đầy đủ đối tượng nghĩa 

là kiểm tra và bổ sung đầy đủ các đối tượng cần thu nhận theo yêu cầu đề ra đối với 

từng loại bản đồ tài liệu. 

Khi kiểm tra đối tượng thì người kiểm tra phải nắm được các quy định về hạn sai 

cho phép của từng đối tượng khi phát hiện ra sai xót thì cần tiến hành chỉnh sửa ngay 

f. Tiếp biên bản đồ 

Sự khác biện của bản đồ số và bản đồ giấy chính là công tác tiếp biên với các 

mảnh lân cận phải thực hiện ngay sau khi thu nhận và chỉnh sửa dữ liệu, các đối tượng 

dạng vùng tô màu phải chưa được tạo (polygon) bởi vì sau khi đóng vùng và tô màu 

nền, các yếu tố dạng vùng rất khó tiếp biên với nhau. 

g. Biên tập và trình bày bản đồ 

Quá trình biên tập bản đồ cũng chính là quá trình kiểm tra các đối tượng trên bản 

đồ một lần nữa tùy theo mục đích của bản đồ số cần thành lập để quá trình kiểm tra 

này diễn ra nhanh hay chậm, như việc thay đổi ký hiệu thích hợp và bố trí vị trí các đối 

tượng nhằm đảm bảo tính tương quan về địa hình cũng như tính thẩm mỹ của bản đồ. 
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Hiện nay có rất nhiều phần mềm xử lý bản đồ, cách tổ chức và quản lý dữ liệu 

không gian và dữ liệu thuộc tính ở các phần mềm có khác nhau, nhưng quy trình biên 

tập chuyển từ bản đồ giấy thành bản đồ số nhìn chung là giống nhau. Với sự phát triển 

của công nghệ thông tin cùng với nhu cầu về tổ chức xây dựng cơ sở dữ liệu quốc gia, 

hiện nay việc thành lập bản đồ số thay thế bản đồ giấy là rất cần thiết và là nhiệm vụ 

cấp bách. 

Bản đồ sau khi trải qua các quá trình trên được lưu trữ trên máy tính điện tử hay 

các thiết bị số khác để phục vụ cho các ngành nghề cũng như nhiều lĩnh vực khác nhau 

3.1.4. Số hóa bản đồ bằng Microstation  

3.1.4.1. Khởi động IrasB  

- Cách 1: Start/Programs/IrasB lúc này sẽ xuất hiện hộp thoại MicroStation 

Manager, chọn file dgn cần làm việc, chọn Ok.  

- Cách 2: Khi đang làm việc với MicroStation, chúng ta có thể chọn 1 trong 2 

cách sau: Từ cửa sổ lệnh đánh lệnh MDL L IRASB sau đó bấm Enter hoặc Từ thanh 

Menu, chọn Utilities/MDL Application lúc này xuất hiện hộp thoại MDL, từ hộp thoại 

đó, trong phần Available Applications, chúng ta chọn IrasB, bấm Load. 

 

Hình 3.1. Hộp thoại khởi động IrasB 

Khi khởi động IrasB hoạt động đồng thời với MicroStation, để chuyển đổi môi 

trường hoạt động giữa MicroStation và IrasB, từ thanh Menu ta chọn trong mục 

Applications.  

3.1.4.2. Mở file ảnh raster cần nắn 

- Từ thanh Menu của I/RAS B chọn File/Open 

- Xuất hiện hộp hội thoại IRASB LOAD 

- Từ hộp thoại, nhập tên và đường dẫn chỉ thư mục chứa file. Nếu không nhớ 

đường dẫn chứa file bấm Browse, xuất hiện hộp hội thoại IRASB LOAD cho phép 

chọn đường dẫn.  

Sau khi đã chọn được file ảnh raster cần mở, chúng ta có hai sự lựa chọn chế độ 

mở ảnh: 
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Hình 3.2. Hộp thoại mở ảnh cần nắn trên IrasB 

+ Use Raster file header transformation: Mở ảnh với toạ độ gốc đã lưu của ảnh 

đó (Được dùng để mở các ảnh đã được nắn chính xác).  

+ Interactive Placement By Rectangle: Mở ảnh trong phạm vi một hình chữ nhật 

do người dùng tự chọn bằng cách nhấp chuột vào một điểm trên màn hình, sau đó kéo 

chuột đến một điểm khác, nhấp chuột và thả ra. (Được dùng để mở các ảnh chưa nắn).  

Trong trường hợp lần đầu tiên mở ảnh, sử dụng chế độ Interactive Placement By 

Rectangle. 

3.1.4.3. Nắn ảnh sơ bộ  

Đây là thao tác đưa ảnh về gần với toạ độ bản đồ để dễ dàng chọn điểm khống 

chế cho quá trình nắn bản đồ. Có hai cách để định vị tương đối.  

Cách 1: Khi chúng ta mở ảnh với chế độ Interactive placement by rectangle (Chế 

độ mở thứ 2) thì chúng ta kéo chuột làm sao để cho ảnh raster nằm gần trùng với lưới 

Km đã được tạo sẵn.  

Cách 2: Từ thanh Menu của IRASB chọn View/Placement/Match Points/Active 

Layer. 

 

Hình 3.3. Thao tác nắn ảnh sơ bộ 
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Hình 3.4. Kết quả nắn ảnh sơ bộ 

3.1.4.4. Nắn ảnh chính xác  

- Chọn thanh công cụ Warp. 

Cách 1: Sử dụng trực tiếp trên thanh công cụ của IrasB  

Cách 2: Mở theo đường dẫn sau: Edit/Modify/Warp. 

Trong hộp thoại này có các lựa chọn như sau:  

+ Transformation Model: Mô hình nắn  

 Mô hình Helmert là mô hình quay và thay đổi tỷ lệ của dữ liệu của ảnh raster. 

Trong mô hình này số điểm khống chế tối đa là 2. 

 Mô hình Projective là mô hình áp dụng cho các dữ liệu bị vặn xoắn hoặc bị 

méo. (Trong bài thực hành này sử dụng mô hình Projective). 

 Mô hình Affine là mô hình co giãn dữ liệu theo một hoặc nhiều hướng phụ 

thuộc vào số bậc của đa thức trong mô hình toán học. Bậc Affine càng cao thì số điểm 

khống chế tối thiểu càng nhiều. 

Mỗi một mô hình đòi hỏi số điểm khác nhau.  

+ Warp Area: Khu vực cần nắn.  

  Drawing: Bức vẽ.  

  Rectangle: Hình chữ nhật. 

  Polygon: Đa giác. 

+ Layers: Lớp chưa ảnh cần nắn.  

+ Delete points: Xoá điểm, trong trường hợp các điểm chúng ta chọn bị sai. Bằng 

cách chon dòng đó, bấm vào Delete points.  

+ Collect points: Thêm điểm. 
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+ Perform Warp: Nắn ảnh.  

 

Hình 3.5. Hộp thoại chọn các cặp điểm khống chế nắn ảnh chính xác 

Sau khi lựa chọn các thông số, chúng ta phải tiến hành đánh giá các sai số, bao gồm:  

- Sai số chuẩn (Standard Error): Phải nhỏ hơn, hoặc bằng sai số cho phép của bản 

đồ x với mẫu số tỷ lệ bản đồ.  

- Sai số tổng bình phương SSE (Sum Squared Error – là khoảng cách thật giữa 

các cặp điểm khống chế), phải nhỏ hơn hoặc bằng sai số cho phép của bản đồ x với 

mẫu số tỷ lệ bản đồ.  

Nếu các sai số này không đảm bảo, chúng ta phải chọn lại các điểm cho phù hợp. 

3.1.4.5. Ghi lại kết quả  

- Ghi lại mô hình nắn.  

Khi đã đảm bảo các yêu cầu, người sử dụng nên ghi lại các thông số của chế độ 

nắn để làm tư liệu báo cáo khi nghiệm thu hoặc sử dụng lại nếu quá trình nắn ảnh bị 

trục trặc.  

Để ghi lại chúng ta thực hiện như sau:  

+ Từ hộp thoại IrasB Warp, chọn File/Save As, xuất hiện hộp thoại. 

 

Hình 3.6. Hộp thoại lưu lại mô hình nắn ảnh 

+ Trong mục Type, chúng ta lựa chọn fomat của để ghi lại, nếu để báo cáo thì 

chọn type là Report file (phần mở rộng là .Rpt), nếu để sử dụng trong quá trình nắn 

ảnh bị trục trặc, nên chọn là Coordinate File (phần mở rộng là .Cor).  

+ File sẽ được ghi lại trong đường dẫn là: C:/Win32app/ustation. Nếu quá trình 

nắn ảnh bị bỏ dở hoặc sau khi nắn, kết quả không thoả mãn, người sử dụng có thể mở lại 

file đã ghi (file có phần mở rộng là .cor) để tham khảo, chỉnh sửa hay tiếp tục công việc.  
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- Các bước để mở lại như sau: Khởi động IrasB, mở file .dgn và file ảnh raster, 

chọn công cụ Warp, nhấn chuột phải, sẽ xuất hiện hộp thoại IrasB Ward. Từ hộp thoại 

IrasB Ward chọn File/Load, sau đó đánh tên file .cor cần mở.  

- Ghi lại ảnh raster sau khi nắn Từ thanh Menu của I/RAS B chọn File/Save/Save 

Active Layer hoặc Save Active Layer As …để ghi lại ảnh vừa nắn đạt yêu cầu. 

3.2. Sử dụng Famis khai thác bản đồ địa chính 

3.2.1. Cài đặt và khởi động Famis  

a. Cài đặt  

 Trước đây, để sử dụng Famis, phải tiến hành cài đặt trải qua nhiều công đoạn, 

tuy nhiên kể từ phiên bản Famis 2004 (Sau khi có luật đất đai 2003 có hiệu lực) thì 

việc cài đặt Famis dễ dàng hơn rất nhiều. Người sử dụng sau khi cài MicroStation, chỉ 

cần copy thư mục Famis cho vào thư mục gốc của ổ đĩa điều hành.  

b. Khởi động Chạy chương trình MicroStation.  

Cách 1:  

- Từ dòng lệnh của MicroStation nhập: "mdl load c:/famis/famis"  

- Trên màn hình xuất hiện menu các chức năng của phần mềm FAMIS. 

 

Hình 3.7. Giao diện phần mềm Famis 

Cách 2:  

- Menu Utilities/ MDL Applications. Xuất hiện hộp thoại MDL.  

- Chọn Browse và tìm đường dẫn đến thư mục famis.ma trong đường dẫn 

C:\famis. 

 

Hình 3.8. Khởi động Famis 

 Trong Famis có 3 mô đun là: Cơ sở dữ liệu trị đo, Cơ sở dữ liệu bản đồ, Tiện ích 
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3.2.2. Các chức năng thao tác cơ sở dữ liệu trị đo  

Các chức năng trong nhóm này thực hiện các thao tác trên cơ sở dữ liệu trị đo. 

Cơ sở dữ liệu trị đo là cơ sở dữ liệu lưu trữ toàn bộ số liệu đo đạc trong quá trình xây 

dựng bản đồ địa chính. Cơ sở dữ liệu trị đo là các cơ sở dữ liệu nền để xây dựng lên cơ 

sở dữ liệu bản đồ địa chính.  

3.2.1.1. Quản lý khu đo  

Nhóm chức năng giao tiếp giữa người sử dụng và các file dữ liệu trị đo lưu 

trong cơ sở dữ liệu tri đo.  

a. Mở một khu đo đã có  

Số liệu của một khu đo được lưu vào một file trị đo. File trị đo có thể lưu một hoặc 

nhiều dữ liệu trị đo gốc. File số liệu trị đo có phần mở rộng là *.COG, lưu trong một thư 

mục do người dùng tự định nghĩa. Menu chọn Quản lý khu đo/Mở một khu đo đã có.  

b. Tạo mới khu đo  

Chức năng cho phép tạo mới trực tiếp một file dữ liệu trị đo.  

Menu Chọn Quản lý khu đo/Tạo mới khu đo.  

c. Ghi lại  

Ghi lại số liệu đang có trong bộ nhớ vào file trị đo đang mở.  

Menu chọn Quản lý khu đo/Ghi lại. 

3.2.1.2 Hiển thị  

Nhóm chức năng quản lý cách hiển thị các số liệu đã có trong file trị đo ra màn hình.  

*Hiển thị các lớp thông tin trị đo. 

Chức năng dùng để bật tắt các lớp thông tin của file trị đo. Từ Menu chọn Hiển 

thị/Hiển thị các lớp thông tin trị đo.  

Các lớp thông tin trị đo bao gồm: Các trạm đo, điểm đo chi tiết, các đối tượng 

đồ họa được vẽ tự động sau quá trình xử lý mã, các đối tượng đồ họa do người dùng tự 

vẽ qua những công cụ xử lý đồ họa của Microstation, các chữ mô tả số hiệu trạm, điểm 

đo, các chữ mô tả mã của điểm đo.  

*Tạo mô tả trị đo  

Đây là một chức năng tạo các đối tượng chữ (text) để mô tả thông tin đi kèm 

theo với các trạm đo, điểm đo chi tiết. Menu chọn Hiển thị/Tạo mô tả trị đo.  

3.2.1.3. Nhập số liệu  

Nhóm các chức năng trao đổi dữ liệu với bên ngoài. 

 a. Import  

 Chức năng nhập số liệu từ ngoài vào file trị đo, từ các nguồn như: máy toàn 

đạc, các phần mềm khác, sổ đo chi tiết. Menu chọn Nhập số liệu /Import.  
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 b. Export  

Chức năng xuất các trị đo trong file ra các dạng file khác nhau để trao đổi thông 

tin với các hệ thống khác. Chức năng cho phép xuất ra 2 dạng file là file text trị đo 

(ASC) và file cơ sở dữ liệu trị đo của SDR (TXT). Menu chọn Nhập số liệu /Export.  

 c. Sửa chữa trị đo  

Chức năng được dùng để sửa chữa các trị đo qua giao diện hiển thị của các trị 

đo trên màn hình. Menu Chọn Nhập số liệu /Sửa chữa trị đo 

 d. Bảng số liệu trị đo  

 Chức năng cung cấp một phương pháp khác để sửa chữa cơ sở dữ liệu trị đo. 

Thông tin của trị đo được hiện ra dưới dạng bảng. Một bản ghi tương ứng với 1 trị đo 

cụ thể. Đây là một hình thức giao diện rất thuận tiện cho sửa chữa các trị đo. Menu 

chọn Nhập số liệu/Bảng số liệu trị đo. 

3.2.1.4 Xử lý, tính toán  

Là nhóm chức năng cung cấp các công cụ tính toán thông dụng thường dùng 

trong đo đạc, xây dựng bản đồ địa chính. Những công cụ được cung cấp ở đây chỉ là 

những công cụ không sẵn có trong MicroStation.  

 a. Nối điểm theo số hiệu  

 Là quá trình tạo các đường theo số hiệu các điểm đo chi tiết. 

 b. Chia thửa  

 Chức năng là công cụ tạo các cạnh thửa mới dựa trên 2 cạnh thửa cũ. Những 

cạnh thửa mới sẽ thỏa mãn:  

 - Song song với nhau theo một góc cho trước hoặc song song với với một cạnh 

thửa đã có (cạnh định hướng).  

 - Điểm đầu của các cạnh thửa mới nằm trên một cạnh thửa đã có.  

 - Điểm cuối của các cạnh mới nằm trên một cạnh thửa nào đó. 

Menu chọn Xử lý, tính toán/Chia thửa 

 

Hình 3.9. Hộp thoại chia thửa 
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Chọn hướng cho các cạnh thửa mới. Người dùng có thể vào trực tiếp giá trị góc 

của cạnh mới so với trục đứng hoặc chọn và chọn một cạnh thửa nào đó đã có. 

Chương trình sẽ tự tính được góc từ cạnh hướng này.  

Chọn cạnh thửa bị chia: chọn và chọn một cạnh thửa đã có. Cạnh thửa nào được 

chọn sẽ chuyển sang màu tím.  

Chọn cạnh thửa biên: chọn và chọn một cạnh thửa đã có. Cạnh thửa nào được 

chọn sẽ chuyển sang màu xanh. 

Chọn hướng chia, các cạnh thửa mới được tạo theo chiều từ phải sang trái hoặc 

ngược lại trên cạnh bị chia.  

Chọn kiểu chia, chức năng cung cấp 3 kiểu chia cạnh bị chia như sau :  

- Kiểu: khoảng cách giữa các cạnh thửa mới sẽ luôn là giá trị độ dài này. (d1 = 

d2 =…… = dn=giá trị độ dài)  

- Kiểu <Số đoạn>: Cạnh bị chia sẽ chia thành n đoạn bằng nhau. Các cạnh mới 

sẽ bắt đầu từ các điểm chia này (d1=d2=...=dn = Độ dài của cạnh bị chia / n)  

- Kiểu <Tùy chọn>: Cạnh bị chia sẽ chia theo các độ dài khác nhau do người 

dùng vào theo từng cạnh mới một. Trong trường hợp kiểu chia là thì người dùng sẽ 

phải lần lượt vào các giá trị độ dài liên tiếp trong cửa sổ giao diện.  

Chọn <Tiếp tục> để chia tiếp theo độ dài vừa vào hoặc chọn để thôi không chia nữa.  

Chọn <Đặt lại> để xóa tòan bộ những lựa chọn và giá trị tham số ở trên và đặt lại.  

Chọn <Thoát> để ra khỏi chức năng chia thửa.  

3.2.3. Các chức năng thao tác bản đồ địa chính  

3.2.3.1. Tạo topology  

Topology là một mô hình lưu trữ dữ liệu bản đồ (không gian) đã được chuẩn 

hóa trên toàn thế giới. Mô hình không chỉ lưu trữ các thông tin địa lý mô tả về vị trí, 

kích thước, hình dạng của từng đối tượng bản đồ riêng lẻ mà còn mô tả được quan hệ 

về mặt không gian giữa các đối tượng bản đồ như nối nhau, kề nhau.  

Đây là nhóm chức năng quan trọng nhất của phần xây dựng bản đồ. Nó bao 

gồm các chức năng thực hiện và đảm bảo thực hiện đúng công việc đóng vùng các 

thửa từ các cạnh thửa đã có. Topology là mô hình để đảm bảo việc tự động tính diện 

tích, là đầu vào cho các chức năng tạo bản đồ địa chính, tạo hồ sơ thửa, tạo bản đồ chủ 

đề, vẽ nhãn thửa v.v… sau này.  
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Hình 3.10. Quy trình tạo topology 

a. Tự động tìm, sửa lỗi (MRF CLEAN)  

 Chức năng tự động sửa lỗi thông dụng trong bản đồ số như là: Bắt quá 

(Overshoot), Bắt chưa tới (Undershoot ), Trùng nhau (Dupplicate).  

 

Hình 3.11. Hộp thoại MRF Clean  

b. Sửa lỗi (MRF FLAG)  

 Chức năng hiển thị vị trí các lỗi mà MRF FLAG không tự động sửa được và để 

người dùng tự sửa.  

Tự động tìm sửa lỗi 

MRF CLEAN 

Chạy chức năng  

MRF FLAG 

 

Lỗi 

 

Tạo vùng 

Dùng các công cụ của 

Microsation để sửa lỗi 

Có 

Không 
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Hình 3.12. Hộp thoại MRF Flag 

- Next: để chạy đến vị trí lỗi tiếp theo.  

- Prew; để chạy đến vị trí lỗi trước đó.  

- Zoom_in: để phóng to hình.  

- Zoom_out: để thu nhỏ hình.  

- Delete_flag: để xoá cờ hiện thời.  

- Delete_elm: để xoá đối tượng hiện thời.  

- Delete_all: để xoá tất cả các cờ trong file.  

Người dùng sử dụng các công cụ của Microstion để tiến hành sửa các lỗi. 

Sau khi sửa hoàn thành một lỗi, chọn Del Flag để xóa cờ liên quan đến lỗi đã 

được sửa. 

Khi nút Next mờ đi và Edit_status báo No flag!!! tức là tất cả các lỗi trong file đã 

được sửa. 

c. Tạo vùng (Tạo topology)  

 Chức năng thực hiện tạo topology cho các đối tượng bản đồ được lựa chọn. 

Hiện tại chương trình chỉ tạo topology cho các đối tượng dạng vùng như là thửa đất, 

sông suối.  

 Các đối tượng tham gia tạo topology có thể nằm trên nhiều level khác nhau, 

trên toàn file hoặc chỉ một vùng do người dùng định nghĩa (fence).  

 Menu chọn Tạo topology /Tạo vùng. 
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Hình 3.13. Hộp thoại tạo topology 

Trong hộp thoại, cần lưu ý một số vấn đề như sau:  

- Chon level chứa các đối tượng tham gia tạo vùng.  

- Đánh mã sử dụng đất của loại đất mà có nhiều nhất trong khu vực.  

- Chọn level chứa tâm thửa đất và màu của tâm thửa đất.  

- Đánh dấu vào các lựa chọn.  

3.2.3.2. Gán thông tin hồ sơ địa chính ban đầu  

Nhóm các chức năng này phục vụ quá trình gán thông tin địa chính ban đầu. Hay 

nói cách khác, các thông tin hồ sơ địa chính ban đầu: loại đất, tên chủ sử dụng, địa chỉnh 

được gán cho các thửa trong quá trình xây dựng và hoàn chỉnh bản đồ địa chính.  

Các thông tin hồ sơ địa chính ban đầu của thửa bao gồm: Số hiệu bản đồ, Số 

hiệu thửa, Diện tích, Loại đất, Tên chủ sử dụng, Địa chỉ.  

Các thông tin hồ sơ địa chính ban đầu được tạo ra như sau: Số hiệu bản đồ từ 

bảng chắp phân mảnh bản đồ địa chính, Số hiệu thửa được đánh tự động bằng chức 

năng "Tự động đánh số thửa" hoặc do người dùng tự đánh trong quá trình quy chủ từ 

nhãn., Diện tích: được tính tự động qua quá trình tạo vùng, Loại đất, tên chủ sử dụng, 

địa chỉ được gán cho thửa bằng nhãn quy chủ qua chức năng Quy chủ từ nhãn.  

 a. Gán dữ liệu từ nhãn  

 Chức năng làm nhiệm vụ tự động lấy thông tin từ các nhãn quy chủ gán cho 

thửa. Chức năng sẽ lấy thông tin ở nhãn quy chủ nào nằm trong thửa để gán.  
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Hình 3.14. Hộp thoại Gán dữ liệu từ nhãn 

 b. Sửa nhãn thửa  

 Sửa chữa các thông tin hồ sơ của thửa qua chọn nhãn thửa trên màn hình Menu 

chọn Gán thông tin địa chính ban đầu/Sửa nhãn thửa.  

 c. Sửa bảng nhãn thửa 

 Chức năng cung cấp một cách khác để sửa thông tin của thửa. Các thông tin của 

thửa được hiện lên nàm hình dưới dạng một bảng (Borwse Table). Mỗi một hàng 

tương ứng với thông tin của một thửa. Menu chọn Gán thông tin địa chính ban 

đầu/Sửa bảng nhãn thửa.  

 

Hình 3.15. Hộp thoại Sửa bảng nhãn thửa 

Các phím chức năng: 

< |<< >: Về đầu danh sách. 

< << >: Lên một bản ghi. 

< >> >: Xuống một bản ghi. 

< >>| >: Về cuối danh sách. 

< Ghi >: Chấp nhận các thông tin vừa sửa. 

< Hiển thị >: Hiển thị đồ họa thửa đang được chọn ra màn hình. 

< Tìm kiếm >: Tìm kiếm thửa thỏa mãn điều kiện nào đó. 
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< Báo cáo >: Tạo một file báo cáo định dạng *.txt tại thư mục chứa file . 

< Ra khỏi >: Đóng cửa sổ giao diện. 

3.2.3.3. Bản đồ địa chính  

 a. Đánh số thửa tự động  

Chức năng đánh số các thửa trong bản đồ theo thứ tự từ trên xuống dưới, từ trái 

qua phải. Vị trí thửa được xác đinh qua vị trí điểm đặc trưng thửa đất. Để tránh việc 

đánh số thửa theo so sánh vị trí tuyệt đối (sẽ dẫn tới tình trạng số hiệu thửa sau khi 

đánh xong rất khó theo dõi do đôi khi vị trí của hai thửa có số hiệu liên tiếp rất xa 

nhau), chức năng cho phép định nghĩa một khoảng (băng rộng) theo chiều ngang, các 

thửa nào rơi vào cùng một khoảng thì được đánh số thửa từ phải sang trái mà không 

quan tâm đến vị trí trên dưới.  

 Các thửa tham gia vào đánh số có thể là toàn bộ thửa trên file bản đồ hiện thời 

hoặc trong một vùng nào đó do người dùng định nghĩa bằng fence. Menu chọn Bản đồ 

địa chính/Đánh số thửa tự động.  

 

Hình 3.16. Hộp thoại Đánh số thửa tự động 

b. Tạo hồ sơ kỹ thuật thửa  

Đây là chức năng tạo ra các bản hồ sơ của thửa đất theo những mẫu quy định 

của Tổng cục Địa chính. Chức năng cho phép tạo ra các loại hồ sơ của thửa đất như 

sau: Giấy chứng nhận quyền sử dụng đất, hồ sơ kỹ thuật, biên bản hiện trạng…Menu 

chọn Bản đồ địa chính/Tạo hồ sơ kỹ thuật (Chi tiết sẽ được trình bày trong phần 3.4). 

c. Tạo bản đồ địa chính  

Chức năng tự động tạo một file mới lưu bản đồ địa chính từ bản đồ nền. Menu 

chọn Bản đồ địa chính/Tạo bản đồ địa chính, xuất hiện hộp thoại: Chức năng này sẽ 

cho phép chúng ta lựa xây dựng được các mảnh bản đồ có số hiệu theo đúng quy phạm 

của bản đồ địa chính.  

d. Tạo khung bản đồ địa chính  

 Chức năng tạo ra khung bản đồ địa chính với vị trí và cách thể hiện theo đúng 

quy phạm quy định. Menu chọn Bản đồ địa chính/Tạo khung bản đồ địa chính.  
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 Sau khi nhập các thông số như tên xã, huyện, tỉnh và tỷ lệ bản đồ địa chính cần 

lập, chúng ta sẽ chọn khu vực bản đồ được đưa vào khung bằng cách sử dụng fence 

hoặc chọn bản đồ. Khi chúng ta chọn thì tọa độ góc khung sẽ hiển thị và số hiệu mảnh 

bản đồ sẽ hiển thị trên đúng với quy phạm trên cơ sở tính toán các tham số.  

3.2.3.4. Xử lý bản đồ  

a. Nắn bản đồ  

Chức năng dùng để nắn, chuyển các đối tượng bản đồ từ một hệ thống tọa độ 

khác sang hệ thống tọa độ của file bản đồ hiện tại thông qua các phép nắn Projective 

với các cặp điểm tọa độ khống chế. Hiện tại chức năng chỉ cho phép nắn với 4 điểm, 

trong phiên bản tiếp theo, chức năng cho phép nắn với số lượng điểm lớn hơn và các 

phương pháp nắn với bậc cao hơn. Menu chọn Xử lý bản đồ/Nắn bản đồ 

Chúng ta mở file cần nắn đưa vào file bản đồ hiện thời, đặt các cửa sổ hiển thị 

(view) sau cho các cặp điểm tương ứng có thể nhìn và chọn dễ dàng. Lần luợt chọn 4 

cặp điểm tương ứng giữa file tham chiếu và file bản đồ hiện tại. Nếu chỉ chuyển một 

vùng nào đó trên file tham chiếu, chọn fence và định nghĩa vùng bằng fence.  

b. Tạo bản đồ chủ đề từ trường số liệu  

Chức năng cung cấp cho người dùng một công cụ rất mạnh để tạo ra bản đồ chủ 

đề khác nhau trên một file bản đồ chính theo các số liệu thuộc tính liên kết với các đối 

tượng bản đồ.  

Để tạo bản đồ chủ đề, người ta phân loại một nhóm các đối tượng bản đồ dựa 

theo một thuộc tính nào đó. các đối tượng bản đồ trong cùng một phân loại có cùng 

một kiểu hiển thị (màu sắc, ký hiệu, mẫu tô) trên màn hình đồ họa. Cách phân loại dựa 

trên thuộc tính thường gồm 2 kiểu như sau :  

Trong khoảng (range): tất cả các đối có thuộc tính nằm trong khoảng giới hạn 

cận trên và cận dưới này đề thuộc 1 phân loại. Đây chính là bài toán phân bậc bản đồ 

trong bản đồ học.  

Theo chỉ số duy nhất (Invidual value): tất cả các đối tượng có cùng 1 giá trị của 

thuộc tính đều được gộp vào một phân loại. 

Hiện tại, để đáp ứng nhu cầu làm việc trên bản đồ địa chính, chức năng này chỉ 

xây dựng các bản đồ chuyên đề dựa các thửa (đối tượng có kiểu vùng). Chức năng còn 

có thể phát triển thêm và làm việc với tất cả các loại đối tượng bản đồ khác nhau.  

Các đối tượng bản đồ được lưu trong file DGN, còn dữ liệu thuộc tính được lưu 

trong file dữ liệu dạng DBF. File DBF bắt buộc phải có trường số hiệu PARCEL_ID 

tương ứng với số hiệu thửa của các thửa trên bản đồ. Đây chính là trường khóa, móc 

nối giữa thửa trên bản đồ và trường của chúng. Menu chọn Xử lý bản đồ /Tạo bản đồ 

chủ đề từ trường số liệu  
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c. Vẽ nhãn thửa từ trường số liệu  

 Một trong những chức năng thường dùng nhất trong biên tập bản đồ số là vẽ 

nhãn (label) cho các đối tượng bản đồ từ dữ liệu thuộc tính của nó. Một đối tượng bản 

đồ có thể có rất nhiều loại dữ liệu thuộc tính đi kèm theo. Tại một thời điểm, không thể 

hiển thị tất cả các dữ liệu liên quan đến ra được. Vì vậy, chức năng vẽ nhãn thửa sẽ 

cung cấp cho người dùng một công cụ để vẽ ra màn hình một số loại dữ liệu thuộc tính 

do người dùng tự định nghĩa và theo một định dạng cho trước.  

 Do phần mềm đáp ứng cho quản lý và xử lý bản đồ địa chính nên các đối tượng 

bản đồ có khả năng vẽ nhãn chỉ là các đối tượng kiểu vùng đã được tạo topology. 

Menu chọn Xử lý bản đồ/Vẽ nhãn thửa.  

Nhãn thửa là nhãn lấy số liệu từ các trường: số hiệu thửa, loại đất và diện tích.  

Nhãn sau khi tạo xong có dạng :  

Loại đất 
Số thửa

Diện tích
 

Nhãn quy chủ là nhãn phục vụ qua trình đăng ký sơ bộ. Nhãn thửa là nhãn lấy 

số liệu từ các trường: số hiệu thửa, loại đất, tên chủ sử dụng và địa chỉ. 

3.3. Xây dựng các loại hồ sơ đất đai  

Để xây dựng hồ sơ đất đai, từ menu Chọn bản đồ địa chính/tạo hồ sơ kỹ thuật 

thửa, xuất hiện hộp thoại như sau: 

 

Hình 3.17. Hộp thoại Tạo hồ sơ thửa đất 

Từ hộp thoại trên, chọn loại hồ sơ kỹ thuật phù hợp và điền các thông số như: 

Tỷ lệ bản vẽ, các yếu tố thể hiện, mã sử dụng đất…để hiển thị trên hồ sơ. Sau đó, bấm 
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vào “chọn thửa” và nhấn chuột vào tâm thửa đất. Lúc này một file templace.dgn sẽ 

xuất hiện, lưu file này lại với một tên bất kỳ (ví dụ: Hsthua1.dgn….).  
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BÀI THỰC HÀNH 2 

Nắn ảnh bản đồ và vector hóa bản đồ 

Bài tập 1:  

Nắn ảnh DC10.tif trong (thư mục D:\Du lieu THCN) trên IrasB vào đúng tọa độ 

với sai số SSE <=0,5. 

HƯỚNG DẪN THỰC HÀNH 

1. Tạo file  

- Khởi động Microstation 

- Từ cửa sổ MicroStation Manager:  

+ Chọn File/New, xuất hiện hộp thoại Create Design File:  

+ Chọn Seed File: Bấm chuột vào Select, xuất hiện hộp thoại Select Seed File, 

Chọn Seed file là file: C:\Famis\system\seed_bd.dgn, chọn OK. 

+ Gõ tên File mới cần tạo là SohoaBDDC, chọn OK.  

- ChọnWorkspace: Default. 

- Chọn Style: Comand window. 

2. Tạo lưới lưới Km  

 - Trên thanh công cụ Main của MSE, sử dụng Place Active Point sau đố nhập 

tọa độ của điểm góc trái dưới vào cửa sổ Comand window:  xy= 592800, 1200400  

 Lưu ý: Trước khi nhập tọa độ điểm XY, do kích thước các điểm tạo ra rất nhỏ 

nên để dễ quan sát có thể chỉnh lực nét của điểm đó lên. (Ví dụ: Line weight = 4) 

 - Chọn Fit view nhìn toàn bộ màn hình để thấy điểm vừa tạo ra. 

 - Trên thanh công cụ Main, sử dụng Construc Array để tạo các điểm mắt lưới. 

 

 Trong đó gồm 7 cột, 6 hàng, khoảng cách giữa các hang và cột là 50m. 

3. Nắn ảnh  

a. Khởi động IrasB  

- Từ thanh Menu, chọn Utilities/MDL Application lúc này xuất hiện hộp thoại 

MDL, từ hộp thoại đó, trong phần Available Applications, chúng ta chọn IrasB, bấm 

Load. 

 

 



  

68 

b. Mở file ảnh raster cần nắn 

- Từ thanh Menu của I/RAS B chọn File/Open > Xuất hiện hộp hội thoại IRASB 

LOAD 

- Từ hộp thoại, bấm Browse, xuất hiện hộp hội thoại IRASB LOAD cho phép 

chọn đường dẫn đến thư mục chứa DC10.tif 

- Chọn chế độ mở ảnh: Interactive Placement By Rectangle 

- Bấm chuột trái ra vào góc trái trên (phía ngoài) lưới km và kéo chuột thành một 

hình chữ nhật để mở file ảnh cần nắn sao cho các điểm lưới km trên ảnh gần trùng với 

các điểm km. 

c. Nắn ảnh sơ bộ  

- Từ thanh Menu của IRASB chọn View/Placement/Match Points/Active Layer. 

 

+ Trên cửa sổ lệnh xuất hiện dòng Enter raster reference point: Bấm phím 

Data chọn điểm góc khung phía trên bên trái của file ảnh raster (Điểm thứ nhất trên 

ảnh raster)  

+ Trên cửa sổ lệnh xuất hiện dòng Enter distance point in raster layer: Bấm 

phím Data chọn điểm góc khung phía dưới bên phải của file ảnh raster (Điểm thứ 

hai trên ảnh raster) 

+ Trên cửa sổ lệnh xuất hiện dòng Enter design file reference point: Sử dụng 

chế độ Snap (bắt điểm chính xác) chọn điểm góc khung phía trên bên trái của lưới 

km và bấm Data (tương ứng với điểm thứ nhất trên ảnh raster). 

+ Trên cửa sổ lệnh xuất hiện dòng Enter distance point in design file: Sử dụng 

chế độ Snap (bắt điểm chính xác) chọn điểm góc khung phía dưới bên phải của lưới 

km và bấm Data (tương ứng với điểm thứ hai trên ảnh raster).  
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Từ thanh Menu của I/RAS B chọn File/Save/Save Active Layer hoặc Save 

Active Layer As …để ghi lại chế độ ảnh vừa nắn sơ bộ.  

d. Nắn ảnh chính xác  

- Chọn thanh công cụ Warp: Menu Edit/Modify/Warp. Xuất hiện hộp thoại Warp 

- Chọn mô hình nắn: Mô hình Projective  

- Warp Area: Drawing 

- Chọn Collect point để lựa chọn các cặp điểm khống chế 

+ Bấm chuột trái chọn điểm khống chế thứ nhất trên file ảnh raster. 

 

- Chọn điểm khống chế thứ nhất tương ứng trên lưới km (bắt điểm chính xác). 
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+ Cứ tiếp tục làm như vậy theo thứ tự chọn một điểm trên ảnh raster rồi chọn một 

điểm trên lưới km tương ứng sao cho đủ số điểm để chúng ta thực hiện phép nắn (tối 

thiểu 5 cặp điểm). 

- Sau khi chọn đủ các cặp điểm khống chế, tiến hành đánh giá sai số SSE phải 

nhỏ hơn < 0,5 thì đạt yêu cầu của bài tập.  

Nếu chưa đạt yêu cầu thì Chọn Delete points: Xoá điểm, trong trường hợp các 

điểm chúng ta chọn bị sai. Bằng cách chon dòng đó, bấm vào Delete points. Sau đó 

chọn lại các cặp điểm khác để đạt yêu cầu chính xác cao hơn. 

- Khi các thông số đã đạt yêu cầu. tiến hành lưu lại mô hình nắn: 

+ Từ hộp thoại IrasB Warp, chọn File/Save As, xuất hiện hộp thoại. 

 

+ Nhập tên file sau đó chọn Save 

- Chọn Perform Warp để nắn ảnh.  

 

e. Ghi lại kết quả nắn ảnh chính xác 

- Chọn File/Save/Save Active Layer hoặc Save Active Layer As …để ghi lại 

ảnh vừa nắn đạt yêu cầu vào thư mục thưc hành của sinh viên. 

Bài tập 2:  

Số hóa toàn bộ các thửa đất và loại đất ở bài tập 1với các thuộc tính như 

sau: 

 - Ranh giới thửa đất: Level (5) – Line color (1) – Line weight (0) 

 - Mục đích sử dụng đất: Level (33) – Text color (1) – Linve weight (0) 

HƯỚNG DẪN THỰC HÀNH 

- Menu Utinities/ chọn MDL Apllication, xuất hiện bảng hội thoại sau: 



  

71 

 

- Chọn Geovec/ Load 

- Từ Menu của MicroStation chọn Application/Geovec/Preference/ View, xuất 

hiện hộp thoại View Preference. Tiến hành đặt các thông số 

 + Đánh dấu vào chế độ Auto Zoom – bấm Apply 

 + Đánh dấu vào chế độ Auto move – Bấm Define 

 + Đánh dấu vào Auto Update after raster 

 

+ Đóng hộp thoại View Preferences lại sẽ xuất hiện hộp thoại Save As Layout, 

đánh tên bất kỳ vào ô Layout. Sau đó OK 

- Chọn thanh công cụ Place Smartline. Đặt chế độ vẽ đường trong hội thoại Place 

Smartline. 

- Bấm Data để bắt đầu một đường. 

- Snap vào điểm tiếp theo nếu cần thiết. 

- Bấm phím Data để vẽ vị trí tiếp theo của đường. 

- Bấm Reset để kết thúc đường. 
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BÀI THỰC HÀNH 3 

Bài tập 1:  

Từ 1 tờ bản đồ địa chính bất kỳ không có file thông tin thửa đất đi kèm 

(to06.dgn phường Kim Long), hãy sử dụng chức năng gán dữ liệu để cập nhật lại file 

thông tin thuộc tính thửa đất. Sau đó xuất file sang Excel để biên tập và lưu lại đặt tên 

là DC.xls 

HƯỚNG DẪN THỰC HÀNH 

1. Chuẩn bị dữ liệu 

- Copy file to06.dgn phường Kim Long vào thư mục của sinh viên 

- Mở file to06.dgn  

2. Khai thác thông tin bản đồ địa chính 

a. Tạo topology 

- Khởi động Famis: Menu Utilities/ MDL Applications. Xuất hiện hộp thoại 

MDL.  

- Chọn Browse và tìm đường dẫn đến thư mục famis.ma trong đường dẫn 

C:\famis. 

 

- Menu Cơ sở dữ liệu bản đồ/Quản lý bản đồ/Kết nối với cơ sở dữ liệu Không 

cần quét sửa lỗi bản đồ. 

- Menu Cơ sở dữ liệu bản đồ/ Tạo topology/Tạo vùng. Xuất hiện hộp thoại Tạo 

vùng. 

- Level tạo nhập: 10, 31  



  

73 

-  

- Bấm Tạo vùng.  

- Xem kết quả tạo vùng ở trên bản đồ 

 

- Sau khi tạo topology cần cập nhật topology vừa tạo xong: Chọn Menu Cơ sở 

dữ liệu bản đồ/Quản lý bản đồ/Kết nối với cơ sở dữ liệu  

b. Xác định các thông tin thửa đất cần gán 

  Sử dụng công cụ Analyze Element trên thanh công cụ Primary của Microstation 

để xác định level của các thông tin thửa đất trên bản đồ địa chính.  

 

- Số thửa (level 12)  

- Tên chủ sử dụng (level 6)  

- Địa chỉ (level 6)  

- MĐSD đất (level 5)  

c. Gán dữ liệu từ nhãn 

- Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Gán dữ liệu từ 

nhãn. Xuất hiện hộp thoại Gán 
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- Lần lượt nhập level của các thông tin cần gán đã xác định ở trên như sau: 

+ Tích chọn thông tin: Số thửa > Nhập level gán: 12 > Chọn Gán > Chọn OK để 

lưu kết quả gán 

+ Tích chọn thông tin: Chủ sử dụng và Địa chỉ > Nhập level gán: 6 > Chọn Gán 

> Chọn OK để lưu kết quả gán 

+ Tích chọn thông tin MĐSD 2003 > Nhập level gán: 5 > Chọn Gán > Chọn OK 

để lưu kết quả gán. 

d. Chỉnh lý thông tin còn thiếu và báo cáo file dữ liệu 

  Trường hợp các thửa đất quá nhỏ, nhãn thửa thiếu hoặc nằm ngoài thửa đất thì 

các thông tin không thể gán vào thửa đất. Vì vậy cần phải chỉnh lý trên bảng nhãn 

thửa. 

  - Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Sửa bảng nhãn 

thửa. Xuất hiện hộp thoại cơ sơ dữ liệu bản đồ địa chính. 

  - Bấm chuột chọn các thửa đất còn thiếu thông tin và nhập thông tin vào. Bấm 

<Ghi> để lưu lại thông tin vừa nhập. 

  - Sau khi đã đầy đủ thông tin các thửa đất. Chọn <Báo cáo> để xuất file dữ liệu 

thông tin thửa đất vào thư mục chứa file to06.dgn. Lúc này file được báo cáo sẽ có tên 

là to06.txt 

 

3. Mở file thông tin trên Excel 

  - Khởi động Excel. File/Open. Xuất hiện hộp thoại mở file.  

- Chọn định dạnh file là <All file> và tìm đường dẫn đến file to06.txt trong thư 

mục đã báo cáo. 
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- Chọn Open để mở file. Xuất hiện hộp thoại Text Import Wizard. Chọn Next 

cho đến khi Finish. 

4. Chuyển font chữ từ TCVN3 sang Unicode  

 - Để sửa lỗi font file Excel cần khởi động Unikey của máy tính trước. 

 - Bấm Ctrl – A để chọn toàn bộ nội dung cần chuyển font. 

 - Bấm Ctrl – C để copy nội dung cần chuyển font 

 - Bấm Ctrl – Shilf – F6 hoặc bấm chuột phải vào biểu tượng Unikey ở góc dưới 

màn hình máy tính > Chọn Công cụ (CS+F6). Xuất hiện hộp thoại Unikey Toolkit 

  

 - Chọn Nguồn: TCVN3 (ABC) - Đích: Unicode 

 - Tích chọn <Chuyển mã clipboard> 

 - Chọn <Chuyển mã> 

 - Xuất hiện hộp thoại chuyển mã thành công. Bấm OK. Bấm Đóng. 

 - Bấm Ctrl – V để dán nội dung vừa chuyển lỗi font  

5. Biên tập và lưu file 

  - Xóa các cột thông tin không cần thiết: A, C, D, E, F, G, I, J, K, L, M 
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  - Xóa các dòng: 1, 3, 83 

  - Phía sau cột C (MĐSD 2003). Thêm mới  (Insert) 2 cột mới. Đặt tên cột là 

<Tên chủ sử dụng> (Lúc này là Cột D) và < Địa chỉ> (lúc này là Cột E) 

  - Bấm chuột vào ô D2 (Tên chủ sử dụng) và nhập công thức để nhập thông tin 

cho cột như sau: =G2&H2 

  - Bấm chuột vào cột E2 (Địa chỉ) và nhập công thức để nhập thông tin cho cột 

như sau: =J2&" "&K2&" "&L2&" "&M2&" "&N2 

  - Chọn chuột vào 2 ô D2, E2 và kéo chuột sao chép công thức cho các dòng 

phía dưới. 

  - Chọn chuột toàn bộ 2 cột D và E. Chọn Copy > Chọn Paste Values để dán 

thông tin giá trị của cột (Không cần sao chép công thức) 

  - Xóa các cột từ F đến Q 

  - Biên tập lại kết quả file excel  

 

- Lưu file: Chọn Save as > Chọn định dạng lưu *.xlsx hoặc *.xls. Đặt tên file là 

DC06. Chọn thư mục lưu file của sinh viên. Chọn Save. 
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Bài tập 2:  

Từ dữ liệu bản đồ địa chính to06.dgn của phường Kim Long, tiến hành chỉnh lý 

tách thửa đất số 25 thành 2 thửa mới trên bản đồ và bảng thuộc tính. Đặt tên cho bản 

đồ mới là Tachthua.dgn. Lưu ý: Khi tách thửa không làm thay đổi thông tin thuộc tính 

các thửa khác trong bản đồ. 

HƯỚNG DẪN THỰC HÀNH 

1. Gán thông tin nhãn thửa từ bản đồ to06.dgn vào bảng nhãn thửa (làm như bài 

tập 2) 

2. Tách thửa trên bản đồ  

- Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Sửa bảng nhãn 

thửa. 

- Bấm chuột chọn thửa đất số 25, chọn <Hiển thị> để di chuyển màn hình làm 

việc đến thửa đất số 25 ở trên bản đồ (Lưu ý: Phải Zoom vào thửa đất bất kỳ ở một tỷ 

lệ vừa đủ trước khi bấm Hiển thị để quan sát dễ dàng thửa đất đã chọn>. 

- Chọn công cụ Drop  trong nhóm công cụ Group. 

- Tích chọn LineString/Shape 

 

- Bấm chuột 2 lần vào các cạnh thửa đất của thửa số 25 để bẻ gãy liên kết giữa 

các cạnh thửa. 

- Trước khi thực hiện chia thửa. Chuyển level hoạt động sang level 10. 

- Menu Tiện Ích/Chia thửa. Xuất hiện hộp thoại Chia thửa. 
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- Chọn <Hướng>, bấm chuột 2 lần chọn hướng chia (Ví dụ: Chia thửa hướng 

ngang thì chọn đường hướng ngang) 

- Chọn <Đường chia>, bấm chuột 2 lần chọn đường chia (Ví dụ: Đường liền kề 

với đường hướng chia phía trên) 

- Chọn <Đường biên>, bấm chuột 2 lần chọn đường biên (Đường liền kề còn lại 

với đường hướng chia phía trên, đối diện với đường chia). 

- Tích chọn ô <Tùy chọn>. Xuất hiện hộp thoại > Nhập độ dài chia thửa (Ví dụ = 

8,677m) 

- Bấm <Tiếp tục> để thực hiện chia thửa. Lúc này trên bản đồ thửa đất số 25 xuất 

hiện đường chia thửa mới. 

 

3. Tách thửa trên bảng thông tin thuộc tính 

a. Tạo mới topology cho thửa đất 

- Menu Cở sở dữ liệu bản đồ/Quản lý bản đồ/ Kết nối với cơ sở dữ liệu 

 - Menu Cơ sở dữ liệu bản đồ/ Tạo topology/ Tự động tìm sửa lỗi (CLEAN). 

Xuất hiện hộp thoại MRF CLEAN. 

 - Chọn Parameters > Xuất hiện hộp thoại MRF Clean Parameter. 

- Tích chọn <By Level>, Chọn Tolerances > Xuất hiện hộp thoại MRF Clean 

Setup Tolerances. 

 - Chọn level để chỉnh thông số thành 0,0001 > Chọn <Set>. Đóng hộp thoại 

MRF Clean Setup Tolerances. 

 - Đóng hộp thoại Mrf Clean Setup Tolerances và MRF Clean Parameter. 

 - Chọn <Clean> trên hộp thoại MRF CLEAN để tìm sửa lỗi bản đồ 
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 - Menu Cơ sở dữ liệu bản đồ/ Tạo topology/ Sửa lỗi (FLAG) > Xuất hiện hộp 

thoại MRF Flag Editor > Chọn Del All Flags. 

- Menu Cơ sở dữ liệu bản đồ/ Tạo topology/ Tạo vùng > Xuất hiện hộp thoại 

<tạo vùng > Nhập level tạo: 10, 31 > Bấm <Tạo vùng> 

 

b. Chỉnh lý thông tin trên bảng thuộc tính 

- Menu Cở sở dữ liệu bản đồ/Quản lý bản đồ/ Kết nối với cơ sở dữ liệu 

 - Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Sửa bảng nhãn 

thửa 

 - Bấm chuột chọn dòng thứ 2 (Chưa có số hiệu thửa nhưng vẫn còn thông tin 

của thửa đất cũ > Nhập số hiệu thửa: 25 (Giữ nguyên số hiệu thửa cũ) > Chọn <Ghi> 

để lưu lại thông tin chỉnh lý 

 - Bấm chuột chọn dòng thứ 1 (Đây là thửa mới tách, chưa có thông tin của thửa 

đất) > Nhập thông tin thửa đất như sau: 

 + Số hiệu thửa mới = 117 (Số hiệu thửa lớn nhất trên tờ bản đồ 116 + 1) 

+ Tên chủ sử dụng mới: Nguyễn Văn A) 

+ Địa chỉ thửa đất mới: Giữ nguyên địa chỉ cũ) 

+ MĐSD mới: ODT 

+ Bấm <Ghi> để lưu lại thông tin chỉnh lý 
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c. Chỉnh lý thông tin nhãn thửa trên bản đồ 

 - Menu Cơ sở dữ liệu bản đồ/Xử lý bản đồ/Vẽ nhãn thửa > Xuất hiện hộp thoại 

biên tập nhãn thửa. 

 - Chọn <Trường>: Số thửa  

 - Chọn các tùy chỉnh như màu sắc, cỡ chữ, độ đậm…. 

 - Chọn <Vẽ nhãn> 

      

4. Lưu file bản đồ 

- Menu File > Save as…> Xuất hiện hộp thoại Save Design As. 

- Chọn thư mục lưu file và đặt tên file là Tachthua.dgn 

Bài tập 3:  

Từ dữ liệu bản đồ địa chính to06.dgn của phường Kim Long, tiến hành chỉnh lý 

gộp 2 thửa đất số 79 và 80 trên bản đồ và bảng thuộc tính. Đặt tên cho bản đồ mới là 

Gopthua.dgn. Lưu ý: Khi gộp thửa không làm thay đổi thông tin thuộc tính các thửa 

khác trong bản đồ. 
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HƯỚNG DẪN THỰC HÀNH 

1. Gán thông tin nhãn thửa từ bản đồ to06.dgn vào bảng nhãn thửa (làm như bài 

tập 2) 

2. Gộp thửa trên bản đồ  

- Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Sửa bảng nhãn 

thửa. 

- Bấm chuột chọn thửa đất số 70 hoặc 80, chọn <Hiển thị> để di chuyển màn 

hình làm việc đến thửa đất số cần gộp ở trên bản đồ (Lưu ý: Phải Zoom vào thửa đất 

bất kỳ ở một tỷ lệ vừa đủ trước khi bấm Hiển thị để quan sát dễ dàng thửa đất đã 

chọn>. 

- Dùng công cụ xóa đối tượng của Microstation để xóa đường cạnh thửa chung 

của 2 thửa đất cần gộp.  

 

3. Gộp thửa trên bảng thông tin thuộc tính 

a. Tạo mới topology cho thửa đất 

- Menu Cở sở dữ liệu bản đồ/Quản lý bản đồ/ Kết nối với cơ sở dữ liệu 

- Menu Cơ sở dữ liệu bản đồ/ Tạo topology/ Tạo vùng > Xuất hiện hộp thoại 

<tạo vùng > Nhập level tạo: 10, 31 > Bấm <Tạo vùng> 
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b. Chỉnh lý thông tin trên bảng thuộc tính 

- Menu Cở sở dữ liệu bản đồ/Quản lý bản đồ/ Kết nối với cơ sở dữ liệu 

 - Menu Cơ sở dữ liệu bản đồ/Gán thông tin địa chính ban đầu/Sửa bảng nhãn 

thửa 

 - Bấm chuột chọn dòng thứ 1 – Đây là thửa mới sau khi gộp 2 thửa đất cũ 

(Chưa có số hiệu thửa nhưng vẫn còn thông tin của thửa đất cũ > Nhập số hiệu thửa: 

79 (Giữ nguyên số hiệu thửa cũ nhỏ hơn) > Chọn <Ghi> để lưu lại thông tin chỉnh lý 

 

c. Chỉnh lý thông tin nhãn thửa trên bản đồ 

 - Menu Cơ sở dữ liệu bản đồ/Xử lý bản đồ/Vẽ nhãn thửa > Xuất hiện hộp thoại 

biên tập nhãn thửa. 

 - Chọn <Trường>: Số thửa  

 - Chọn các tùy chỉnh như màu sắc, cỡ chữ, độ đậm…. 

 - Chọn <Vẽ nhãn> 
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 - Xóa bớt các thông tin từ thửa cũ sau khi gộp. 

4. Lưu file bản đồ 

- Menu File > Save as…> Xuất hiện hộp thoại Save Design As. 

- Chọn thư mục lưu file và đặt tên file là Gopthua.dgn 

Bài tập 4:  

Từ tờ bản đồ địa chính to06.dgn của phường Kim Long, tiến hành tạo Bản mô 

tả ranh giới thửa đất cho thửa số 14 và Trích lục thửa đất cho thửa số 33. Đặt tên ần 

lượt là MTRG14.dgn và TL33.dgn. 

HƯỚNG DẪN THỰC HÀNH 

1. Gán thông tin nhãn thửa từ bản đồ to06.dgn vào bảng nhãn thửa (làm như bài 

tập 2) 

2. Tạo bảng mô tả ranh giới thửa đất/Trích lục/ 

 - Tìm và phóng to bản đồ để thấy thửa đất số 14 

 - Menu Cơ sở dữ liệu bản đồ/ Bản đồ địa chính/ Tạo hồ sơ kỹ thuật thửa. Xuất 

hiện hộp thoại Hồ sơ thửa đất. 

 - Chọn <Loại> hồ sơ: Bản mô trả ranh giới thửa đất (hoặc Trích lục hoặc các 

loại hồ sơ khác theo bài tập). 

 - Kích chọn <To file> để có thể lưu hồ sơ 

 - Tùy chỉnh chọn <Vẽ chiều dài cạnh> và <Vẽ tứ cận> 

 - Điền thông tin người đo và người KT 

 - Bấm <Chọn thửa> sau đó kích đúp chuột vào tâm topology của thửa đất số 14. 

 - Phần mềm tự động chuyển màn hình làm việc sang giao diện hồ sơ Bản mô tả 

ranh giới thửa đất để biển tập. 
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 - Sử dụng công cụ Edit Text để thay đổi, chỉnh sửa các thông tin cần thiết trên 

bản mô tả ranh giới thửa đất 

 - Chọn <Ra khỏi> để lưu hồ sơ. Xuất hiện hộp thoại lưu hồ sơ kỹ thuật. Chọn 

thư mục lưu và đặt tên file. 

Bài tập 5:  

Từ tờ bản đồ địa chính to06.dgn của phường Kim Long, tiến hành cấp giấy 

chứng nhận quyền sử dụng đất cho thửa đất số 85. Đặt tên file là GCN85.dgn 

1. Khởi động 1 file bất kỳ trên Microstation 

2. Khởi động phần mềm In GCN 

 - Menu Utilities/ MDL Application. Xuất hiện hộp thoại MDL. Tìm đường dẫn 

đến C:\gcntt17\gcntt17.ma 
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 - Xuất hiện giao diện phần mềm In GCNTT17 

 - Chọn <Tạo mới> để tạo mới file GCN. Chọn thư mục lưu của SV và đặt tên là 

GCN85.dgn. 

3. Mở file thửa đất trên bản đồ địa chính cần in GCN 

 - Menu File/References/ Xuất hiện hộp thoại References File 

 - Chọn Tool/Attach. Xuất hiện hộp thoại mở file dưới dạng file tham khảo. 

 - Tìm đến thư mục chứa file to06.dgn của Phường Kim Long và OK 

 - Tìm và phóng to đến thửa đất số 85 của to06.dgn của Phường Kim Long 

4. Trích xuất thửa đất cần in GCN  

 - Dùng công cụ Place Fence để bao fence quanh thửa đất cần in GCN 

 + Fence type: Shape ;  + Fence Mode: Clip 

 

 - Dùng công cụ Copy để copy thửa đất cần in GCN sang file GCN85.dgn: 

 + Chọn công cụ Copy;  + Tích chọn <Use Fence> 
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 + Kích chuột trái vào trong fence 

 + Nhập dx=0 vào cửa sổ lệnh Comand Window để copy vị trí của fence không 

thay đổi. 

 - Dùng công cụ Creat Region để tạo vùng cho thửa đất cần in GCN với Method 

là Flood 

 

 - Kích chuột trái vào thửa đất để nhận dạng các đường ranh giới khép vùng. 

Tiếp tục kích chuột trái thêm lần nữa để tạo vùng. 

 - Trên giao diện công cụ In GCN, nhập mã vạch và  chọn <Trích lục từ Shape> 

 - Biên tập lại GCN bằng cách thay đổi các thông tin trên GCN theo thông tin 

thửa đất. 
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CHƯƠNG 4 

 XÂY DỰNG BẢN ĐỒ HIỆN TRẠNG SỬ DỤNG ĐẤT 

4.1. Quy định kĩ thuật xây dựng bản đồ hiện trạng sử dụng đất  

4.1.1. Quy định chung 

 Khi sử dụng phần mềm MicroStation để xây dựng bản đồ hiện trạng sử dụng 

đất phải thống nhất theo các quy định sau: 

 - Tệp tin bản đồ phải ở dạng mở, cho phép chỉnh sửa, cập nhật thông tin khi cần 

thiết và có khả năng chuyển đổi khuôn dạng. 

- Các ký hiệu dạng điểm trên bản đồ phải thể hiện bằng các ký hiệu dạng cell 

được thiết kế sẵn trong các tệp *.cell. 

- Các đối tượng dạng đường chỉ được vẽ ở dạng LineString, Polyline, Chain 

hoặc Complex Chain, vẽ liên tục, không đứt đoạn và chỉ được dừng tại các điểm nút 

giao nhau giữa các đường. 

- Những đối tượng dạng vùng (polygon) phải được vẽ ở dạng pattern, shape, 

complex shape hoặc fill color. Những đối tượng dạng vùng phải là các vùng khép kín. 

- Các đối tượng trên bản đồ phải thể hiện đúng lớp, màu sắc, lực nét và các 

thông số kèm theo như quy định tại bảng phân lớp đối tượng. Đối với các đối tượng 

tham gia đóng vùng khoanh đất vẽ nửa theo tỷ lệ (như đường giao thông, địa giới …) 

thì sao lưu nguyên trạng phần tham gia đóng vùng và chuyển về lớp riêng để tham gia 

đóng vùng. Mỗi khoanh đất phải có một mã sử dụng đất, khi biên tập lược bỏ để in 

không được xãa mà phải chuyển về lớp riêng để lưu trữ. Sản phẩm phải có ghi chú lý 

lịch kèm theo. 

4.1.2. Quy định các tệp tin chuẩn cho xây dựng bản đồ hiện trạng sử dụng đất 

 Để thống nhất dữ liệu bản đồ số khi sử dụng phần mềm MicroStation phải sử 

dụng các tệp chuẩn sau: 

 - Seedfile: Là tệp chuẩn ở hệ tọa độ VN2000, cơ sở toán học phù hợp với đơn 

vị hành chính xây dựng bản đồ, theo quy định tại Quy định về thành lập bản đồ hiện 

trạng sử dụng đất. 

 - Đơn vị làm việc (Working Units) gồm: 

 + Đơn vị làm việc chính (Master Units): mét (m);  

 + Đơn vị làm việc phụ (Sub Units): milimét (mm);  

 + Độ phân giải (Resolution):1000. 

 - Fonts chữ tiếng Việt: dùng bộ phông chữ vnfont.rsc  

 - Thư viện các ký hiệu độc lập cho các dãy tỷ lệ tương ứng: ht1-5.cell;  ht10-

24.cell; ht50-100.cell; ht250-1tr.cell. 

 - Thư viện các ký hiệu hình tuyến theo dãy tỷ lệ tương ứng: ht1-4.rsc; ht10-

24.rsc; ht50-100.rsc; ht250-1tr.rsc. 

 - Bảng màu: ht_qh.tbl 
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 Các tệp này được tạo sẵn trong thư viện “HT_QH” sử dụng cho xây dựng bản 

đồ dạng số. Để có thể cài đặt các tệp chuẩn tiến hành chạy tệp Datdai*.bat (* là c, d, e, 

tùy vào phần mềm Microstation được cài trên ổ C, D, E) trong thư mục “HT_QH” 

bằng cách nháy đúp chuột trái vào tập tin hoặc đưa con trỏ, đánh dấu tập tin và nhấn 

Enter, các tệp chuẩn (seedfile, bảng màu, thư viện Cell, LineStyle, Font tiếng việt) sẽ 

tự động copy vào các thư mục quy định của Microstation. 

 Bản đồ ở tỷ lệ nào thì có những tệp chuẩn tương ứng cho tỷ lệ đó để xác định 

môi trường số hóa nhằm tránh nhầm lẫn về cách sử dụng các ký hiệu, cách đặt các ghi 

chú, đúng lớp quy định.  

 Khi số hóa, biên tập bản đồ hiện trạng, quy hoạch sử dụng đất của tỷ lệ nào cần 

chọn Workspace tương ứng trên hộp thoại Microsation Manager. 

 

Hình 4.1. Chọn Workspace phù hợp cho bản đồ hiện trạng sử dụng đất 

Bảng 5.1. Workspace và tỷ lệ bản đồ HTSDĐ tương ứng 
 

Workspace Tỷ lệ bản đồ 

HT_QH1 1/ 1000 

HT_QH2 1/ 2000 

HT_QH5 1/ 5000 

HT_QH10 1/ 10 000 

HT_QH25 1/ 25 000 

HT_QH50 1/ 50 000 

HT_QH100 1/ 100 000 

HT_QH250 1/ 250 000 

HT_QH1TR 1/ 1000 000 

Khi số hóa, biên tập bản đồ tỷ lệ 

1/100.000 chọn Workspace ht_qh100 
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4.1.3. Nội dung thể hiện trên bản đồ hiện trạng sử dụng đất 

 Nội dung thể hiện trên bản đồ hiện trạng sử dụng đất gồm: 

 - Cơ sở toán học gồm khung bản đồ, lưới kilômét, lưới kinh vĩ tuyến, chú dẫn, 

trình bày ngoài khung và các nội dung có liên quan. 

 - Biên giới quốc gia và đường địa giới hành chính các cấp: Đối với bản đồ hiện 

trạng sử dụng đất của vùng kinh tế - xã hội dạng giấy chỉ thể hiện đến địa giới hành 

chính cấp huyện; bản đồ hiện trạng sử dụng đất của cả nước dạng giấy chỉ thể hiện đến 

địa giới hành chính cấp tỉnh. Khi đường địa giới hành chính các cấp trùng nhau thì 

biểu thị đường địa giới hành chính cấp cao nhất. 

 Trường hợp không thống nhất đường địa giới hành chính giữa thực tế đang 

quản lý với hồ sơ địa giới hành chính thì trên bản đồ hiện trạng sử dụng đất phải thể 

hiện đường địa giới hành chính thực tế đang quản lý. Trường hợp đang có tranh chấp 

về địa giới hành chính thì trên bản đồ hiện trạng sử dụng đất phải thể hiện đường địa 

giới hành chính khu vực đang tranh chấp theo ý kiến của các bên liên quan. 

 - Ranh giới các khoanh đất của bản đồ hiện trạng sử dụng đất cấp xã thể hiện 

ranh giới và ký hiệu các khoanh đất theo chỉ tiêu kiểm kê đất đai. Ranh giới các 

khoanh đất của bản đồ hiện trạng sử dụng đất cấp huyện, cấp tỉnh, các vùng kinh tế - 

xã hội và cả nước thể hiện theo các chỉ tiêu tổng hợp; được tổng hợp, khái quát hóa 

theo quy định biên tập bản đồ hiện trạng sử dụng các cấp. 

 - Địa hình: Thể hiện đặc trưng địa hình của khu vực (không bao gồm phần địa 

hình đáy biển, các khu vực núi đá và bãi cát nhân tạo) và được biểu thị bằng đường 

bình độ, điểm độ cao và ghi chú độ cao. Khu vực núi cao có độ dốc lớn chỉ biểu thị 

đường bình độ cái và điểm độ cao đặc trưng. 

 - Thủy hệ và các đối tượng có liên quan phải thể hiện gồm biển, hồ, ao, đầm, 

phá, thùng đào, sông, ngòi, kênh, rạch, suối. Đối với biển thể hiện theo đường mép 

nước biển triều kiệt trung bình trong nhiều năm; trường hợp chưa xác định được 

đường mép nước biển triều kiệt trung bình trong nhiều năm thì xác định theo đường 

mép nước biển triều kiệt tại thời điểm kiểm kê để thể hiện. Các yếu tố thủy hệ khác có 

bờ bao thì thể hiện theo chân phía ngoài đường bờ bao (phía đối diện với thủy hệ); 

trường hợp thủy hệ tiếp giáp với có đê hoặc đường giao thông thì thể hiện theo chõn 

mỏi đắp của đê, đường phớa tiếp giỏp với thủy hệ; trường hợp thủy hệ không có bờ 

bao và không tiếp giáp đê hoặc đường giao thì thể hiện theo mép đỉnh của mái trượt 

của thủy hệ. 

 - Giao thông và các đối tượng có liên quan thể hiện phạm vi chiếm đất của đường 

sắt, đường bộ và các công trình giao thông trên hệ thống đường đó theo yêu cầu sau: 

 + Bản đồ hiện trạng sử dụng đất cấp xã thể hiện tất cả các loại đường giao 

thông các cấp, kể cả đường trục chính trong khu dân cư, đường nội đồng, đường mòn 

tại các xã miền núi, trung du. 
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 + Bản đồ hiện trạng sử dụng đất cấp huyện đường bộ biểu thị từ đường liên xã 

trở lên; khu vực miền núi phải biểu thị cả đường đất nhỏ. 

 + Bản đồ hiện trạng sử dụng đất cấp tỉnh biểu thị từ đường liên huyện trở lên; 

 + Trên bản đồ hiện trạng sử dụng đất vùng kinh tế - xã hội và cả nước biểu thị 

từ đường tỉnh lộ trở lên, khu vực miền núi phải biểu thị cả đường liên huyện. 

 - Các yếu tố kinh tế, xã hội. 

 - Các ghi chú, thuyết minh. 

4.2. Sử dụng FrameHT xây dựng bản đồ hiện trạng sử dụng đất 

4.2.1. Giới thiệu FrameHT 

 Phần mềm FrameHT là phần mềm hỗ trợ xác định các loại hình sử dụng đất 

phục vụ thành lập bản đồ hiện trạng sử dụng đất. Theo quy định hiện hành, sản phẩm 

bản đồ hiện trạng sử dụng đất dạng số được lưu trữ dưới dạng file DGN của phần mềm 

Microstation. 

 Để hỗ trợ công tác biên tập bản đồ hiện trạng sử dụng đất dưới dạng file DGN, 

dự án đã phát triển một mô đun của phần mềm FrameHT chạy trong môi trường 

Microstation. 

 a. Cài đặt và khởi động FrameHT 

 Phần mềm FrameHT được đóng gói dưới dạng file nén, ngừoi sử dụng tạo thư 

mục tùy chọn. Ví dụ c:\frameht\; d:\frameht\ sau đó giải nén toàn bộ các file trong file 

nén vào thư mục này. 

 Để chạy phần mềm, mở file bản đồ cần biên tập bằng Microstation, sau đó mở 

ứng dụng bằng cách cách nhập dòng lệnh “Mdl load c:\frameht\frameht” vào cửa sổ 

lệnh Command Window. Khi đó trong Microstation xuất hiện cửa sổ giao diện như sau: 

 

Hình 5.2. Giao diện FrameHT 
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 b. Các chức năng chính 

Phần mềm FrameHT trong Microstation cung cấp các chức năng chính sau: 

 - Quản lý các lớp thông tin của bản đồ hiện trạng sử dụng đất theo đúng quy 

phạm hiện hành. 

 - Tự động tạo vùng, tô màu, mẫu ký hiệu cho từng loại hình sử dụng đất theo 

đúng quy phạm yêu cầu bằng sử dụng mô hình topology. 

 - Tự động tạo khung bản đồ hiện trạng sử dụng đất theo đúng quy phạm. 

 - Cung cấp các chức năng khái quát hóa các đối tượng bản đồ hỗ trợ phương 

pháp thành lập bản đồ hiện trạng sử dụng đất cấp huyện từ bản đồ hiện trạng sử dụng đất 

cấp xã. 

4.2.2. Biên tập lớp hiện trạng sử dụng đất 

 Dựa theo lớp đường ranh giới các đối tượng hiện trạng sử dụng đất, các đối 

tượng vùng hiện trạng sử dụng đất sẽ được thành lập. Dựa theo lớp ký hiệu loại hình 

hiện trạng sử dụng đất sẽ xác định màu tô, mẫu trải theo đúng quy định. 

 FrameHT hỗ trợ xây dựng lớp hiện trạng sử dụng đất cung cấp các chức năng 

nhằm giảm tối đa các thao tác bản đồ, cũng như những sai sót để có thể nhanh chóng 

tạo ra lớp vùng đối tượng hiện trạng sử dụng đất theo đúng quy định. 

 Phần mềm FrameHT sử dụng cấu trúc topology để tự động đóng vùng cũng như 

tô màu lớp hiện trạng hết sức nhanh chóng và chính xác, hiệu quả trong cả hai trường 

hợp tạo với lớp vùng hiện trạng sử dụng đất cũng như biên tập, chỉnh sửa lại lớp này. 

 Quá trình biên tập lớp hiện trạng sử dụng đất gồm các bước: 

 - Chuẩn bị bản đồ nền. 

- Chuẩn hóa cơ sở dữ liệu theo quy định kỹ thuật của bản đồ hiện trạng sử 

dụng đất. 

+ Biên tập các đường ranh giới các đối tượng hiện trạng sử dụng đất.  

 + Biên tập các ký hiệu hiện trạng sử dụng đất. Lưu ý tâm của các đối tượng này 

phải nằm trong vùng của đối tượng hiện trạng sử dụng đất mà nó mô tả. 

 - Sử dụng chức năng mrfclean, mrfflag  để sửa lỗi, khép kín các đường ranh 

giới trên bản  đồ. 

 - Chạy tạo vùng hiện trạng sử dụng đất 

+ Xác định level các lớp thông tin tham gia làm đường ranh giới cho các đối 

tượng hiện trạng sử dụng đất. 

+ Tạo lớp đối tượng hiện trạng sử dụng đất dạng vùng ấn <Tạo vùng HT> 

 + Chọn <Tạo lại Topo> nếu muốn tự động tạo lại mô hình topology, đóng 

vùng, tạo topology cho lớp đối tượng hiện trạng sử dụng đất. Sau khi đóng vùng, phần 

mềm tự tạo ra lớp vùng hiện trạng với mầu, kiểu trải theo quy định. 
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 + Không chọn <Tạo lại Topo> nếu không thay đổi về đường bao, chỉ thay đổi về 

ký hiệu hiện trạng sử dụng đất. Chức năng này hiệu quả trong việc chỉnh sửa, thay đổi 

lại hiện trạng sử dụng đất mà không ảnh hưởng đến đường bao của các đối tượng vùng 

hiện trạng. 

 

 Hình 5.3. Biên tập các thông tin bản đồ hiện trạng sử dụng đất 

 Sau khi chạy xong, bản đồ hiện trạng sử dụng đất bổ sung thêm 2 lớp (level): 

 - Lớp vùng tô màu hiện trạng 

 - Lớp vùng tô ký hiệu trải nền hiện trạng 

 Kết quả chạy tạo lớp hiện trạng sử dụng đất: 

 

Hình 5.4. Tạo lớp hiện trạng sử dụng đất 

Tạo topology, đóng 

vùng, tô màu tự động các 

đối tượng HTSDĐ 
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 Đồng thời, song song với tạo ra lớp vùng hiện trạng sử dụng đất, phần mềm 

tổng hợp diện tích cho biểu đồ cơ cấu đất đai theo diện tích các đối tượng vùng hiện 

trạng đất được tính ra. 

 

Hình 5.5. Tính diện tích cho biểu đồ cơ cấu đất đai 

 Tuy nhiên, khi các lớp mới được tạo ra do đối tượng vùng và phủ màu nên che 

khuất các đối tượng bên dưới. Để giải quyết vấn đề này, phần mềm cung cấp công cụ 

chuyển tất cả các đối tượng của một lớp lên trên cùng hoặc chuyển xuống cuối cùng. 

 Vào level cần đưa lên đầu (ví dụ: 21) hoặc level xuống dưới cùng (mang giá trị 

âm, ví dụ -30) sau đó ấn <Lên đầu> để phần mềm thực hiện. Ví dụ sau đưa toàn bộ 

level 30 (vùng hiện trạng sử dụng đất ) xuống dưới cùng. 

 

Hình 5.6. Công cụ đưa level chứa nhãn lên đầu 

 Kết quả của việc chuyển lớp 30 xuống dưới: 

Tự động tính 

diện tích cho 

biểu đồ cơ cấu 

đất đai 

 

Chọn level để hiển 

thị trên cùng hoặc 

dưới cùng. 
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Hình 5.7. Biên tập nhãn vùng hiện trạng sử dụng đất 

4.2.3. Biên tập bản đồ hiện trạng sử dụng đất 

4.2.3.1. Biên tập khung 

 FrameHT cung cấp chức năng tạo khung cho bản đồ hiện trạng sử dụng đất theo 

đúng quy định. Cách tạo khung như sau: 

 - Lựa chọn loại khung cấp xã, huyện tỉnh. 

 - Chọn tỷ lệ bản đồ. FrameHT cung cấp các tỷ lệ từ 1:1.000 đến 1:25.000. 

 - Đưa vào thông tin về đơn vị hành chính, nguồn tài liệu, đơn vị xây dựng. 

 - Chọn phạm vi của khung bằng cách xác định tọa độ trước hoặc chọn bằng fence. 

 - Nhấn <Fence>, trên giao diện xuất hiện tọa độ góc trái dưới và góc phải trên.  

 - Nhấn <Vẽ khung> để vẽ khung bản đồ hiện trạng sử dụng đất. 

 

Hình 5.8. Biên tập khung bản đồ hiện trạng sử dụng đất 
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Hình 5.9. Biên tập khung bản đồ 

4.2.3.2. Biên tập các đối tượng khác 

 a. Biểu đồ cơ cấu sử dụng đất 

 Sau khi tạo ra lớp vùng hiện trạng sử dụng đất, phần mềm tổng hợp diện tích 

cho biểu đồ cơ cấu đất đai theo diện tích các đối tượng vùng hiện trạng đất được tính 

ra. Tiến hành biên tập biểu đồ cơ cấu sử dụng đất theo mẫu. 

 

Hình 5.10. Mẫu biểu đồ cơ cấu sử dụng đất 

 b. Bảng chú dẫn 

 Dựa vào các đối tượng và nội dung thể hiện trên bản đồ, tiến hành biên tập bảng 

chú giải dựa theo mẫu kí hiệu bản đồ quy định của bản đồ hiện trạng sử dụng đất.  
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Hình 5.11. Biên tập bảng chú dẫn 

 c. Sơ đồ vị trí:  

 Dựa vào bản đồ tổng thể của khu vực thành lập bản đồ hiện trạng sử dụng đất 

để biên tập sơ đồ vị trí của khu vực đó. 

 

Hình 5.12. Biên tập sơ đồ vị trí 

 d. Kim chỉ hướng Bắc 

 Đưa cell kí hiệu kim chỉ hướng Bắc trong thư viện chứa cell lên bản đồ  

 

Hình 5.13. Kí hiệu kim chỉ hướng Bắc 
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 e. Mẫu xác nhận và xét duyệt bản đồ hiện trạng sử dụng đất 

 Tiến hành biên tập mẫu xác nhận và xét duyệt bản đồ theo đơn vị hành chính 

bản đồ hiện trạng được thành lập. 

 

Hình 5.14. Mẫu xác nhận và ký duyệt bản đồ hiện trạng sử dụng đất cấp xã 
 

 

Hình 5.15. Mẫu bản đồ hiện trạng sử dụng đất biên tập hoàn chỉnh 
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BÀI THỰC HÀNH 4 

Bài tập 1:  

Tạo và biên tập 1 bản đồ hiện trạng sử dụng đất ở tỷ lệ 1:2000 với ít nhất 10 

khoanh đất có điều kiện như sau:  

- Diện tích mỗi khoanh đất tối thiểu là 100 m2, tối đa là 10 ha  

- Có ít nhất 5 MĐSD đất khác nhau, trong đó bắt buộc có đất ODT hoặc ONT, đất 

LUC  

HƯỚNG DẪN THỰC HÀNH 

1. Tạo file mới 

Tạo file Microstation mới trong thư mục của Sinh viên đặt tên file là 

Hientrang_TenSV. Sử dụng seed file là vn2d.dgn. 

Trước khi mở file, Chọn Workspace làm bản đồ hiện trạng tương ứng với tỷ lệ 

bản đồ 1:2000 là ht_qh2  

 

2. Chuyển bảng màu hiện trạng 

 Chọn Setting/Color Table. Xuất hiện hộp thoại > Chọn File/Open > Bảng màu 

ht_qh1 > Bấm Attach.  
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4.  Chọn lớp thông tin đối tượng cần biên tập trong công cụ MFSC Feature 

Collection để các đối tượng trên bản đồ  

 

- Vẽ thửa đất hiện trạng 

+ Chọn lớp thông tin vẽ ranh giới thửa đất hiện trạng: Chọn Ranh giới > RG_05  

+ Sử dụng công cụ Place Line vẽ các khoanh đất trên bản đồ theo đúng điều kiện.  

- Đưa các MĐSD đất vào khoanh đất  

+ Chọn lớp thông tin mã loại đất hiện trạng: Chọn Loại đất > LD_04  

+ Sử dụng công cụ Place Text vẽ các MĐSD đất trên bản đồ theo đúng điều kiện. 

5. Tạo topology cho các thửa đất 

 - Khởi động Famis 

- Quét sửa lỗi Clean (Set level 5)  

- Sửa lỗi Flag  

- Tạo vùng (Level tạo: 5)  

6. Tạo vùng hiện trạng  

  - Khởi động FramHT (Menu Utilites/MDL Application. Xuất hiện hộp thoại. 

Chọn <Browse> tìm đường dẫn đến thư mục C:\frameht\frameht.ma 

-  Nhập <Level bao> : 5 ;  <Nhãn>: 33  

- Bấm <Tạo vùng > để chạy vùng hiện trạng 

- Bấm <Lên đầu> để đưa nhãn lên trên màu hiện trạng  

7. Tạo khung bản đồ hiện trạng 

 - Dùng Place Fence bao quanh khu vực bản đồ cần tạo khung. 

 - Trong hộp thoại tạo bản đồ HTSDĐ. 
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 + Chọn loại khung: <Xã>. 

 + Chọn tỷ lệ: 1/2000. 

 + Nhập tên đơn vị hành chính: Xã, Huyện, Tỉnh. 

 - Nhấn <Fence> để đưa tọa độ các góc khung. 

 - Nhấn <Vẽ khung>. 

8. Biên tập biểu đồ cơ cấu đất đai  

- Chọn lớp thông tin biên tập: Chọn Trình bày > TB_19  

 

- Đổ màu bảng biểu đồ cơ cấu bằng công Create Region:  

+ Chọn Method: Flood ; Tích chọn Keep Original  

+ Fill Type: Outline  

+ Fill color: (Đất nông nghiệp = 1; Đất phi nông nghiệp = 39; Đất chưa sử dụng 

= 97)  

- Chọn toàn bộ bảng cơ cấu. Edit > Group > Di chuyển vào trong khung bản đồ  

9. Đưa kim chỉ hướng Bắc – Nam vào bản đồ  

- Element/Cell. Chọn Attach. Mở Cell ht_qh1-5 

- Kích đúp chuột trái chọn cell Chỉ hướng Bắc đưa ra bản đồ  
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Bài tập 2:  

Xây dựng 1 tờ bản đồ Hiện trạng sử dụng đất tỷ lệ 1/2000 trên cơ sở tờ bản đồ 

địa chính số 6,7 của Phường Kim Long. 

HƯỚNG DẪN THỰC HÀNH 

1. Tạo file  

- Khởi động Microstation. 

- Từ cửa sổ MicroStation Manager:  

+ Chọn File/New, xuất hiện hộp thoại Create Design File:  

+ Chọn Seed File: Bấm chuột vào Select, xuất hiện hộp thoại Select Seed File, Chọn 

Seed file là file: C:WIN32APP\ustation\wsmod\default\seed\vn2d.dgn, chọn OK. 

+ Gõ tên File mới cần tạo là <Hientrang67KimLong>. Chọn OK.  

- ChọnWorkspace: ht_qh2. 

- Chọn Style: Comand window. 

 

2. Tiến hành gộp các tờ bản đồ địa chính theo yêu cầu bài tập. 

 Từ hộp thoại Microstation Manager. Chọn File\Merge. Xuất hiện hộp thoại 

Merge. 

- Chọn <Select> ở ô File to Merge. Xuất hiện hộp thoại Select file to merge. 

- Tìm đường dẫn đến thư mục chứa file cần gộp (to06, to07 của phường Kim 

Long). Kích đúp chuột vào các tờ bản đồ địa chính để thêm. 

- Chọn <Done> để đóng hộp thoại 
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- Chọn <Select> ở ô Merg Into. Xuất hiện hộp thoại Select Destination File. Tìm 

đường dẫn đến file đã tạo ở mục 1 (Hien trang 6,7 Kim Long.dgn) 

 

 - Chọn <Merge> để tiến hành gộp file. 

 - Mở file Hien trang 6,7 Kim Long.dgn để xem kết quả gộp file. 

 

3. Chuyển bảng màu của bản đồ theo đúng quy phạm 

 - Menu Setting/Color table. Xuất hiện hộp tho Color table. 

 - File/Open. Chọn ht_qh1.tbl. Chọn Ok.  

 - Chọn Attach để chuyển bảng màu. 
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4. Xóa những đối tượng không cần thiết trên bản đồ địa chính 

Mục đích chỉ giữ lại các đối tượng tham gia tạo lớp bản đồ hiện trạng sử dụng đất. 

Ví dụ: lớp ranh giới thửa đất, Mục đích sử dụng đất, lớp thủy văn, tên đường, tên sông, 

địa danh, ranh giới hành chính…. (Tùy vào từng bản đồ địa chính cụ thể) 

+ Menu Edit/Select By Atrributes 

+ Tích bỏ chọn các level 10,13, 31, 46 

  

+ Chọn <Excute> để thực hiện lệnh 

+ Dùng công cụ Delete Element để xóa các đối tượng đã chọn 

 

- Tiếp tục xóa số thửa và diện tích thửa đất, chỉ giữ lại mã loại đất: 
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+ Menu Edit/Select By Atrributes. Xuất hiện hộp thoại Attributes. 

+ Chọn level 13. Excute. 

+ Chọn công cụ Drop của Microstation. Sau đó bấm chuột trái vào điểm bất kỳ 

trên bản đồ để thực hiện lệnh bẻ gãy liên kết nhóm của đối tượng trên level 13.  

 

+ Tiếp tục Menu Edit/Select By Atrributes. Xuất hiện hộp thoại Attributes. Chọn 

level 13 

+ Menu Setting\Text. Xuất hiện hộp thoại Select by text. 

+ Tích chọn <String>, nhập 0 để xóa các kí tự có chứa số 0 trên bản đồ. 

 

+ Chọn Excute để thực hiện lệnh 

+ Chọn công cụ Delete Element để xóa các đối tượng đã chọn 

+ Tiếp tục làm tương tự với các số từ 1 đến 9 để xóa toàn bộ các kí tự có chứa số 

trên bản đồ.  

+ Sau khi xóa hết các đối tượng chữ số. Tiếp tục vào Menu Setting\Text. Xuất hiện 

hộp thoại Select by text. Bỏ dấu tích chọn ở ô <String> để hủy tùy chỉnh này. 

5. Gộp các thửa có cùng mục đích sử dụng đất.  

 - Sử dụng công cụ fence để chọn các đường ranh giới thửa đất chung cần xóa.  

  + Fence type: Shape. 

  + Fence mode: Overlap. 

 

 - Dùng chức năng Delete Fence Contents để xóa các đường ranh giới đã chọn. 

6. Chuẩn hóa lớp các lớp đường ranh giới đúng quy phạm bản đồ hiện trạng SDĐ 

 - Chuẩn hóa lớp đường ranh giới thửa đất. 
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 + Menu Edit/Select by attributes.  

 + Chọn level 10. Chọn Execute. 

 

 - Sử dụng công cụ FC Select Feature. Xuất hiện hộp thoại Feature Collection. 

  + Category Name: Chọn <Ranh giới>. 

  + Feature Code: RG-05. 

  + Feature name: Ranh giới loại đất hiện trạng. 

 

 - Chọn OK. 

 - Chọn công cụ Change Element Attributes. Tích chọn các thuộc tính thay đổi. 

Nhấn phím Data lên bản đồ để xác nhận lệnh. 



  

106 

 

 - Tiến hành thao tác ương tự với các loại dữ liệu khác: 

+ Lớp thủy văn trên level 31, chuẩn hóa sang lớp thông tin Thủy văn > TV-01: 

Thủy văn 1 nét 0,2 ht 

+ Lớp ký hiệu sử dụng đất trên level 13,  chuẩn hóa sang Loại đất > LĐ-04: Mã 

loại đất hiện trạng 

+ Lớp ranh giới hành chính cấp xã trên level 46, chuẩn hóa sang Ranh giới > RD-

04: Địa giới cấp xã xác định 

7. Chuẩn hóa vị trí nhãn MĐSD đất 

 - Dùng chuột để di chuyển vị trí các nhãn MĐSD đất ở phía ngoài các thửa đất 

nhỏ vào bên trong. Có thể thu nhỏ các nhãn MĐSD để đảm bảo nhãn không nằm ngoài 

thửa đất. 

   

8. Sửa lỗi bản đồ và chạy tạo vùng 

a. Sửa lỗi bản đồ 

 - Khởi động Famis: Nhập dòng lệnh vào cửa sổ lệnh Comand Window: MDL 

Load C:\famis\famis 

 - Menu Cơ sở dữ liệu bản đồ/Quản lý bản đồ/Kết nối với CSDL 

 - Thiết lập thông số tìm và sửa lỗi cho level 4,5,22 trên bản đồ hiện trạng  

 - Chạy topology cho các thửa đất. Nhập level tạo vùng là 4,5.22. 

b. Chạy tạo vùng hiện trạng sử dụng đất 

 - Khởi động Frameht: Nhập dòng lệnh vào cửa sổ lệnh Command Window: 

Mdl load c:\frameht\frameht 

 - Xuất hiện hộp thoại. 
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 + Xác định các level bao: Nhập 4,5.22. 

 +  Nhãn: 33. 

 + Vùng: 30. 

 - Nhấn <Tạo vùng HT> để đổ màu cho các thửa đất. 

 - Nhấn <Lên đầu> để đưa các đường line, nhãn lên trên lớp vùng hiện trạng. 

 

9. Biên tập khung 

 - Dùng Place Fence bao quanh khu vực bản đồ cần tạo khung. 

 - Trong hộp thoại tạo bản đồ HTSDĐ. 

 + Chọn loại khung: <Xã>. 

 + Chọn tỷ lệ: 1/2000. 

 + Nhập tên đơn vị hành chính: Xã, Huyện, Tỉnh. 

 - Nhấn <Fence> để đưa tọa độ các góc khung. 

 - Nhấn <Vẽ khung>. 
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10. Biên tập các đối tượng khác 

 a. Biểu đồ cơ cấu sử dụng đất 

 Sau khi tạo ra lớp vùng hiện trạng sử dụng đất, phần mềm tổng hợp diện tích 

cho biểu đồ cơ cấu đất đai theo diện tích các đối tượng vùng hiện trạng đất được tính 

ra. Tiến hành biên tập biểu đồ cơ cấu sử dụng đất như sau: 

 - Dùng công cụ Create Region để tô màu cho biểu đồ cơ cấu: 

  + Vùng “Đất nông nghiệp”: Fill color = 1. 

  + Vùng “Đất phi nông nghiệp”: Fill color = 39. 

  + Vùng “Đất chưa sử dụng”: Fill color =97. 

 - Tiến hành biên tập các đối tượng dạng text: 

  + Thêm dấu % sau phần trăm diện tích. 

  + Thêm đoạn thẳn nằm ngang giữa diện tích và phần trăm diện tích. 

  + Chỉnh sửa tiêu đề bảng cơ cấu. 

 - Copy biểu đồ cơ cấu vào trong khung bản đồ hiện trạng, nằm phía dưới bản đồ. 
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 b. Bảng chú dẫn 

 Dựa vào các đối tượng và nội dung thể hiện trên bản đồ, tiến hành biên tập bảng 

chú giải dựa theo mẫu kí hiệu bản đồ quy định của bản đồ hiện trạng sử dụng đất. 

 

 d. Kim chỉ hướng Bắc 

 Đưa kí hiệu kim chỉ hướng Bắc lên bản đồ như sau: 

 - Từ menu Element/Cells: Xuất hiện hộp thoại Cells. 

 - Tìm kí hiệu kim chỉ hướng Bắc bản đồ. 

 

 - Kích đúp chuột để đưa cell chỉ hướng Bắc lên bản đồ. 

 e. Mẫu xác nhận và xét duyệt bản đồ hiện trạng sử dụng đất 

 Tiến hành biên tập mẫu xác nhận và xét duyệt bản đồ theo đơn vị hành chính 

bản đồ hiện trạng được thành lập. 
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 Lưu ý: Khi đưa biểu đồ cơ cấu, bảng chú dẫn, kết quả xét duyệt, sơ đồ vị trí, 

kim chỉ hướng bắc vào bản đồ, phải sử dụng công cụ Modify để xóa các đường lưới 

kilômét nằm chồng lên các đối tượng đó. 
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PHỤ LỤC  

PHỤ LỤC SỐ 1 

QUY ĐỊNH PHÂN LỚP CÁC YẾU TỐ NỘI DUNG TRÊN BẢN ĐỒ HTSDĐ VÀ 

BẢN ĐỒ QHSDĐ 

(Trích: Ký hiệu Bản đồ hiện trạng sử dụng đất và bản đồ quy hoạch sử dụng đất- Bộ 

TN&MT, 2007) 

TT Tên đối tượng 

HƯỚNG DẪN SỬ DỤNG KÝ HIỆU TRONG 

PHẦN MỀM MICROSTATION 

Lớp 

Level 

Màu 

Color 

Tên, kiểu ký hiệu 

Linestyle cell 

Text 

Tên 

Fonts 

Số 

Fon

ts 

1 Địa giới, ranh giới       

2 Biên giới quốc gia xác định 1 0 BgQGxd    

3 Biên giới quốc gia chưa xác định 1 215 BgQGcxd    

4 Địa giới hành chính cấp tỉnh xác định 2 0 RgTxd    

5 Địa giới hành chính cấp tỉnh chưa xác định 2 215 RgTcxd    

6 Địa giới hành chính cấp huyện xác định 3 0 RgHxd    

7 Địa giới hành chính cấp huyện chưa xác định 3 215 RgHcxd    

8 Địa giới hành chính cấp xã xác định 4 0 RgXxd    

9 Địa giới hành chính cấp xã chưa xác định 4 215 RgXcxd    

10 Ranh giới khoanh đất hiện trạng 5 0 RgLdat    

11 Ranh giới khoanh đất quy hoạch 6 203 RgLdat    

12 Ranh giới các đơn vị sử dụng đất hiện trạng 7 0 RgSD    

13 Ranh giới các đơn vị sử dụng đất quy hoạch 7 203 RgSD    

14 Đối tượng kinh tế, văn hóa, xã hội       

15 UBND cấp tỉnh hiện trạng 8 0  UB.T   

16 UBND cấp tỉnh quy hoạch 8 203  UB.T   

17 UBND cấp huyện hiện trạng 8 0  UB.H   

18 UBND cấp huyện quy hoạch 8 203  UB.H   

19 UBND cấp xã hiện trạng 8 0  UB.X   

20 UBND cấp xã quy hoạch 8 203  UB.X   

21 Sân bay hiện trạng 9 0  SB   

22 Sân bay quy hoạch 9 203  SB   

23 Đình, chùa, miếu, đền... hiện trạng 9 0  CHUA   
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24 Đình, chùa, miếu, đền... quy hoạch 9 203  CHUA   

25 Nhà thờ hiện trạng 9 0  NT   

26 Nhà thờ quy hoạch 9 203  NT   

27 Đài phát thanh, truyền hình hiện trạng 9 0  PTTH   

28 Đài phát thanh, truyền hình quy hoạch 9 203  PTTH   

29 Sân vận động hiện trạng 9 0  SVD   

30 Sân vận động quy hoạch 9 203  SVD   

31 Trường học hiện trạng 9 0  TH   

32 Trường học quy hoạch 9 203  TH   

33 Bệnh viện, trạm y tế hiện trạng 9 0  BVTX   

34 Bệnh viện, trạm y tế quy hoạch 9 203  BVTX   

35 Bưu điện hiện trạng 9 0  BD   

36 Bưu điện quy hoạch 9 203  BD   

37 Đường giao thông và đối tượng liên quan       

38 Đường sắt hiện trạng 10 0 DgSat    

39 Đường sắt quy hoạch 10 203 DgSat    

40 Quốc lộ nửa theo tỷ lệ hiện trạng 11 0, 214 DgQlo    

41 Quốc lộ nửa theo tỷ lệ quy hoạch 11 203,214 DgQlo    

42 Đường tỉnh nửa theo tỷ lệ hiện trạng 13 0,254 DgT    

43 Đường tỉnh nửa theo tỷ lệ quy hoạch 13 203,254 DgT    

44 Đường hầm hiện trạng 15 0 DgHam    

45 Đường hầm quy hoạch 15 203 DgHam    

46 Đường huyện nửa theo tỷ lệ hiện trạng 16 0 DgH    

47 Đường huyện nửa theo tỷ lệ quy hoạch 16 203 DgH    

48 Đường liên xã nửa theo tỷ lệ hiện trạng 17 0 DgLxa    

49 Đường liên xã nửa theo tỷ lệ quy hoạch 17 203 DgLxa    

50 Đường đất nhỏ nửa theo tỷ lệ ht 18 0 DgXa    

51 Đường đất nhỏ nửa theo tỷ lệ qh 18 203 DgXa    

52 Đường mòn 19 0 DgMon    

53 Cầu sắt hiện trạng 20 0 CauSat    

54 Cầu sắt quy hoạch 20 203 CauSat    

55 Cầu bê tông hiện trạng 20 0 CauBT    

56 Cầu bê tông quy hoạch 20 203 CauBT    

57 Cầu phao hiện trạng 20 0 CauPhao    

58 Cầu phao quy hoạch 20 203 CauPhao    



  

114 

59 Cầu treo hiện trạng 20 0 CauTreo    

60 Cầu treo quy hoạch 20 203 CauTreo    

61 Cầu tre, gỗ dân sinh 20 0 CauTam    

62 Ghi chú đường giao thông 20 0   Theo mẫu  

63 Thuỷ hệ và các đối tượng liên quan       

64 Thủy văn vẽ theo tỷ lệ 21 207 Tv2nét    

65 Thủy văn vẽ nửa theo tỷ lệ 22 207 Tv1nét    

66 Tên biển 23 207   VHtimebi 195 

67 Tên vịnh 23 207   Theo mẫu  

68 Tên cửa biển, cửa sông 23 207   Theo mẫu  

69 Tên hồ, ao, sông, suối, kênh, mương 23 207   Theo mẫu  

70 Ghi chú tên quần đảo, bán đảo 43 0   VHariali 186 

71 Ghi chú tên đảo 43 0   Theo mẫu  

72 Ghi chú hòn đảo 43 0   Vncenti 208 

73 Ghi chú tên mũi đất 43 0   Vncenti 208 

74 Đê vẽ nửa theo tỷ lệ hiện trạng 22 0 DeNTL    

75 Đê vẽ nửa theo tỷ lệ quy hoạch 22 203 DeNTL    

76 Đập hiện trạng 24 0 Dap    

77 Đập quy hoạch 24 203 Dap    

78 Cống hiện trạng 24 0 Cong    

79 Cống quy hoạch 24 203 Cong    

80 Địa hình       

81 Bình độ và độ cao bình độ cái 26 206 BdCai  Vntimei 190 

82 Bình độ cơ bản 27 206 BdCoBan    

83 Điểm độ cao, ghi chú điểm độ cao 29 0  CDDC Vncouri 196 

84 Ghi chú dải núi, dãy núi 29 0   VHariali 186 

85 Ghi chú tên núi 29 0   Vnariali 182 

86 Trình bày       

87 Tên Thủ đô 35 0   VHtimeb 193 

88 Tên tỉnh, thành phố trực thuộc trung ương 35 0   Vhtimeb 193 

89 Tên thành phố trực thuộc tỉnh 36 0   Vhtimeb 193 

90 Tên tỉnh 36 0   VHarial 184 

91 Tên thị xã 36 0   Vhtimeb 193 

92 Tên tỉnh lị 36 0   Vhtimeb 193 

93 Tên quận, huyện 36 0   Vharialb 203 
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94 Tên huyện lị 37 0   Vhtimeb 193 

95 Tên xã, phường, thị trấn 37 0   Theo mẫu  

96 Tên thôn xãm, ấp, bản, mường 38 0   Theo mẫu  

97 Ghi chú tên riêng 39 0   Vnariali 182 

98 Khung bản đồ 61 0     

99 Lưới kinh, vĩ tuyến và lưới kilômét 62 207     

100 Giá trị lưới kinh, vĩ tuyến và lưới kilômét 62 0   univcd 214 

101 Tên bản đồ 59 0   VHtimeb 193 

102 Tỷ lệ bản đồ 59 0   VHtimeb 193 

103 Tên quốc gia giáp ranh 58 0   VHtimeb 193 

104 Tên tỉnh giáp ranh 58 0   VHarialb 185 

105 Tên huyện giáp ranh 58 0   VHaial 184 

106 Tên xã giáp ranh 58 0   VHaial 184 

107 Nguồn tài liệu sử dụng 57 0   VHaial 184 

108 Tài liệu sử dụng 57 0   Vntime 188 

109 Đơn vị xây dựng 57 0   VHaial 184 

110 Tên đơn vị xây dựng 57 0   Vntimeb 189 

111 Ghi chú trong bản chú dẫn, biểu đồ 56 0   Theo mẫu  

112 Ghi chú ký duyệt 56 0   Theo mẫu  

113 Loại đất       

114 Màu loại đất 30      

115 Pattern loại đất hiện trạng 31 0     

116 Pattern  loại đất quy hoạch 32 203     

117 Mã sử dụng đất hiện trạng 33 0   VHvan 202 

118 Mã sử dụng đất quy hoạch 34 203   VHvan 202 
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PHỤ LỤC SỐ 2 

QUY ĐỊNH MÀU LOẠI ĐẤT TRÊN BẢN ĐỒ  HIỆN TRẠNG SỬ DỤNG ĐẤT 

VÀ BẢN ĐỒ QUY HOẠCH SỬ DỤNG ĐẤT 

(Trích: Ký hiệu Bản đồ hiện trạng sử dụng đất và bản đồ quy hoạch sử dụng đất - Bộ 

TN&MT, 2007) 

Loại đất 
Mã 

SDĐ 

Thông số màu loại đất 

Số màu Red Green Blue 

 1. Đất nông nghiệp NNP 1 255 255 100 

 1.1. Đất sản xuất nông nghiệp SXN 2 255 252 110 

 1.1.1. Đất trồng cây hàng năm CHN 3 255 252 120 

 1.1.1.1. Đất trồng lúa LUA 4 255 252 130 

 1.1.1.1.1. Đất chuyên trồng lúa nước LUC 5 255 252 140 

1.1.1.1.2. Đất trồng lúa nước còn lại LUK 6 255 252 150 

1.1.1.1.3. Đất trồng lúa nương LUN 7 255 252 180 

1.1.1.2. Đất cỏ dùng vào chăn nuôi COC 8 230 230 130 

1.1.1.3. Đất trồng cây hàng năm khác HNK 11 255 240 180 

1.1.1.3.1. Đất bằng trồng cây hàng năm khác BHK 12 255 240 180 

1.1.1.3.2. Đất nương rẫy trồng cây hàng năm khác NHK 13 255 240 180 

1.1.2. Đất trồng cây lâu năm CLN 14 255 210 160 

1.1.2.1. Đất trồng cây công nghiệp lâu năm LNC 15 255 215 170 

1.1.2.2. Đất trồng cây ăn quả lâu năm LNQ 16 255 215 170 

1.1.2.3. Đất trồng cây lâu năm khác LNK 17 255 215 170 

1.2. Đất lâm nghiệp LNP 18 170 255 50 

1.2.1. Đất rừng sản xuất RSX 19 180 255 180 

1.2.1.1. Đất có rừng tự nhiên sản xuất RSN 20 180 255 180 

1.2.1.2. Đất có rừng trồng sản xuất RST 21 180 255 180 

1.2.1.3. Đất khoanh nuôi phục hồi rừng sản xuất RSK 22 180 255 180 

1.2.1.4. Đất trồng rừng sản xuất RSM 23 180 255 180 

1.2.2. Đất rừng phòng hộ RPH 24 190 255 30 

1.2.2.1. Đất có rừng tự nhiên phòng hộ RPN 25 190 255 30 

1.2.2.2. Đất có rừng trồng phòng hộ RPT 26 190 255 30 

1.2.2.3. Đất khoanh nuôi phục hồi rừng phòng hộ RPK 27 190 255 30 

1.2.2.4. Đất trồng rừng phòng hộ RPM 28 190 255 30 

1.2.3. Đất rừng đặc dụng RDD 29 110 255 100 

1.2.3.1. Đất có rừng tự nhiên đặc dụng RDN 30 110 255 100 
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1.2.3.2. Đất có rừng trồng đặc dụng RDT 31 110 255 100 

1.2.3.3. Đất khoanh nuôi phục hồi rừng đặc dụng RDK 32 110 255 100 

1.2.3.4. Đất trồng rừng đặc dụng RDM 33 110 255 100 

1.3. Đất nuôi trồng thủy sản NTS 34 170 255 255 

1.3.1. Đất nuôi trồng thuỷ sản nước lợ, mặn TSL 35 170 255 255 

1.3.2. Đất chuyên nuôi trồng thuỷ sản nước ngọt TSN 36 170 255 255 

1.4. Đất làm muối LMU 37 255 255 254 

1.5. Đất nông nghiệp khác NKH 38 245 255 180 

2. Đất phi nông nghiệp PNN 39 255 255 100 

2.1. Đất ở OTC 40 255 180 255 

2.1.1. Đất ở tại nông thôn ONT 41 255 208 255 

2.1.2. Đất ở tại đô thị ODT 42 255 160 255 

2.2. Đất chuyên dùng CDG 43 255 160 170 

2.2.1. Đất trụ sở cơ quan, công trình sự nghiệp CTS 44 255 160 170 

2.2.1.1. Đất trụ sở cơ quan, công trình sự nghiệp của Nhà nước TSC 45 255 170 160 

2.2.1.2. Đất trụ sở khác TSK 48 250 170 160 

2.2.2. Đất quốc phòng CQP 52 255 100 80 

2.2.3. Đất an ninh CAN 53 255 80 70 

2.2.4. Đất sản xuất, kinh doanh phi nông nghiệp CSK 54 255 160 170 

2.2.4.1. Đất khu công nghiệp SKK 55 250 170 160 

2.2.4.2. Đất cơ sở sản xuất, kinh doanh SKC 56 250 170 160 

2.2.4.3. Đất cho hoạt động khoáng sản SKS 57 205 170 205 

2.2.4.4. Đất sản xuất vật liệu xây dựng, gốm sứ SKX 58 205 170 205 

2.2.5. Đất có mục đích công cộng CCC 59 255 170 160 

2.2.5.1 Đất giao thông DGT 60 255 170 50 

2.2.5.2. Đất thuỷ lợi DTL 63 170 255 255 

2.2.5.3. Đất  công trình năng lượng DNL 66 255 170 160 

2.2.5.4. Đất  công trình bưu chính viễn thông  DBV 67 255 170 160 

2.2.5.5. Đất cơ sở văn hóa DVH 69 255 170 160 

2.2.5.6. Đất cơ sở y tế DYT 72 255 170 160 

2.2.5.7. Đất cơ sở giáo dục - đào tạo DGD 75 255 170 160 

2.2.5.8. Đất cơ sở thể dục - thể thao DTT 78 255 170 160 

2.2.5.9. Đất cơ sở nghiên cứu khoa học DKH 79 255 170 160 

2.2.5. 10. Đất cơ sở dịch vụ về xã hội DXH 80 255 170 160 

2.2.5.11. Đất chợ DCH 81 255 170 160 
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2.2.5.12. Đất có di tích, danh thắng DDT 84 255 170 160 

2.2.5.13. Đất bãi thải, xử lý chất thải DRA 85 205 170 205 

2.3. Đất tôn giáo, tín ngưỡng TTN 86 255 170 160 

2.3.1. Đất tôn giáo TON 87 255 170 160 

2.3.2. Đất tín ngưỡng TIN 88 255 170 160 

2.4. Đất nghĩa trang, nghĩa địa NTD 89 210 210 210 

2.5. Đất sông suối và mặt nước chuyên dùng SMN 90 180 255 255 

2.5.1. Đất sông, ngòi, kênh, rạch, suối SON 91 160 255 255 

2.5.2. Đất có mặt nước chuyên dùng MNC 92 180 255 255 

2.6. Đất phi nông nghiệp khác PNK 93 255 170 160 

3. Nhóm đất chưa sử dụng CSD 97 255 255 254 

3.1. Đất bằng chưa sử dụng BCS 98 255 255 254 

3.2. Đất đồi núi chưa sử dụng DCS 99 255 255 254 

3.3. Núi đá không có rừng cây NCS 100 230 230 200 

4 . Đất có mặt nước  ven biển  MVB 101 180 255 255 

4.1. Đất mặt nước ven biển nuôi trồng thủy sản MVT 102 180 255 255 

4.2. Đất mặt nước ven biển có rừng ngập mặn  MVR 103 180 255 255 

4.3.  Đất mặt nước ven biển có mục đích khác MVK 104 180 255 255 

 

 


